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Change History
This table lists and links to changes made to this document, and gives the dates those changes were made.
Earliest changes appear in the bottom rows.
Change

Date

Initial release of document

August,
2015

Packaged CCE supports IPv6 connections for agent and
supervisor desktops and phones.

Link

Agent Greeting, on page 11
Mobile Agent, on page 89
Whisper Announcement, on page
183

Packaged CCE supports Call Progress Analysis (CPA) for
Outbound Option deployments configured with Cisco
Unified Border Element (Cisco UBE).

Outbound Option, on page 111
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Preface
About This Guide

Change

Date

Link

Packaged CCE automatically configures the Unified CVP
Media Servers during initialization for fresh installs.
Configuration instructions have been removed.

Unified CVP Media Server, on
page 85

Video Contact Center:

Video Contact Center, on page
193

• Added support for the Remote Expert Mobile
deployment of Video Contact Center.
• Added support for Remote Expert Branch
deployments of Video Contact Center, including
Kiosk/Immersive
Updates for Windows 2012 and component software
11.0(1) releases.

Throughout guide

Packaged CCE supports Extension Mobility.

Feature Descriptions, on page 7

Cisco Interaction Manager chapter updated for Media
Blender deprecation.

Cisco Interaction Manager
(Unified WIM and Unified EIM),
on page 67

About This Guide
This document explains the features you can enable after your Packaged CCE system is installed, configured,
and operational. For each feature, there is a description, procedures for initial setup, and details on the
functionality the feature provides.

Audience
This document is prepared for:
• Contact center administrators who configure and run the contact center, manage agents and supervisors,
and address operational issues.
• Contact center supervisors, who lead agent teams and are responsible for team performance.
This document is written with the understanding that your system has been deployed by a partner or service
provider who has validated the deployment type, virtual machines, and database and has verified that your
contact center can receive and send calls.
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Preface
Related Documents

Related Documents
Subject

Link

Cisco Packaged Contact Center Enterprise (Packaged http://www.cisco.com/c/en/us/support/
CCE)
customer-collaboration/
packaged-contact-center-enterprise/
tsd-products-support-series-home.html
Packaged CCE DocWiki

http://docwiki.cisco.com/wiki/Packaged_CCE

Packaged CCE Troubleshooting DocWiki

http://docwiki.cisco.com/wiki/Troubleshooting_
Packaged_CCE

Cisco Packaged CCE Software Compatibility Matrix http://docwiki.cisco.com/wiki/Compatibility_Matrix_
DocWiki
for_Packaged_CCE
Virtualization for Cisco Packaged CCE DocWiki

http://docwiki.cisco.com/wiki/Virtualization_for_
Cisco_Packaged_CCE

Cisco Unified Communications Manager

http://www.cisco.com/c/en/us/support/
unified-communications/
unified-communications-manager-callmanager/
tsd-products-support-series-home.html

Cisco Unified Intelligence Center

http://www.cisco.com/c/en/us/support/
customer-collaboration/unified-intelligence-center/
tsd-products-support-series-home.html

Cisco Finesse

http://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/
tsd-products-support-series-home.html

Cisco Unified Customer Voice Portal (Unified CVP) http://www.cisco.com/c/en/us/support/
customer-collaboration/unified-customer-voice-portal/
tsd-products-support-series-home.html
Cisco Remote Expert Mobile

http://www.cisco.com/c/en/us/support/
customer-collaboration/remote-expert-mobile/
tsd-products-support-series-home.html

Cisco MediaSense

http://www.cisco.com/c/en/us/support/
customer-collaboration/mediasense/
tsd-products-support-series-home.html

Cisco SocialMiner

http://www.cisco.com/c/en/us/support/
customer-collaboration/socialminer/
tsd-products-support-series-home.html
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Obtaining Documentation and Submitting a Service Request

Subject

Link

Cisco Unified Web and E-Mail Interaction Manager http://www.cisco.com/c/en/us/support/
customer-collaboration/
unified-email-interaction-manager/
tsd-products-support-series-home.html

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service
request, and gathering additional information, see What's New in Cisco Product Documentation, at: http://
www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html.
Subscribe to What's New in Cisco Product Documentation, which lists all new and revised Cisco technical
documentation as an RSS feed and delivers content directly to your desktop using a reader application. The
RSS feeds are a free service.

Field Alerts and Field Notices
Cisco products may be modified or key processes may be determined to be important. These are announced
through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and
Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive
announcements by selecting all products of interest.
Log into www.cisco.com and then access the tool at http://www.cisco.com/cisco/support/notifications.html.

Documentation Feedback
To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com
We appreciate your comments.

Conventions
This document uses the following conventions:
Convention

Description

boldface font

Boldface font is used to indicate commands, such as user entries, keys, buttons,
and folder and submenu names. For example:
• Choose Edit > Find.
• Click Finish.
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Conventions

Convention

Description

italic font

Italic font is used to indicate the following:
• To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.
• A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)
• A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

window font

Window font, such as Courier, is used for the following:
• Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>

< >

Angle brackets are used to indicate the following:
• For arguments where the context does not allow italic, such as ASCII output.
• A character string that the user enters but that does not appear on the window
such as a password.
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CHAPTER

2

Optional Features in Packaged CCE
• Feature Descriptions, page 7
• Integrations with Other Cisco Products, page 8
• Assumptions for Proceeding with Optional Features, page 10

Feature Descriptions
You can choose to enable these features at any time after your Packaged CCE system is installed, configured,
and operational.
Agent Greeting
Agent Greeting manages the recording and playing of greeting messages from agents. An agent's
recorded greeting plays automatically to callers when they connect to that agent. Agents can set up
different greetings for different types of callers, if the call center supports that option.
Agent Request
Agent Request allows a customer to initiate a request from the web to receive a return call from an
agent. The request is initiated by a SocialMiner callback feed.
Cisco Interaction Manager
Cisco Interaction Manager is a suite of web and email interaction management applications that includes
Cisco Unified E-Mail Interaction Manager (Unified EIM) and Cisco Unified Web Interaction Manager
(Unified WIM).
Courtesy Callback
Courtesy Callback offers customers the option to hang up and then receive a callback when an agent
is close to being available, rather than having to wait for an extended time on hold. Customers do not
lose their place in the queue. The system collects callback information from the caller, monitors agent
availability, and calls the customer when the agent is close to available.
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Extension Mobility
Extension Mobility is a Cisco Unified Communications Manager feature that allows agents to temporarily
access their Cisco Unified IP Phone configuration, such as line appearances, services, and speed dials,
from other Unified IP Phones.
As part of the configuration in Unified Communications Manager Administration, you create a
device profile for each agent that will use Extension Mobility, and associate each device profile with
the appropriate agent. You can add either all of the device profiles to the pguser, or all of the phones
that the agents will use to the pguser; you do not need to add both the profiles and phones to the pguser.
For more information about this feature, see the Extension Mobility section of the Feature Configuration
Guide for Cisco Unified Communications Manager at http://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/
products-installation-and-configuration-guides-list.html.
Mobile Agent
Mobile Agent supports call center agents who are using phones that are not directly controlled by
Packaged CCE. A mobile agent can be located outside of the contact center, using an analog phone or
a mobile phone. Mobile agents might also be located in the contact center using an IP phone connection
that is not being controlled by Packaged CCE. All mobile agents use broadband connection to access
the same Agent desktop and agent state controls as non-mobile agents.
Packaged CCE supports agents in Nailed Up mode. (Call-by-Call mode is not supported in this
deployment.)
Outbound Option
Outbound Option manages and executes outbound dialing campaigns. You configure the system to
automatically dial numbers using imported contact lists and filtering rules. When a call connects to a
live person, the system transfers the call to an agent skilled in handling that calling campaign.
Post-Call Survey
Post-Call Survey sends a caller to an automated survey after the agent disconnects. A Post-Call Survey
is typically used to determine whether customers are satisfied with their call center experiences.
Whisper Announcement
Whisper Announcement plays a brief message to an agent before connecting a caller to the agent. The
message might include information about the caller or choices the caller made from menu options.
Video Contact Center
Video Contact Center provides high-quality video collaboration between customers and agents.
Depending on how Video Contact Center is deployed, customers may connect with agents either from
within the enterprise network or from devices outside the enterprise.

Integrations with Other Cisco Products
You can extend Packaged CCE functionality by integrating it with other Cisco products.
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Cisco Interaction Manager (Unified WIM and EIM)
Unified WIM provides agents with a comprehensive set of tools for serving customers in real-time. It
enables call center agents to provide immediate personalized service to customers through text chat
messaging and web page-pushing. Agents also use Unified WIM to assist customers to navigate through
web pages while providing support on the phone.
Unified EIM enables organizations to intelligently route and process inbound emails, webform inquiries,
faxes, and letters.
For information about E-Mail Interaction Manager, see http://www.cisco.com/en/US/products/ps7236/
tsd_products_support_series_home.html. For Web Interaction Manager, see http://www.cisco.com/en/
US/products/ps7233/index.html.
Cisco MediaSense
Cisco MediaSense is a media recording platform that uses Web 2.0 application programming interfaces
(APIs) to expose its functionality to third-party customers so they can create custom applications.
Cisco MediaSense can be used by compliance recording companies whose regulatory environment
requires all conversations to be recorded and maintained. These recordings can later be used by a
compliance auditor or a contact center supervisor to resolve customer issues or for training purposes.
These recordings can also be used by speech analytics servers or transcription engines.
Cisco MediaSense is not dependent on the use of any other contact center product. However, it is
capable of working with all contact center products. Its only dependency is Cisco Unified
Communications Manager (Unified CM), which is used to set up the recording profile and call control
service connection (SIP trunk) information.
For information about Cisco MediaSense, see http://www.cisco.com/en/US/products/ps11389/index.html.
Cisco Silent Monitoring
Silent monitoring provides the supervisor with the ability to listen in on agent’s calls for quality control
and performance evaluation. Two silent monitoring types are supported for Unified Contact Center:
• CTI OS based
• Unified CM based
Both CTI OS based and Unified CM based silent monitor sessions are started and stopped using the
Start Silent Monitor and Stop Monitoring Agent buttons on the Team State window. Silent Monitoring
must be installed on a separate server from Packaged CCE.
Cisco SocialMiner
Cisco SocialMiner is a customer-care system that provides capture, filtering, workflow, queuing, and
reporting for social media engagement teams. Internet postings captured by SocialMiner are referred
to as Social Contacts. SocialMiner stores the social contacts and groups them into user-defined
Campaigns. Each Campaign obtains social contacts from one or more Feeds. SocialMiner presents the
social contacts to social media customer care personnel who can search, review, categorize, and respond
to the postings. SocialMiner also produces reporting metrics on the handling of the social contacts.
For information about SocialMiner, see http://www.cisco.com/en/US/products/ps11349/index.html.
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Assumptions for Proceeding with Optional Features
This document makes the following assumptions about the state of your Packaged CCE system and the system
administrator's knowledge of Packaged CCE:
• Your Packaged CCE system must be installed, configured, and operational.
• System administrators must have access to the following interfaces:
◦Cisco Packaged Contact Center Enterprise (CCE) Administration
◦Cisco Unified Customer Voice Portal (CVP) Operations Console
◦Script Editor
◦Cisco SocialMiner
◦Cisco Unified Communications Manager (CUCM) reporting interface
◦Cisco Interaction Manager (Unified WIM and EIM)
◦Interfaces for all Video Contact Center components. See Video Contact Center, on page 193.
• System administrators must be familiar with the following procedures or have access to the Cisco
documentation that describes them:
◦Expanded call variables—Know how to use Unified CCE Administration to set variable values
and add new variables.
◦Scripting—Know how to use the Script Editor to create new Packaged CCE call routing scripts
and modify existing scripts. Understand the scripting technology.
◦CVP scripting—Know how to use the CVP Script Editor to create new or modify existing voice
scripts.
The Cisco Packaged Contact Center Enterprise Administration and Configuration Guide describes all
of the above procedures. This guide is available at http://www.cisco.com/c/en/us/support/
customer-collaboration/packaged-contact-center-enterprise/products-maintenance-guides-list.html.
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Capabilities
The Agent Greeting feature lets an agent record a message that plays automatically to callers when they
connect to the agent. The greeting message can welcome the caller, identify the agent, and include other useful
contextual information. With Agent Greeting, each caller can receive a clear, well-paced, language-appropriate,
and enthusiastic introduction. Another benefit is that it saves the agent from having to repeat the same
introductory phrase for each call. It also gives the agent a moment to review the desktop software screen
pop-ups while the greeting plays.
The process of recording a greeting is much the same as recording a message for voice mail. Depending on
how the call center is set up, agents may be able to record different greetings that play for different types of
callers (for example, an English greeting for English speakers or an Italian greeting for Italian speakers).
By default, greeting play is enabled when agents log in to their agent desktop. Agents can turn greeting play
off and on as necessary.

Agent Greeting Phone Requirements (for Local Agents Only)
Agent Greeting is available to agents and supervisors who use IP Phones with Built-In Bridge (BIB). These
agents are typically located within a contact center. Phones used with Agent Greeting must meet these
requirements:
• The phones must have the BIB feature.

Note

If you disable BIB, the system attempts to use a conference bridge for agent greeting
call flow and raises a warning event.
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• The phones must be running firmware version CM 8.5(1) or greater. (Usually, phone firmware upgrades
automatically when you upgrade your Unified Communications Manager installation.)
• In an IPv6-enabled environment, Agent Greeting might require extra Media Termination Points (MTPs).
• See the Cisco Packaged CCE Software Compatibility Matrix DocWiki at http://cisco.com/en/US/products/
ps12586/tsd_products_support_series_home.html for the list of supported Packaged CCE phone models.

Agent Greeting Functional Limitations
Agent Greeting is subject to these limitations.
• Agent Greeting does not support outbound calls made by an agent. The announcement plays for inbound
calls only.
• Only one Agent Greeting file plays per call.
• Supervisors cannot listen to agent recorded greetings.
• Agent Greetings do not play when the router selects the agent through a label node.
• The default CTI OS Toolkit Agent desktop includes the Agent Greeting buttons. If you do not set up
Agent Greeting, the Agent Greeting buttons do not execute any functionality. If you use the default
desktop but do not plan to use Agent Greeting, you should remove the buttons.
• Agent Greeting supports Silent Monitoring (CTI OS and Unified CM-based) with this exception: For
Unified-CM based Silent Monitoring, supervisors cannot hear the greetings themselves. If a supervisor
clicks the Silent Monitor button in their CTI OS desktop while a greeting is playing, a message displays
stating that a greeting is playing and to try again shortly.

Whisper Announcement with Agent Greeting
You can use Agent Greeting with the Whisper Announcement feature. Here are some things to consider when
using them together:
• On the call, the Whisper Announcement always plays first.
• To shorten your call-handling time, use shorter Whisper Announcements and Agent Greetings than you
might if you were using either feature by itself. A long Whisper Announcement followed by a long
Agent Greeting equals a long wait before an agent actively handles a call.
• If you use a Whisper Announcement, your agents probably handle different types of calls: for example,
“English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” “English-Platinum
Member-Account Inquiry.” Therefore, you may want to ensure that greetings your agents record are
generic enough to cover the range of call types.

Initial Setup
This section is intended for system administrators responsible for installing and configuring Packaged CCE.
It describes the one-time tasks required to set up Agent Greeting.
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Configuration Requirements
The following configuration components must be in place to deploy Agent Greeting.
Where

What

Unified Communications
Manager

For phones that use Agent Greeting, you must set the Built-in-Bridge option to On or Default (if
the value of Default is On). To verify, in Unified CM Administration, select Device > Phone >
Built in Bridge.

Unified CCE

Agent Greeting is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP
to control the call). If your current Unified CCE deployment is not configured for a Type 10 VRU,
you must modify it accordingly.
Agent Greeting requires at minimum three expanded call variables.
• user.microapp.ToExtVXML: This is used twice in an Agent Greeting record script: the first
time is to queue the Unified CVP RecordAgentGreeting application; the second time is to tell
the recording application where to save greeting files. Configure it as an array with size 3.
Use the Unified CCE Administration tool to ensure this variable includes these settings:
Maximum Length - 100 and Enabled.
• user.microapp.app_media_lib:This is required in Agent Greeting record and play scripts to
specify the dedicated directory on the media server where your greeting audio files are stored.
Maximum Length - 100 and Enabled.
• user.microapp.input_type: This is required in Agent Greeting record scripts to limit the
allowable input type to DTMF. Maximum Length - 100 and Enabled.
No other expanded call variables are needed if you serve your files from the Unified CVP default
media server, and your files are in the media server default locale directory
("<web_server_root>\en-us\app"). However, if you store your files in a location other than these
defaults, you must use one or more of the expanded call variables in the next row in your scripts.

Unified CCE (optional
variables, used to override
defaults)

To make these variables available to your script authors, confirm that they are defined in the Unified
CCE Administration tool. For instructions about defining ECC variables for CVP, see the
Administration Guide for Cisco Unified Customer Voice Portal at http://www.cisco.com/en/US/
products/sw/custcosw/ps1006/tsd_products_support_series_home.html.
• user.microapp.media_server: Use to identify the Unified CVP media server if it is other than
the default.
• user.microapp.locale: Use to specify the name of the locale directory on the media server if
it is other than the default (“en-us”).
• user.microapp.UseVXMLParams: Required in your record script if you include the
user.microapp.media_server variable. It tells the external VXML recording script to use the
name/value pair of the application that you pass in the user.microapp.ToExtVXML variable.

Unified CVP

Unified CVP Server must be installed and configured, as described in the Cisco Packaged Contact
Center Enterprise Installation and Upgrade Guide at http://www.cisco.com/c/en/us/support/
customer-collaboration/packaged-contact-center-enterprise/products-installation-guides-list.html.
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Agent Greeting Deployment Tasks
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

Ensure that your system meets the baseline requirements for software, hardware, and configuration described
in the System Requirements and Limitations section.
Configure one or more servers to act as media servers. Configuration requirements include IIS and FTP.
In Unified CVP, add media servers, configure FTP connection information, and deploy the media servers.
Configure a Unified CVP media server, if you have not already done so. See Unified CVP Media Server, on
page 85.
In Unified CVP, republish the VXML Gateway.tcl scripts with updated Agent Greeting support. See Republish
.tcl scripts to VXML Gateway, on page 15 for Agent Greeting support.

Step 6
Step 7

Set the cache size on the VXML Gateway. See Set Cache Size on VXML Gateway, on page 15.
Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your
media server. See Create Voice Prompts for Recording Greetings, on page 16.
Step 8 Configure call types to record and play agent greetings. See Configure Call Types, on page 17.
Step 9 Configure dialed numbers to record and play agent greetings. See Configure Dialed Numbers, on page 17.
Step 10 Schedule the Script, on page 18.
Step 11 Define Network VRU Scripts for Agent Greeting, on page 18.
Step 12 In Script Editor:
• To use the installed scripts to record and play agent greetings, see Import Example Agent Greeting
Scripts, on page 19.
• To create your own scripts, see Agent Greeting Scripts, on page 23.
Step 13 Modify the Unified CCE call routing scripts to use Play Agent Greeting script, on page 21.

Configure Media Server for Agent Greeting
Agent Greeting uses the Unified CVP media server. If you previously configured and deployed one or more
Unified CVP media servers for other features, you do not have to configure any additional servers for Agent
Greeting. You can optionally add additional media servers.
Agent Greeting uses the Unified CVP media server to store and serve the following types of files:
• Prompt files, prepared by Administrators. These files supply the prompts that agents hear when they
record their greetings. The Administrator must manually add the prompt files to all the media servers
that their Agent Greeting scripts will query to retrieve those files.
• Greeting files, recorded by agents. These files are the actual greetings that play to callers. They are
recorded by individual agents. The system handles the storage of these files as follows:
◦A greeting file is named using the convention agentID_AgentGreetingType. For more about
AgentGreetingType, see Specify AgentGreetingType Call Variable, on page 22.
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◦When a greeting is first recorded, it is stored temporarily on the Unified CVP Call Server, where
an agent can listen to it before confirming its use.
◦When the agent confirms the greeting, the file is transferred, using FTP, to all media servers that
are deployed and are configured with FTP enabled. Make sure that an FTP server is installed and
configured for the correct version of IIS on the media server. For instructions, consult the Microsoft
corporation (http://microsoft.com).
◦To satisfy a request for the greeting to play to a caller, the greeting file is copied from the media
server to the VXML Gateway, where it is cached. The cached copy is used to satisfy subsequent
requests for the greeting. Content expires in the cache based on the cache timeout period defined
on the media server.
The routing scripts look for the prompt and greeting files either on the configured default Unified CVP media
server or on a specific server identified in the script. Some typical scripting scenarios for retrieving files for
Agent Greeting include:
• All files are retrieved from the default server.
• All files are retrieved from the default server if available; otherwise, a redundant server is queried.
• For security, the prompt files are retrieved from one server and the greetings files are retrieved from a
different server.
• For load balancing, the greetings files are dispersed among several servers and retrieved based on tests
in the script.

Republish .tcl scripts to VXML Gateway
The .tcl script files that ship with Unified CVP Release 9.0(1) include updates to support Agent Greeting.
You must republish these updated files to your VXML Gateway.

Procedure
Step 1

Step 4

In the Unified CVP Management Console, select Bulk Administration > File Transfer > Scripts and
Media.
Set Device to Gateway.
Select the gateways you want to update. Typically you would select all of them unless you have a specific
reason not to.
Select Default Gateway Files.

Step 5

Click Transfer.

Step 2
Step 3

Set Cache Size on VXML Gateway
To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed.
The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to
its maximum can result in slowed performance to increased traffic to the media server.
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Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:
conf t
http client cache memory pool 100000
exit
wr

For more information about configuring the cache size, see the Configuration Guide for Cisco Unified Customer
Voice Portal at http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_
home.html.

Create Voice Prompts for Recording Greetings
You must create audio files for each of the voice prompts that agents hear as they record a greeting. The
number of prompts you require can vary, but a typical set can consist of:
• A welcome followed by a prompt to select which greeting to work with (this assumes you support
multiple greetings per agent)
• A prompt to select whether they want to hear the current version, record a new one, or return to the main
menu
• A prompt to play if a selected greeting is not found.
To create voice prompts for recording greetings:

Procedure
Step 1

Create the files using the recording tool of your choice. When you record your files:
• The media files must be in .wav format. Your .wav files must match Unified CVP encoding and format
requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).
• Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.

Step 2

After recording, deploy the files to your Unified CVP media server. The default deployment location is to the
<web_server_root>\en-us\app directory.

Step 3

Note the names of the files and the location where you deployed them on the media server. Your script authors
need this information for the Agent Greeting scripts.

Built-In Recording Prompts
The Unified CVP Get Speech micro-application used to record Agent Greetings includes the following built-in
prompts:
• A prompt that agents can use to play back what they recorded
• A prompt to save the greeting, record it again, or return to the main menu
• A prompt that confirms the save, with an option to hang up or return to the main menu
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The built-in prompts are installed on each server at <CCE_root>\wav and are referenced in the example
recording script that is included with Packaged CCE. To deploy the example script, copy the audio prompts
to the <web_server_root>\en-us\app directory on your media server.
You can replace these .wav files with files of your own. For more information, see the Unified Customer
Voice Portal Call Studio documentation at http://www.cisco.com/en/US/products/ps7235/tsd_products_
support_series_home.html

Configure Call Types
To record and play agent greetings, create two call types: RecordAgentGreeting and PlayAgentGreeting.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

In Unified CCE Administration, select Manage > Call Types.
Click New to open the New Call Type window.
Complete the fields to create a call type to record agent greetings. For Name, enter RecordAgentGreeting.
Click Save.
Repeat this procedure to create a call type to play agent greetings. For Name, enter PlayAgentGreeting

Configure Dialed Numbers
To record and play agent greetings, create two dialed numbers: RecordAgentGreeting and PlayAgentGreeting.

Procedure
Step 1
Step 2

In Unified CCE Administration, select Manage > Dialed Numbers.
Click New to open the New Dialed Number window.

Step 3

Complete the fields to create a dialed number to record agent greetings, as follows:
• Dialed Number String: RecordAgentGreeting
The name must match exactly and is case-sensitive.
• Routing Type: Internal Voice
• Call Type: RecordAgentGreeting (the call type that you created for recording agent greetings)

Step 4
Step 5

Click Save.
Repeat this procedure to create a dialed number to play agent greetings. Complete the New Dialed Number
fields as follows:
• Dialed Number String: PlayAgentGreeting
The name must match exactly and is case-sensitive.
• Routing Type: Internal Voice

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
17

Agent Greeting
Agent Greeting Deployment Tasks

• Call Type: PlayAgentGreeting (the call type that you created for playing agent greetings)

Schedule the Script
Procedure
Step 1

In the Script Editor ,select Script > Call Type Manager.

Step 2
Step 3

From the Call Type Manager screen, select the Schedules tab.
From the Call type drop-down list, select the call type to associate with the script; for example,
PlayAgentGreeting.

Step 4
Step 5

Click Add and select the script you want from the Scripts box.
Click OK twice to exit.

Define Network VRU Scripts for Agent Greeting
For Agent Greeting record and play scripts to interact with Unified CVP, Network VRU scripts are required.
The number of VRU scripts that you require and how you configure them depends on how you choose to
script Agent Greeting.
To create these scripts, log into Packaged CCE Administration and select Manage > Network VRU Script.
The following table lists an example set of Agent Greeting Network VRU scripts based on the example Agent
Greeting scripts that are included with the software.

Note

If you require the following example VRU scripts, you must manually create them.

Table 1: Agent Greeting Network VRU Scripts

Name /
VRU Script Name

Configuration
Parameter

Interruptible
(Y/N)

What it does

AgentGreeting

null

N

Causes a saved greeting audio file to play. The -a
parameter automatically generates the file name by
concatenating the agent's Login Name with the
AgentGreetingType variable value set in your routing
scripts that target an agent.

PM,-a
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Name /
VRU Script Name

Configuration
Parameter

Interruptible
(Y/N)

What it does

GreetingMenu_1_to_9

1-9

Y

During a recording session, play an audio file that
presents a voice menu prompting the agent to press the
number corresponding to the greeting he or she wants to
record. The 1-9 configuration parameter defines the range
of allowable keys. So this value also determines the
number of concurrent greetings agents can have. The A
parameter specifies that the file is in the (default)
Application directory on the Unified CVP VXML Server.

1-3

Y

During a recording session, play an audio file that
prompts the agent to press 1 to listen to a greeting, 2 to
record, or 3 to go to the main menu.

Y

Y

During a recording session, if an agent tries to play back
a greeting that does not exist, play the
no_greeting_recorded audio file. The Y configuration
parameter in this instance allows barge-in (digit entry to
interrupt media playback).

,,,,,,,,,,Y

Y

This starts the external VXML application that records
the greeting. The VRU script name must be specified
exactly as shown and is case-sensitive.

M,press_1_thru_9_greeting,A

GreetingSubMenu
M,press1-press2-press3,A

Greeting_Not_Found
PM,no_greeting_recorded,A

T10_GS_AUDIUM
GS,Server,V, FTP

The Y parameter in the eleventh position of the
Configuration Parameter is required. It allows the script
to pass FTP connection information to the VXML server.
The VXML server then uses this information to make an
FTP connection to the media server when saving greeting
files.
GreetingReview

Y

Y

PM,-a,A

This script allows the agent to review the recorded
greeting audio file.

Import Example Agent Greeting Scripts
To view or use the example Agent Greeting scripts, you must first import them into Script Editor. To import
the scripts:

Procedure
Step 1
Step 2

Launch Script Editor.
Select File > Import Script and select a script to import.
The scripts are located in the icm\bin directory on the data server (DS) node.
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Note

When you import the example scripts, Script Editor maps objects that are referenced in the scripts.
Some of the objects, such as the external Network VRU scripts, skill groups, route to skill group, or
precision queue, do not map successfully. You must create these manually or change these references
to point to existing scripts, skill groups, and precision queues in your system.

What to Do Next
In addition to importing the scripts, you may need to modify the following items. For more information, see
Agent Greeting Scripts, on page 23.
• If you do not use a default media server, you must modify the media server specification.
• If you do not use the default values for application and locale (en-us/app), you must modify the path
name of greeting files.
• Using the Unified CCE Administration tool, enable all expanded call variables referenced by the following
sample scripts.

Agent Greeting Example Routing Scripts
The example routing script files in the icm\bin directory include:
• AG.ICMS—This script sets up an Agent Greeting by setting the greeting type to be used on the call
and then queueing the call to a skill group or precision queue. Once an agent is selected from the skill
group or precision queue and the call routed to the agent, the PAG.ICMS script is invoked. It requires
that you define an AgentGreeting VRU script (described in Define Network VRU Scripts for Agent
Greeting, on page 18) and a skill group.
• PAG.ICMS—This script causes an Agent Greeting to play. It is invoked by the PlayAgentGreeting
dialed number that you configured earlier in the configuration process. This number must be associated
with a call type that then executes the script. It requires that you define an AgentGreeting VRU script,
described in Define Network VRU Scripts for Agent Greeting, on page 18.
• RECORD_AG.ICMS—This script lets agents record a greeting. It is called from the agent desktop
when an agent clicks the Record Agent Greeting button. It prompts the agent to select which greeting
to play or record. This script is invoked by the RecordAgentGreeting dialed number that you configured
earlier in this configuration process. It requires that you define all five VRU scripts described in Define
Network VRU Scripts for Agent Greeting, on page 18.
• WA_AG.ICMS—This script plays a Whisper Announcement and an Agent Greeting together on the
same call flow. It requires that you define an AgentGreeting VRU script (described in Define Network
VRU Scripts for Agent Greeting, on page 18) and a skill group.

Note

The PAG.ICMS and RECORD_AG.ICMS example scripts assume that a default media server is configured
in Unified CVP, and the greeting files are stored in a dedicated directory named ag_gr directory. The
WA_AG.ICMS script does not include a dedicated directory.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
20

Agent Greeting
Agent Greeting Deployment Tasks

Note

For greeting, the initial script sets up the call between caller and agent, and a different script plays the
greeting to the agent after the caller is connected. If the initial Unified CCE script overrides the default
media server with a SET node, the call context of expanded call variables is preserved on the greeting
playback call as well, and the Default Media Server may be overridden. In this case, modify the greeting
playback script to use a SET node with the correct media server.

Test Agent Greeting File Path
When an agent records a greeting, the greeting file is saved with a system-generated name as follows:
• The filename starts with the value of the Call.AgentGreetingType variable associated with the choice
the agent made when recording the greeting. For example, if the agent selected the first option, and the
Agent Greeting record script sets the first option to "1," then the greeting filename is appended with _1.
As another example, if descriptive strings were implemented, and the first option is associated with the
string "French," then the greeting filename is appended with _French.
• The agent's id number is appended to the starting string. For example, agent 10201 would have greeting
files named 10201_1 or 10201_French.
The greeting file is saved in a directory whose path is determined by the following variables in the Agent
Greeting record script:
• A specific media server, or the default media server. (The file is later pushed to all FTP-enabled media
servers.)
• A specific application directory, or the default application directory.
• A specific locale directory, or the default locale directory.
To test the path you defined to the greeting file in your script variables, plug the complete URL into a browser.
The .wav file should play. For example:
• If your script uses a default media server whose IP is 192.1.1.28 + the default locale + an application
directory named greet + agent123_im1.wav, then the generated URL should be
http://192.1.1.28/en-us/app/greet/agent123_1.wav. Entering this URL into a
browser should cause this agent’s greeting to play.
• If your script includes: http://my_server.my_domain.com + the default locale + an application directory
app/greet + agent123_1.wav, then the path should be
http://my_server.my_domain.com/en-us/app/greet/agent123_1.wav.

Modify the Unified CCE call routing scripts to use Play Agent Greeting script
For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your
existing Unified CCE call routing scripts: This variable's value is used to select the audio file to play for the
greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill
Group or Precision Queue], Queue Agent, Route Select, or Select node).
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Specify AgentGreetingType Call Variable
To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call
variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use.
The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For
example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5',
then the variable value should be 5.
You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType
set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow
different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify
the variable at each decision point used to select a particular skill group or Precision Queue.

Note

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more
than once in any single path through a script, the last value to be set is the one that plays.
Use these settings in the Set Variable node for Agent Greeting:
• Object Type: Call.
• Variable: Must use the AgentGreetingType variable.
• Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or
“French”
◦You must enclose the value in quotes.
◦The value is not case-sensitive.
◦The value cannot include spaces or characters that require URL encoding.
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The following script example illustrates how to include Agent Greeting in a script using the Set Variable node:
Figure 1: Modified Call Routing Script to Enable Greeting Play

Include Agent Greeting Controls in Agent Desktops
CTI OS includes Active X objects that let you include Agent Greeting controls in your COM and C++ sourced
agent desktops. Available controls include Enable Greeting, Disable Greeting, and Record Greeting. For more
information, see the CTI OS Developer Guide for Cisco Unified ICM/Contact Center Enterprise at http://
www.cisco.com/en/US/products/sw/custcosw/ps14/tsd_products_support_series_home.html. Agent Greeting
controls are not supported with Java or .NET based CTI OS desktops, or with non-CTI OS desktops such as
CAD.

Agent Greeting Scripts
Agent Greeting requires two call routing scripts: one that agents can use to record greetings and one to play
a greeting to callers. Examples of these scripts are included in your installation. This section describes the
elements in the installed example scripts, including optional features and other modifications that you can
make. To create scripts from scratch, use this section to understand the required elements in Agent Greeting
scripts.

Note

If you plan to use the installed example scripts out of the box, you can ignore this section.
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Agent Greeting Recording Script
The Agent Greeting recording script is a dedicated routing script that allows agents to record greetings. You
can use the installed example scripts or create your own.
The script should be called from the agent desktop when an agent clicks the Record Greeting button on the
CTI OS desktop. If you support multiple greetings per agent, it should include prompts to select which greeting
to play or record. The dialed number RecordAgentGreeting must be created for the specific routing client and
associated with a call type which then executes this script.

Note

To record an Agent Greeting, Finesse agents use the dial pad on their desktop to call a custom dialed
number. The administrator must create this custom number and provide it to the agents.
In the example script shown here, the agent is first prompted to select one of nine possible greeting types.
After selecting a greeting type, the agent chooses whether to 1) listen to the existing greeting for that type; 2)
record a new greeting for that type, or 3) return to the main menu. If the agent selects the option to listen, the
name of the application directory on the media server is set and the external VRU script that plays the greeting
is triggered. Then the agent is returned to the main menu. If the agent selects the option to record, the Unified
CVP recording application is called. The recording application contains its own built-in audio prompts that
step the agent through the process of recording and saving a greeting. At the end, the agent is returned to the
main menu.
There are several other behaviors in the script to note. An agent may select to listen to a greeting type for
which no greeting exists. In that event, a VRU script that plays an error message is called. Also, in two places
in the script, the path to the application directory is reset to the default. This is because (in this example) that
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is where the files for the audio files reside. The only files that reside outside of the default directory are the
greetings themselves.
Figure 2: Agent Greeting Record Script

RecordAgentGreeting Micro-application
Unified CVP includes a dedicated micro-application -- RecordAgentGreeting -- for recording agent greetings.
The application lets agents record, review, re-record, and confirm the save of a greeting. It includes audio
files to support each of these functions. If an agent is not satisfied with a greeting, it can be re-recorded up to
three times. Upon confirmation of a save, the application FTPs the saved file to the media server. Built-in
error checking includes checks for the data required to name the file (agent Login Name + AgentGreetingType
variable value), media server specification, valid menu selections made by the agent, and successful FTP of
the greeting file.

Agent Greeting Record Script Nodes
Using the example script as a reference, here are descriptions of the functions its nodes perform.
Table 2: Script Node Functions for Agent Greeting

Node

Value

What it does

Variable:Call:user.

D

Sets the allowable input type to DTMF
(touch tone).

microapp.input_type
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Node

Value

What it does

RunExtScript:Press 1-9 to Select
Greeting X

M,press_1_thru_9_greeting,A

Runs the VRU script that defines which
digits are valid to select an
AgentGreetingType and plays a voice
prompt describing the options.

Variable:Call:AgentGreetingType

Call.CallerEnteredDigits

Sets the AgentGreetingType to the digit
the agent pressed. This text is used in
the greeting wave file. It can be a simple
numbering system or more descriptive
titles such as “English.”

RunExtScript:

M,press1-press2-press3,A

Runs the VRU script that defines which
digits are valid to select a desired action
and plays a voice prompt describing the
options.

CED

1,2,3

Tells the script how to handle the caller
entered digits in response to the 1,2,3
external script.

Variable:Call:
user.microapp.app_media_lib

Set three times:

Defines the path to the application
directory on the Unified CVP media
server. Prior to playing the greeting file,
it is set to the dedicated greeting file
directory (in this example,
app/ag_gr). After the greeting file
plays, it is reset to the default application
directory where (in this example) the
files for voice prompts are stored. If the
voice prompts were stored in the same
directory as the greeting files, there
would be no need to reset the path.

1 - hear greeting X,
2 - record greeting X,
3 - return to menu

• Once to "app/ag_gr"
• Twice to "" (an empty string; that is, the
default)

RunExtScript: Play Recording

PM,-a,A

Runs the VRU script that plays the
selected Agent Greeting.

RunExtScript:Greeting Not Found

PM,no_greeting_recorded,A

Runs the VRU script that plays an error
message if the Agent Greeting selected
to play does not exist.
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Node

Value

Variable:

Array Index: 2

What it does

Specifies the FTP information that the
CVP Server uses to write greeting files
Value: "ftpPath=<path_to_dedicated/
to the media server. The information
directory>"
must match the FTP information
For example: "ftpPath=en-us/app/ag_gr" configured for the media server in the
Unified CVP Operations Console.

Call:user.microapp.
ToExtVXML[]

The value for array index must be 2.
The value consists of:
• ftpPath= to set the path to the
dedicated directory for agent
greeting files.
• The path must begin with the
locale directory.
Variable:

Array Index: 0

Call:user.microapp.

Value: "application=RecordAgentGreeting"

ToExtVXML[]

Identifies the external Unified CVP
micro-application
(RecordAgentGreeting) that is used to
record the greeting.
The value for array index must be 0.

RunExtScript: Run Default
Recording Application

Runs the VRU script that launches the
Get Speech micro-application on the
CVP Server.

GS,Server,V

Descriptive Agent Greeting Type Strings
The previous Agent Greeting record script example stores Agent Greeting Type values as numbers (although
in string format). But suppose you prefer more descriptive string names. For example, “English,” “French,”
and “Spanish.” Or “Sales,” “Billing,” and “Tech Support.” Descriptive names can make it easier to understand
at a glance what different numeric key selections in your scripts correspond to. Note that they also affect how
greeting files are named (for example agent123_English.wav as opposed to agent123_1.wav).
The following script example is almost identical to the previous record script, except that it includes four
additional nodes (highlighted in green). They consist of an additional CED node that maps the keys 1, 2, and
3 to language names. The Run Ext Script node (in gray) was modified for the new options. The rest of the

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
27

Agent Greeting
Agent Greeting Scripts

script is the same with no other changes required. Note that your routing scripts require a corresponding
mapping of numeric keys to language names.
Figure 3: Script with Descriptive Greeting Type Strings

Agent Greeting Play Script
The Agent Greeting feature requires a dedicated routing script that causes the agent greeting to play. This
script is invoked by the PlayAgentGreeting dialed number.
The Play script must contain at least two and possibly four specific nodes, depending on other factors.
You always need the following nodes:
• A Run External Script node that calls the VRU script that plays the greeting.
• A Set Variable node that sets the directory path to your greeting files.
You may also need to include in your scripts Set Variable nodes that:
• Specify the Media Server: Unified CVP lets you specify a default media server. If you are not serving
your audio files from the default media server, your scripts must include a variable that identifies the
server where your audio files are stored.
• Specify the Locale Directory: Additionally, if you are not storing your files in the default locale directory
en-us on the media server, you must include a variable that specifies the name of the locale directory
where the files are stored.
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Note

The Locale Directory set variable node is optional. It is needed only if you decide to
use another directory other than the default one.

Figure 4: Agent Greeting Play Script Example

Administration and Usage
Use Agent Greeting with Your Finesse Desktop
Configure Custom Dialed Number for Finesse Agent Greeting Record
Finesse does not support the default Record Greeting button that ships with CTI OS. To record Agent Greetings
with Finesse, create your own custom dialed number for recording. You may want to create different dialed
numbers for different customers.
To record the greeting, your agents can enter the record dialed number using the dial pad on their desktops.
Use the following steps to create a custom dialed number for Finesse Agent Greeting Record:
1 Create a CTI Route Point in Unified CM and associate it with an Application User (PG User).
2 Create a Dialed Number in Unified ICM for the CTI Route Point created in Unified CM.
3 Create a Call Type for the Custom Dialed Number.
4 Associate the Call Type and Dialed Number with the Record Agent Greeting Script.
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5 Create a Phonebook Entry in Finesse for the agent to dial the Custom Dialed Number.

Use Agent Greeting with Your CTI OS Agent or Supervisor Desktop
Record a Greeting
Recording an Agent Greeting is very similar to recording a personal message for your voice mail. To record
a greeting, you must be logged in to your desktop software and in the Not Ready state. To record a greeting:

Procedure
Step 1
Step 2

Step 3

Step 4

Click the Agent Greeting Record button on your desktop.
You may hear a brief ring tone, after which you receive voice instructions for recording a greeting. Options
may include selecting a greeting type (if your contact center uses more than one greeting per agent), recording,
playing back, and confirming whether to use the new greeting. There is also an option for listening to your
existing greetings.
After you connect to the Record Greeting service, a dialog box containing a dial pad appears on your agent
desktop. You can use the dial pad or the keypad on your phone to make your selections. (If you close the
dialog box before you finish recording your greeting, you cannot re-open it; use the keypad on your hard
phone to complete your recording.)
To exit without recording a greeting, release the call.
The number of greetings that you need to record is determined by your contact center. It may vary depending
on things like your skill group or Precision Queue membership or the time of day or day of the week. Your
contact center also determines how long your greeting can be. When you are recording, if you reach the
maximum recording time, you receive a notification.

Delete Greeting
You cannot delete an agent greeting. However, you can record over previously recorded greetings. When you
record over a greeting, the new greeting is used for the next customer call you take.

Review Greetings
To listen to your current greetings, click the Agent Greeting Record button on your desktop and select a
greeting.

Enable or Disable Greeting Play
Your CTI desktop toolbar includes a Greeting button that you can use to turn the Agent Greeting feature on
or off. There are various reasons you might want to turn off your greeting. You might want to turn off your
greeting on a day when you have a cold and you are concerned that your voice does not sound like your
recorded message. Or you might want to turn off a greeting that was appropriate yesterday but is not today,

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
30

Agent Greeting
Reporting

until you have time to go Not Ready and record a new one. Turning off Agent Greeting does not affect a
greeting that is already playing to a caller.
Turning off Agent Greeting stops your greetings from playing until you manually turn it back on again, or
until the next time you log in to the desktop; Agent Greeting is always automatically turned on at login.

To turn Agent Greeting off, with Greeting enabled, click the Greeting button.

To turn Agent Greeting back on, click the Greeting button again.

Agent Greeting with the Outbound Agent Desktop
Agent greetings play to inbound callers only; they do not play when you make an outbound call. If you are
an outbound-only agent, you can still record greetings but they do not play, even when Agent Greeting play
is turned on in your desktop toolbar.

Agent Greeting During Transfers and Conferences
When you blind transfer a call to another agent, your customer hears the other agent's greeting (assuming that
agent has greeting enabled). Similarly, when you conference in another agent, all parties on the call hear the
other agent's greeting.
Consultative transfers work a little differently. When you place a consultative transfer, your customer does
not normally hear the other agent's greeting, unless you transfer the customer while the other agent's greeting
is still playing.

Reporting
In agent, skill group, and precision queue reports, greeting time is not specifically broken out. The period
during which the greeting plays is reported as talk time. Record time is counted as an internal call by the
default skill group.
Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to
Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values
in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting
purposes.

Greeting Call Statistics
To view greeting call statistics, create a separate call type and associate it with the routing script that plays
agent greeting. New Cisco Unified Intelligence Center templates for the agent greeting call type are created
based on the data in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

Peripheral Call Types for Agent Greeting
There are two peripheral call types specific to Agent Greeting that you can use to track and report on the
feature.
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• Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.
• Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Serviceability
Serviceability for Agent Greeting includes SNMP events captured by your Network management software
that indicate reasons for greeting failures and counters to track the number of failed greeting events.

Note

There is no counter for the number of failed agent greeting calls.
When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio
file cannot be found for any reason, the call proceeds normally without the Agent Greeting.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
32

CHAPTER

4

Agent Request
• Agent Request Feature Description, page 33
• Configure Packaged CCE for Agent Request, page 36
• Configure SocialMiner for a Voice Callback Agent Request, page 37
• Create Script for Agent Request, page 39
• Sample Code to Create Customer Callback Request, page 41
• Agent Request Reporting, page 42

Agent Request Feature Description
The Agent Request feature allows a customer to initiate a request on the web that results in a call from an
agent.
Cisco SocialMiner works in a Contact Center Enterprise (CCE) solution to process the request from its
inception through the delivery of the callback.

Note

Unified WIM also offers callback and delayed callback. You can use Agent Request , Unified WIM, or
both.

Important

The Agent Request feature can be used only if the customer or a partner develops a custom application.
There is sample code on the DevNet (formerly Cisco Developer Network) that you can use to understand
how to start building your custom application to submit callback requests to SocialMiner.

SocialMiner and Agent Request
SocialMiner provides the Callback API used by a custom application to request a phone call from a contact
center agent.
The API works in conjunction with SocialMiner callback feeds, campaigns, and notifications to pass callback
requests to the contact center for routing.
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The Callback API:
• Allows custom applications to initiate a callback.
• Forwards the callback request and callback details to CCE using a notification mechanism (the Connection
to CCE notification type) through a Media Routing (MR) connection.
• Allows custom applications to retrieve the state of the callback as well as the estimated wait time (EWT)
until an agent becomes available.
• Allows custom applications to cancel a requested callback.
The Callback API supports the use of Call variables and ECC variables for callback requests. Call variables
and ECC variables send customer-specific information with the request. When you create a callback contact,
the social contact associated with the callback contact includes all of the specified variables as extension
fields.
CCE and Agent Request
CCE services in the Agent Request solution:
• Process the callback request.
• Route the callback request to an agent and place a call from the agent's phone to the customer.
• Notify SocialMiner that the agent has been selected.
Agent Desktops and Agent Request
Both Cisco Finesse and CTI OS support Agent Request.

Agent Request Prerequisites
Install and configure SocialMiner before implementing Agent Request. SocialMiner must be geographically
colocated with the Call Server on one side.
The customer or partner must build a custom application for the Agent Request feature. See Sample Code to
Create Customer Callback Request, on page 41
SocialMiner is always deployed in a DMZ. Remember to open the port you have configured for the MR PG.
See Set up the Media Routing PG and PIM, on page 36.

Agent Request Call Flow
Figure 5: Agent Request Call Flow

The flow proceeds as follows:
1 The customer application initiates an agent request by requesting a callback.
2 SocialMiner sends the request to the Unified CCE Call Server.
3 The Unified CCE Call Server sends the request to the agent.
4 A call is initiated from the agent's phone, dialing the customer's phone number.
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Agent Request Scenarios
1 From the web, the customer requests to speak to an agent.
2 The customer receives feedback that the request is accepted.
3 The customer receives feedback that the call is queued and the estimated wait time.
4 The customer receives feedback that a call is on its way.
5 The agent's phone places an outbound call.
6 The agent is presented with call context.
If

Then

The customer is available

The customer receives and answers the call, and speaks to the
agent

The customer is busy when the callback The agent receives a busy tone
occurs
The customer does not answer when the The agent hears ringing
callback occurs
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If

Then

The customer cancels the callback before There is no impact on the agent
an agent is selected

Configure Packaged CCE for Agent Request
Set up the Media Routing PG and PIM
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Navigate to Unified CCE Administration > System > Information. Open the Peripheral Gateways tab to
determine the Peripheral ID for a Multichannel peripheral that is unused.
From Cisco Unified CCE Tools, select Peripheral Gateway Setup.
On the Components Setup screen, in the Instance Components panel, select the PG Instance component. Click
Edit.
In the Peripheral Gateways Properties screen, click Media Routing. Click Next.
Click Yes at the prompt to stop the service.
From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure
with the Client Type of Media Routing as follows.
a) Check Enabled.
b) In the Peripheral Name field, enter MR.
c) In the Peripheral ID field, enter the Peripheral ID for the unused Multichannel peripheral that you identified
in Step 1.
d) For Application Hostname (1), enter the hostname or IP address of SocialMiner.
e) Make a note of the default Application Connection Port. You will use it in the CCE Configuration for
Multichannel Routing for SocialMiner.
The Application connection port defaults to 38001; this is the default port on which SocialMiner accepts
MR connections. If you change the default port number for either side of the MR PG, you must change
the second side.
f) Leave the Application Hostname (2), field blank.
g) Keep all other values.
h) Click OK.

Step 7
Step 8
Step 9
Step 10
Step 11
Step 12

Accept defaults and click Next until the Setup Complete screen opens.
At the Setup Complete screen, check Yes to start the service. Click Finish.
Click Exit Setup.
Repeat from Step 1 for Side B.
Navigate to Unified CCE Administration > System > Deployment.
Add SocialMiner as an external machine.
a) Click Add Machine.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
36

Agent Request
Unified CCE Administration Tools

b)
c)
d)
e)

Select SocialMiner from the drop-down list.
Add the name.
Add the hostname or IP address.
Click Save.

Unified CCE Administration Tools
This topic explains the Unified CCE Administration tools you need to configure Agent Request.

Before You Begin
For details on the procedures for steps 2 - 5, refer to the Unified CCE Administration online help or to the
Cisco Packaged Contact Center Enterprise Administration and Configuration Guide at http://www.cisco.com/
en/US/products/ps12586/prod_maintenance_guides_list.html.

Procedure
Step 1
Step 2
Step 3

Sign in to Unified CCE Administration.
Call Type: Create a call type for Agent Request.
Dialed Number: Create a dialed number for Agent Request. You will use this number when you configure
the notification in SocialMiner.
a) For Routing Type, select SocialMiner.
b) For Media Routing Domain, select Cisco_Voice.
c) For Call Type, select the call type that you created in Step 2.

Step 4

Expanded Call Variable: You can use an existing Expanded Call Variable, or you can create an expanded
call variable for Agent Request.
Note
Arrays are not supported with the Agent Request feature.

Step 5

CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call
variables when used with Unified CVP, Finesse, and SocialMiner.
Create a Network VRU Script.

Configure SocialMiner for a Voice Callback Agent Request
To support a callback request, SocialMiner must be configured with:
• A callback feed
• A campaign
• A Connection to CCE notification configured for the campaign mentioned above that will be triggered
by incoming callback requests with a matching tag.
• CCE Configuration for Multichannel Routing must be enabled on the SocialMiner Administration tab.
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Configure SocialMiner to Allow MR PG Connections
Procedure
Step 1
Step 2
Step 3

Click Administration.
In the System Administration panel, click CCE Configuration for Multichannel Routing.
Click Edit.

Step 4

Check the Enabled checkbox.

Step 5
Step 6

Enter the hostnames or IP addresses of the Side A and Side B Unified CCE Call Server so that SocialMiner
will only allow connections from those hosts.
Update the Port (if necessary) to match the port set up on the Unified CCE Call Server, or leave the default.

Step 7

Click Save.

Create Feed
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Click Configuration.
On the Manage Feeds panel, click New.
For Type, select Callback.
Name the feed.
For Reply Template, retain the default, No reply template.
Configure the feed to automatically tag all callback requests that come in on that feed. For example, autotag
with 'sendtocontactcenter'.
Make a note of the tag. It is used to trigger the notification to CCE.
Click Save.
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Create Campaign
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Click Configuration.
On the Manage Campaigns panel, click New.
Name the campaign.
Enter an optional description.
Make no selection in the Chat Invitation Feed drop-down list.
Locate the Callback feed in the Available panel and move it to Selected.
Click Save.

Create Notification
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9

Click Administration.
On the Manage Notifications panel, click New.
For Type, select Connection to CCE.
Name the notification.
From the Campaigns drop-down list, select the campaign that you created for the callback.
In the Tags field, enter the tag that is automatically applied to callback requests by the feed. In our example
'sendtocontactcenter'.
In the Dialed Number/Script Selector field, enter the dialed number string that you have configured.
See Unified CCE Administration Tools, on page 37.
In the Media Routing Domain field, accept the default, Cisco_Voice.
Click Save.

What to Do Next
For more SocialMiner configuration information, see the Cisco SocialMiner User Guide at http://
www.cisco.com/c/en/us/support/customer-collaboration/socialminer/products-user-guide-list.html.

Create Script for Agent Request
This illustration shows a sample script. The key below explains the nodes.
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Start node: Create the Start node by selecting a new Routing Script from the Script Editor.
Set Variable (Call.Calling Line ID) node: (optional). If required, you can set the CallingLineID (CLID/
ANI) variable to implement a "dial-plan," pre-pending a set of digits to the phone number provided by the
customer so that it can be correctly routed. For example, it is often necessary to add 9 to the phone number
to reach an outside line. In other cases, more pre-pended digits may be required to reach the end customer.
You can also set up Unified Communications Manager Route Patterns to respond to a certain set of digits by
routing the call to an outside line with a specified area code. To implement a dial-plan, add a Set Variable
node before the queue, as shown in this example. In this case, a 9 is pre-pended to the customer phone number
using the built-in concatenate function.
Queue to Skill Group node: The Agent Request call can be queued against one or more Skill Groups,
Precision Queues, or a queue-to-agent node. In the example script, the call is queued against a single skill
group.
Set Variable (Call.Estimated Wait Time) node: A customer who requests a voice callback might want to
know approximately how long it will be before the call is returned. You can configure voice callback to
provide an estimate of the wait time back to the customer. The estimated wait time is calculated once, when
the call enters the queue. The time is not updated as the position in the queue changes.
The default estimated wait time algorithm is based on a running five minute window of the rate of calls leaving
the queue. Any calls that are routed or abandoned during the previous 5 minutes are taken into account as part
of the rate leaving queue. For Precision Queues, the rate leaving queue represents the rate at which calls are
delivered or abandoned from the entire precision queue, not any individual recision Queue steps. The algorithm
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computes the wait time for each of the queues against which the call is queued (Skill Groups or Precision
Queues) and then returns the minimum estimated wait time. Queue to Agent is not supported.
While the queue builds, the small number of calls in the queue makes the estimated wait time less accurate
and the value fluctuates rapidly. As the queue operates with more calls over time, the estimated wait time is
more accurate and consistent. If CCE does not have enough data to calculate EWT, the callback API returns
a value of -1. Customers must determine how their custom applications handle this situation.
Note that the built-in function also applies to inbound calls that queue.
Set the Call Wait time as follows:
1 From the Set Variable node, select Call from the Object type drop-down menu.
2 From the Variable drop-down menu, choose Estimated Wait Time().
You can then work with the Formula Editor to use the default estimated wait value or create a formula
and use your own value.
3 Click Formula Editor, and do either of the following:
• To use the default estimated wait value, click the Built-In Functions tab and choose
EstimatedWaitTime()
• To create a formula and use your own value, click the Variables tab and choose an entry in the Object
type list and an entry in the Object list. Then double-click a variable in the Variable list.
Run Ext Script node: Apply the Network VRU script as follows:
1 Click the Queue tab.
2 Click Run External Script.
3 Click inside the script. A Run External Script node appears.
4 Double-click the node and choose the Network VRU script from the list; then click OK.
The call variable Estimated Wait Time now contains a value in the EstimatedWaitTime field and can be
passed to peripherals.
Note that a Run External Script node is required to send the EstimatedWaitTime to SocialMiner.
Wait node: The wait period before an agent becomes available.
End node: The script ends if no agent becomes available.

Sample Code to Create Customer Callback Request
Cisco Systems has made sample callback application code available to use as a baseline in building your own
application. This sample includes retrieving and displaying the estimated wait time, assuming it has been
configured in Unified CCE. You can find the sample code on DevNet.

Note

You cannot copy and paste this code to achieve a working application. It is a only a guideline.
For more information about how to use the Callback API, see the Cisco SocialMiner Developer Guide at
https://developer.cisco.com/site/socialminer/documentation/index.gsp.
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Procedure
Step 1

Retrieve the feed id by entering this URL in a browser:
https://<SocialMiner_Hostname_or_Ip>/ccp-webapp/ccp/feed.
In the example output below, note that the value in the <name> field is "Callback." Look for the number of
the feed id identified at the end of the refURL path (in this case, it is 100000) just before the </refURL> tag.
Copy this number.
<feeds>
<Feed>
<changeStamp>0</changeStamp>
<name>Callback</name>
<pushFeedURL>https://128.107.81.27/ccp/callback/feed/100000</pushFeedURL>
<refURL>https://128.107.81.27/ccp-webapp/ccp/feed/100000</refURL>
<status>1</status>
<tags>
<tag>trial</tag>
</tags>
<type>10</type>
</Feed>
</feeds>

Step 2
Step 3

Access the sample application from DevNet: https://developer.cisco.com/web/socialminer.
Enter values in the fields:
• Title: A title or subject for the callback request.
• Author: The name of the person submitting the callback request.
• Phone: The phone number to call back.
• Feed Id: The value from the refURL above.

Step 4

Click Call me back.

Agent Request Reporting
Cisco Unified Intelligence Center CCE reports include data for Agent Requests

Note

Agent requests that fail before being routed to CCE will not be included in the CCE solution-level reports.
The SocialMiner search function can be used to identify these requests.

Call Type and Call Type Skill Group Metrics
• Calls Offered — Incremented when Call Type is entered (through Script Selector or Call Type node).
• Calls Abandoned in Queue — Incremented when a Queued Callback request is canceled by the
customer prior to when an Agent is selected to handle the Voice Callback call.
• Calls Answered — Incremented if the call is placed from the agent and represents work accepted by
the agent.
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• Calls Handled — Incremented if the customer answers the call. Calls Answered minus Calls Handled
indicates how many calls failed to reach the intended customer.
• Service Level Offered — Incremented for all routed calls, including voice callback calls initiated through
the agent request API.
• ServiceLevelCalls — Incremented if the call is presented to the agent within a service level.
• Answer Intervals (1 - 10) — The appropriate bucket is incremented based on how long the call was in
the queue.
Skill Group Metrics
Call Type Skill Group and Skill Group metrics are not counted in the same way. The skill group metric treats
each call as agent-initiated; therefore, Calls Answered and Calls Handled are not incremented.
AgentOutCallsTime, AgentOutCalls, AgentOutCallsTalkTime, AgentOutCallsOnHold, and
AgentOutCallsOnHoldTime are incremented.
Agent Real Time
The direction in the Agent Real Time table is listed as Outbound.
Termination Call Detail
For custom reporting, the Termination Call Detail records contain a PeripheralCallType of 41 -Voice Callback.
Calls which do not successfully connect to a customer have a call disposition of 10 - Disconnect/Drop no
answer. This includes agent request calls to busy numbers.
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Courtesy Callback
• Capabilities , page 45
• Initial Setup , page 47
• Administration and Usage, page 65

Capabilities
Courtesy Callback reduces the time callers have to physically wait on hold or in a queue. The feature enables
your system to offer callers (who meet your criteria) the option to receive a courtesy callback by the system
instead of waiting on the phone for an agent. The caller who has been queued by Unified CVP can hang up
and subsequently be called back when an agent is close to becoming available (preemptive callback).
Preemptive callback does not change the time a customer must wait to be connected to an agent, but rather
enables the caller to hang up and not be required to remain in queue listening to music. Callers who have
remained in queue or have undergone the callback treatment appears the same to agents answering the call.
If the caller decides to be called back by the system, they leave their name and phone number. Their request
remains in the system and when the system determines that an agent will be available soon (or is available),
then the system places a call back to the caller. The caller answers the call and confirms that they are the
original caller and the system connects the caller to the agent after a brief wait.
In the event that the caller cannot be reached after a configurable max number and frequency of retries, the
callback is aborted and the database status is updated appropriately. You can run reports to determine if any
manual callbacks are necessary based on your business rules.
Note that you cannot schedule a callback for a specific time.

Note

There are a number of prerequisites and design considerations for using this feature. See the Cisco Unified
Customer Voice Portal Release Solution Reference Network Design (SRND) guide.

Note

The Cisco Unified Customer Voice Portal Release Solution Reference Network Design (SRND) guide
also describes how the system determines customer wait time and when to call the customer for the
callback.
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Callback Criteria
In your callback script, you can establish criteria for offering a caller a courtesy callback. Examples of callback
criteria include:
• Number of minutes a customer is expected to be waiting in queue that exceeds a maximum number of
minutes (based on your average call handling time per customer)

Note

The included example scripts use this method for determining callback eligibility.

• Assigned status of a customer (gold customers may be offered the opportunity to be called back instead
of remaining on the line)
• The service a customer has requested (sales calls, or system upgrades, for example, may be established
as callback criteria)

Sample Scripts and Audio Files for Courtesy Callback
The courtesy callback feature is implemented using Unified CCE scripts. The installation provides a set of
modifiable example CCE scripts, call studio scripts, and audio files to get you started. You can use these
scripts in your implementation after making a few required changes.
Related Topics
CCE Script for Courtesy Callback, on page 60

Typical Use Scenario
If the caller decides to be called back by the system, they leave their name and phone number. Their request
remains in the system and the EWT executes when the system places a callback to the caller. The caller
answers the call and confirms that they are the original caller, and the system connects the caller to the agent
after a short wait.

Note

Courtesy Callback is supported for IP originated calls as well.
A typical use of the Courtesy Callback feature follows this pattern:
1 The caller arrives at Unified CVP and the call is treated in the normal IVR environment.
2 The Call Studio and Unified ICM Courtesy Callback scripts determine if the caller is eligible for a callback
based on the rules of your organization (such as in the prior list of conditions).
3 If a courtesy callback can be offered, the system tells the caller the approximate wait time and offers to
call the customer back when an agent is available.
4 If the caller chooses not to use the callback feature, queuing continues as normal.
Otherwise, the call continues as indicated in the remaining steps.
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5 If the caller chooses to receive a callback, the system prompts the caller to record their name and to key
in their phone number.
6 The system writes a database record to log the callback information.

Note

If the database is not accessible, then the caller is not offered a callback and they are placed in queue.
7 The caller is disconnected from the TDM side of the call. However, the IP side of the call in Unified CVP
and Unified ICM is still active. This keeps the call in the same queue position. No queue music is played,
so Voice XML Gateway resources used during this time are less than if the caller had actually been in
queue.
8 When an agent in the service or skill category the caller is waiting for is close to being available (as
determined by your callback scripts), then the system calls the person back. The recorded name is announced
when the callback is made to ensure that correct person accepts the call.
9 The system asks the caller, through an IVR session, to confirm that they are the person who was waiting
for the call and that they are ready for the callback.
If the system cannot reach the callback number provided by the caller (for example, the line is busy, RNA,
network problems, etc.) or if the caller does not confirm they are the caller, then the call is not sent to an
agent. The agent is always guaranteed that someone is there waiting when they take the call. The system
assumes that the caller is already on the line by the time the agent gets the call.
This feature is called preemptive callback as the system assumes that the caller is already on the line by
the time the agent gets the call and that the caller has to wait minimal time in queue before speaking to an
agent.
10 The system presents the call context on the agent screen-pop, as normal.
If the caller cannot be reached after a configurable maximum number and frequency of retries, the callback
is aborted and the database status is updated appropriately. You can run reports to determine if any manual
callbacks are necessary based on your business rules.
See the Configuration Guide for Cisco Unified Customer Voice Portal at http://www.cisco.com/en/US/products/
sw/custcosw/ps1006/products_installation_and_configuration_guides_list.html that explains a call flow
description of the function of the scripts providing the Courtesy Callback feature.

Initial Setup
The Courtesy Callback feature must be configured on the following servers/gateways:
• Ingress Gateway (IOS configuration)
• VXML Gateway (IOS configuration)
• Reporting Server (through the Unified CVP Operations Console)
• Media Server (upload of Courtesy Callback media files)
• Unified CVP VXML Server (upload of Call Studio Scripts)
• Packaged CCE
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Courtesy Callback Design Considerations
The following design considerations apply for Courtesy Callback feature:
• During Courtesy Callback, callback is made using the same Ingress Gateway through which the call
arrived.

Note

In Courtesy Callback, outbound calls cannot be made using any other Egress Gateway.

• Calls that allow Callback must be queued using a Unified CVP VXML Server.
• The Unified CVP Reporting Server is a prerequisite for Courtesy Callback.
• Answering machine detection is not available for this feature. During the callback, the best that can be
done is to prompt the caller with a brief IVR session message and acknowledge with DTMF that they
are ready to take the call.
• Calls that are transferred to agents using DTMF *8, TBCT, or hookflash cannot use the Courtesy Callback
feature.
• Callbacks are a best-effort function. After a limited number of attempts to reach a caller during a callback,
the callback is terminated and marked as failed.
• Customers must configure the allowed or blocked numbers that Callback is allowed to place calls through
the Unified CVP Operations Console.
• Media inactivity detection feature on the VXML Gateway can affect waiting callback calls. For more
information, see the Configuration Guide for Cisco Unified Customer Voice Portal (CVP).
• Courtesy Callback requires an accurate EWT calculation for its optimal behavior.
Consider the following recommendations to optimize the EWT, when using Precision Queues for
Courtesy Callback:
◦Queue the calls to a single Precision Queue
◦Do not include a Consider

If

expression when you configure a step.

◦Do not include a wait time between steps or use only one step in the Precision Queue.

Configure the Ingress Gateway for Courtesy Callback
The ingress gateway where the call arrives is the gateway that processes the preemptive callback for the call,
if the caller elects to receive a callback.

Note

Courtesy callback is supported with Cisco Unified Border Element.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
48

Courtesy Callback
Configure the Ingress Gateway for Courtesy Callback

Procedure
Step 1
Step 2

Step 3
Step 4

Step 5

Log in to the CVP OAMP Operations Console (from the CVP OAMP VM), using this syntax:
https://<server_ip>:9443/oamp.
Copy survivability.tcl from the Operations Console to the flash memory of the gateway. Using the Operations
Console, perform the following:
a) Select: Bulk Administration > File Transfer > Scripts and Media.
b) In Device Association, for Select Device Type select: Gateway.
c) Select all the Ingress gateways.
d) From the default gateway files, highlight: survivability.tcl.
e) Click Transfer.
Log in to the ingress gateway.
If survivability is not already configured, configure it as described in the "Call Survivability" section of the
Configuration Guide for Cisco Unified Customer Voice Portal at http://www.cisco.com/c/en/us/support/
customer-collaboration/unified-customer-voice-portal/products-installation-and-configuration-guides-list.html.
To add services to the gateway, you must be in enabled-config application mode. Type these commands at
the gateway console:
GW81#en
GW81#config
Configuring from terminal, memory, or network [terminal]?
Enter configuration commands, one per line. End with CNTL/Z.
GW81(config)#application
GW81(config-app)#

Step 6

Add the following to the survivability service:
param ccb id:<host name or ip of this gateway>;loc:<location name>;trunks:<number of callback
trunks>

Where the definitions of the preceding fields are:
• id: A unique identifier for this gateway and is logged to the database to show which gateway processed
the original callback request.
• loc: An arbitrary location name specifying the location of this gateway.
• trunks: The number of DS0's reserved for callbacks on this gateway. Limit the number of T1/E1 trunks
to enable the system to limit the resources allowed for callbacks.
The following example shows a basic configuration:
service cvp-survivability flash:survivability.tcl
param ccb id:10.86.132.177;loc:doclab;trunks:1
!

If you are updating the survivability service, or if this is the first time you created the survivability service,
remember to load the application using the command:
call application voice load cvp-survivability
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Step 7

Create the incoming dial peer, or verify that the survivability service is being used on your incoming dial peer.
For example:
dial-peer voice 978555 pots
service cvp-survivability
incoming called-number 9785551234
direct-inward-dial
!

Note: We support both POTS and VoIP dial peers that point to a service provider.
Step 8

Create outgoing dial peers for the callbacks. These dial peers place the actual callback out to the PSTN. For
example:
dial-peer voice 978554 pots
destination-pattern 978554....
no digit-strip
port 0/0/1:23
!

Step 9

Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:
voice service voip
signaling forward unconditional

Step 10 Save your changes.

Configure the VXML Gateway for Courtesy Callback
To configure the VXML gateway for Courtesy Callback:

Procedure
Step 1

Copy cvp_ccb_vxml.tcl from the CVP OAMP Operations Console to the flash memory of the gateway. Using
the Operations Console:
a)
b)
c)
d)

Step 2

Select: Bulk Administration > File Transfer > Scripts and Media.
In Device Association, for Select Device Type select: Gateway.
From the default gateway files, highlight: cvp_ccb_vxml.tcl.
Click Transfer.

To add services to the gateway, you must be in enabled-config application mode. Type these commands at
the gateway console:
GW81#en
GW81#config
Configuring from terminal, memory, or network [terminal]?
Enter configuration commands, one per line. End with CNTL/Z.
GW81(config)#application
GW81(config-app)#
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Step 3

Add the cvp_cc service to the configuration:
service cvp_cc flash:cvp_ccb_vxml.tcl

The service does not require any parameters.
Load the application with the command:
call application voice load cvp_cc

The media-inactivity detection feature must be turned off in the VXML Gateway to successfully call
back the caller. With media-inactivity enabled on the VXML Gateway, the cvp_cc service will
disconnect the waiting callback calls after 'ip rtcp report interval' * 1000-milliseconds interval. This
configuration becomes important in a colocated Ingress/VXML setup where media inactivity timers
are always enabled. In such scenarios, the 'ip rtcp report interval' must be increased to support the
maximum allowable waiting for a callback call as defined by the solution requirements.
On the VoIP dial-peer that defines the VRU leg from Packaged CCE, verify that the codec can be used for
recording. The following example shows that g711ulaw can be used for recording in Courtesy Callback:
Note

Step 4

dial-peer voice 123 voip
service bootstrap
incoming called-number 123T
dtmf-relay rtp-nte
codec g711ulaw
no vad
!

In other words, this example shows the g711ulaw codec set on the 123 voip dial-peer. The codec must be
specified explicitly. A codec class cannot be used because recording will not work.
Step 5

Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:
voice service voip
signaling forward unconditional

Step 6

VXML 2.0 is required to play the beep to prompt the caller to record their name in the BillingQueue example
script. Add the following text to the configuration so the VXML Server uses VXML 2.0:
vxml version 2.0

Note

Whenever vxml version 2.0 is enabled on the gateway,vxml audioerror is off by default. When an
audio file cannot be played, error.badfetch will not generate an audio error event. To have the gateway
generate an error.badfetch event when a file cannot be played, enable vxml audioerror in your gateway
configuration. The following example uses config terminal mode to add both commands:
config t
vxml version 2.0
vxml audioerror
exit

Step 7

Save your changes.
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Configure the Reporting Server for Courtesy Callback
A Reporting Server is required for the Courtesy Callback feature. The Reporting Server must be installed and
configured prior to completing the following task.
For instructions, see the Cisco Packaged Contact Center Enterprise Installation and Upgrade Guide at http:/
/www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
products-installation-guides-list.html.
Once you have added the Reporting Server, configure the Reporting Server for courtesy callback using the
following procedure:

Procedure
Step 1
Step 2

Login to the CVP Operations Console, using this syntax: https://<server_ip>:9443/oamp.
In the Operations Console, select System > Courtesy Callback. The Courtesy Callback Configuration
page opens.
From this window, on the General tab you can:
• Select the Reporting Server for Courtesy Callback
• Enable secure communication with the Courtesy Callback database
• Configure allowed and disallowed dialed numbers
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These operations are described in the following steps.
Figure 6: Courtesy CallBack Configuration

Step 3

Step 4
Step 5

On the Courtesy Callback Configuration page, select the Unified CVP Reporting Server drop-down list,
and select the Reporting Server to use for storing Courtesy Callback data.
Note
If you do not have a Reporting Server configured, refer to the notes at the beginning of this procedure
to configure one.
If desired, enable secure communication with the callback reporting database. Check Enable secure
communication with the Courtesy Callback database.
Configure allowed and denied dialed numbers. These are the numbers that the system should and should not
call when it is making a courtesy callback to a caller. Also configure the Maximum Number of Calls Per
Calling Number.
Use the following table to configure these fields:
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Field

Description

Default

Allow
Unmatched
Dialed
Numbers

This checkbox controls whether or not dialed numbers that do Unchecked - Callbacks can
not exist in the Allowed Dialed Numbers field can be used for only be sent to dialed
a callback.
numbers listed in the
By default, this is unchecked. If no dialed numbers are present Allowed Dialed Numbers
in the Allowed Dialed Numbers list box, then Courtesy Callback list.
does not allow any callbacks.

Allowed
Dialed
Numbers

The list of allowed dialed numbers to which callbacks can be
sent. You can use dialed number patterns, for example 978>
allows callbacks to all phone numbers in the area code 978.
To Add/Remove Dialed Numbers:

Empty - If Allow
Unmatched Dialed
Numbers is not checked, and
this list remained empty, then
no callbacks can be made.

• To Add a number to the list of allowed dialed numbers Enter the dialed number pattern in the Dialed Number
(DN): field and click Add.
• To remove a number from the list - Highlight the number
and click Remove.
Denied
Dialed
Numbers

The list of denied dialed numbers to which callbacks are never The Denied Dialed Numbers
sent. You can use dialed number patterns, for example 555>
window is prepopulated if
disallows callbacks to all phone numbers in the area code 555. your local language is
"en-us"(United States,
To Add/Remove Dialed Numbers:
English). Be sure to add any
additional numbers you want
• To Add a number to the list of denied dialed numbers to deny.
Enter the dialed number pattern in the Dialed Number
(DN): field and click Add.
• To remove a number from the list - Highlight the number
and click Remove.
Denied numbers takes precedence over allowed numbers.
• Wildcarded DN patterns can contain "." and "X" in any
position to match a single wildcard character.
• Any of the wildcard characters in the set ">*!T" will match
multiple characters but can only be used trailing values
because they will always match all remaining characters
in the string.
• The highest precedence of pattern matching is an exact
match, followed by the most specific wildcard match.
• When the number of characters are matched equally by
wildcarded patterns in both the Allowed Dialed Numbers
and Denied Dialed Numbers lists, precedence is given to
the one in the Denied Dialed Numbers list.
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Step 6
Step 7

Field

Description

Default

Maximum
Number of
Calls Per
Calling
Number

The default value is 0 which is equivalent to an unlimited number 0
of callbacks offered per calling number. The maximum value is
1000.
This setting allows you to limit the number of calls, from the
same calling number, that are eligible to receive a callback when
there are outstanding callbacks already waiting for this number.
If this field is set to a positive number (X), then the courtesy
callback “Validate” element only allows X callbacks per calling
number to go through the “preemptive” exit state at any time. If
there are already X callbacks offered for a calling number, new
calls go through the “none” exit state of the “Validate” element.
In addition, if no calling number is available for a call, the call
always goes through the “none” exit state of the “Validate”
element.

Click the Call Server Deployment tab and move all four CVP Call Servers from the Available box to the
Selected box.
Click Save & Deploy to deploy the new Reporting Server configuration immediately.
If you click Save, the configuration is saved and becomes active (is deployed) the next time the Reporting
Server restarts.

Configure the Media Server for Courtesy Callback
Several Courtesy-Callback-specific media files are included with the sample scripts for Courtesy Callback.
During the Unified CVP Operations Console Server installation , these files are placed in the following
directory:
%CVP_HOME%\OPSConsoleServer\CCBDownloads\CCBAudioFiles.zip

After CVP installation, the files are located on the CVP OAMP Server, in %CVP_Home%\OPSConsoleServer\.
A typical value for %CVP_Home% is C:\Cisco\CVP.
CCBAudioFiles.zip has callback-specific application media files under
C:\inetpub\wwwroot\en-us\app and media files for Say It Smart under
C:\inetpub\wwwroot\en-us\sys.
The special audio files should be unzipped and copied to your media server.

Note

If you selected the Media File installation option, during the Unified CVP install, the audio files were
unzipped and copied to C:\inetpub\wwwroot\en-us\app on the installation server.
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Note

CCBAudioFiles.zip also contains media files for Say It Smart. During installation, these files are copied
to C:\inetpub\wwwroot\en-us\sys. Copy these files to your media server, if you do not have
them there already.

Note

The sample scripts are set up to use the default location of http://<server>:<port>/en-us/app
for the audio files. Later in this configuration process you will change the <server> and <port> parameters
in the default location of the audio files in the example scripts to be your media server IP address and port
number.

Configure Call Studio Scripts for Courtesy Callback
The Courtesy Callback feature is controlled by a combination of Call Studio scripts and ICM scripts. Refer
to the Design Guide for Cisco Unified Customer Voice Portal (formerly the Cisco Unified Customer Voice
Portal Solution Reference Network Design) at http://www.cisco.com/c/en/us/support/customer-collaboration/
unified-customer-voice-portal/products-implementation-design-guides-list.html for a discussion of the script
logic.
To configure the Call Studio scripts, perform the following procedure:

Note

This example follows the BillingQueue example application.

Procedure
Step 1

Extract the example Call Studio Courtesy Callback scripts contained in CourtesyCallbackStudioScripts.zip
to a folder of your choice on the computer running Call Studio.
You can access the .zip file from the following two locations:
• From the Unified CVP install media in \CVP\Downloads and Samples\Studio
Samples\CourtesyCallbackStudioScripts
• From the Operations Console server in %CVP_HOME%\OPSConsoleServer\StudioDownloads.

Step 2

Each folder contains a Call Studio project having the same name as the folder. The five individual projects
comprise the Courtesy Callback feature.
Do not modify the following scripts:
• CallbackEngine: Keeps the VoIP leg of the call alive when the caller elects to receive the callback (and
hangs up) and when the caller actually receives the callback. Do not modify this script.
• CallbackQueue: Handles the keepalive mechanism for the call when callers are in queue and listening
to the music played by BillingQueue.
Modify the following scripts to suit your business needs:
• BillingQueue: Determines the queue music played to callers.
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• CallbackEntry: Modify the initial IVR treatment a caller receives when entering the system and is
presented with an opportunity for a callback.
• CallbackWait: Modify the IVR treatment a caller receives when they respond to the callback.
Do not change the CCB application
names.
Start Call Studio by selecting Start > Programs > Cisco > Cisco Unified Call Studio.
In Call Studio, select File > Import.
In the Import dialog box, expand the Call Studio folder and select Existing Call Studio Project Into
Workspace .
Click Next.
In the Import Call Studio Project From File System dialog, browse to the location where you extracted the
call studio projects. For each of the folders that were unzipped, select the folder (for example BillingQueue)
and click Finish.
The project is imported into Call Studio. Repeat this action for each of the five folders.
Note

Step 3
Step 4
Step 5
Step 6
Step 7

When you are finished importing the five folders, you should see five projects in the Navigator window in
the upper left.
Step 8

Update the Default Audio Path URI field in Call Studio to contain the IP address and port value for your
media server.
For each of the Call Studio projects previously unzipped, complete the following steps:
a) Select the project in the Navigator window of Call Studio.
b) Click Project > Properties > Call Studio > Audio Settings.
c) On the Audio Settings window, modify the Default Audio Path URI field by supplying your server IP
address and port number for the <Server> and <Port> placeholders.
d) Click Apply, and then click OK.

Step 9

Billing Queue Project: If desired, change the music played to the caller while on hold.
You can also create multiple instances of this project if you want to have different hold music for different
clients, for example, BillingQueue with music for people waiting for billing, and SalesQueue with music for
people waiting for sales. You also need to point to the proper version (BillingQueue or SalesQueue) in the
ICM script. In the ICM script, the parameter queueapp=BillingQueue would also have a counterpart,
queueapp=SalesQueue.
The CallbackEntry Project (in the following step) contains a node called SetQueueDefaults. This node contains
the value Keepalive Interval which must be greater than the length of the queue music you use. Refer to the
Keepalive Interval in the next step for details.

Step 10 Callback Entry Project: If desired, in the CallbackEntry project, modify the caller interaction settings in the
SetQueueDefaults node.
This step defines values for the default queue. You can insert multiple SetQueueDefaults elements here for
each queue name, if it is necessary to customize configuration values for a particular queue. If you do not
have a SetQueueDefaults element for a given queue, the configuration values in the default queue are used.
You can define a Callback_Set_Queue_Defaults node with Queue Name parameter set to default.
Configuration defined in this default node will be picked whenever a queue type is encountered for
which there are no explicitly defined values.
a) In the Call Studio Navigator panel, open the CallBackEntry project and double click app.callflow to
display the application elements in the script window.
b) Open the Start of Call page of the script using the tab at the bottom of the script display window.
Note
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c) Select the SetQueueDefaults node.
d) In the Element Configuration panel, select the Setting tab and modify the following default settings as
desired:
For the SetQueueDefaults element, the caller interaction values in the Start of Call and the Wants Callback
elements, may be edited.
Step 11 Perform the following steps.
1 Set the path for the storage of recorded caller names.
2 Select app.callflow.
3 In the CallbackEntry project, on the Wants Callback page, highlight the Record Name node and click the
Settings tab in the Element Configuration window of Call Studio.
4 In the Path setting, change the path to the location where you want to store the recorded names of the
callers.
By default, Call Studio saves the path string in your VXML Server audio folder. If you are using the default
path, you can create a new folder called recordings in the
%CVP_HOME%\VXMLServer\Tomcat\webapps\CVP\audio\ folder on the VXML Server. If you
are using IIS as your media server, create a new folder called recordings under
C:\Inetpub\wwwroot\en-us\app and set that as the path for recordings.
Step 12 Set the name of the Record name file.
From the CallbackEntry project on the Wants Callback page, highlight the Add Callback to DB node and
select the Settings tab in the Element Configuration window of Call Studio.
Change the Recorded name file setting to match the location of the recording folder you created.
This setting references the URL of the recordings folder, whereas the Path setting references the file system
path.
The AddCallback element setting in the CallbackEntry project is configured to do automatic recorded file
deletions. If automatic recorded file deletion is not desired, then remove the value of the Recorded name path
setting in the AddCallback element. This removal action assumes that you will be doing the deletion or
management of the recorded file yourself.
Step 13 In the CallbackEntry project on the Callback_Set_Queue_Defaults node, be sure the keepalive value (in
seconds) is greater than the length of the queue music being played. The default is 120 seconds.
Step 14 Save the CallbackEntry project.
Step 15 CallbackWait Project: Modifying values in the CallbackWait application.
In this application, you can change the IVR interaction that the caller receives at the time of the actual callback.
The caller interaction elements in CallbackWait > AskIfCallerReady (page) may be modified. Save the
project after you modify it. The WaitLoop retry count can also be modified from the default of six retries in
the Check Retry element. This will allow a larger window of time to pass before the call is dropped from the
application. It is used in a failure scenario when the CallbackServlet on the reporting server cannot be reached.
For instance, in a reboot or a service restart, this allows more time for the reporting server to reload the entry
from the database when it is initializing. If the reporting server is not online within the retry window, then
the entry will not be called back.
Step 16 Validate each of the five projects associated with the Courtesy Callback feature by right-clicking each Courtesy
Callback project in the Navigator window and selecting Validate.
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Deploy VXML Application to VXML Server (Preferred Method)
You can deploy a VXML application to the VXML Server using the Bulk Administration VXML Applications
feature.

Procedure
Step 1
Step 2
Step 3
Step 4

After validating and saving your applications, in the navigator panel of Call Studio (top left), right-click and
select all the applications you want to deploy.
Click Deploy.
In the Deploy Destination area, select Archive File and click Browse.
Navigate to the archive folder that you have set up; for example,
C:\Users\Administrator\Desktop\Sample.

Step 5

Enter the name of the file; for example, Samplefile.zip.

Step 6
Step 7
Step 8
Step 9
Step 10

Click Save.
In the Deploy Destination area, click Finish.
Log in to the CVP OAMP server and navigate to Bulk Administration\File Transfer\VXML Applications.
Select the VXML Server to which you want to deploy the applications.
Select the zip file that contains the applications; for example, Samplefile.zip.

Step 11 Click Transfer.

Deploy VXML Application to VXML Server (Alternate Method)
You can use this alternate method to deploy a VXML application to the VXML server.

Procedure
Step 1
Step 2
Step 3
Step 4

Right click each of the projects and click Deploy, then click Finish. This deploys them to your VXML
server(s).
On your VXML server, using Windows Explorer, navigate to the %CVP_HOME%\VXMLServer\admin
folder.
Deploy all new apps by double clicking on deployAllNewApps.bat file located in admin directory.
Verify that all the applications are running by navigating to%CVP_HOME%\VXMLServer\admin and
double-clicking status.bat. All five applications should be listed under Application Name, and the status
for each one should be Running.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
59

Courtesy Callback
CCE Script for Courtesy Callback

CCE Script for Courtesy Callback
The following discussion provides an overview of the scripts used for the courtesy callback feature. There
are nine numbered blocks, or sets of blocks, identified in the following figure.

Note

In the following example, the yellow comment blocks describe first the value being set and then the place
where the value is being sent.
Figure 7: Setting Value for Courtesy Callback

The following bullets provide descriptions for the numbered blocks in the preceding graphic:
• Block 1: Enable callback or shut it off.
• Block 2: Compute average wait time. Once the caller is in queue, calculate the Estimated Wait Time
(EWT) for that queue and place the value in ToExtVXML[0].
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If there is poor statistical sampling because of sparse queues and the wait time cannot be calculated in
the VXML Server, use the ICM-calculated estimated wait time.
One method of calculating EWT (the method used in this example) is:
ValidValue(((SkillGroup.%1%.RouterCallsQNow+1)
*
(ValidValue(SkillGroup.%1%.AvgHandledCallsTimeTo5,20))
/max(
SkillGroup.%1%.Ready,
(SkillGroup.%1%.TalkingIn
+
SkillGroup.%1%.TalkingOut
+
SkillGroup.%1%.TalkingOther))
),100)

Modify this method if you are looking at multiple skill groups (when queuing to multiple skills).
• Block 3: Set up parameters to be passed.
• Block 4: Run this block and prompt the caller. If the caller does not accept the offer for a callback, keep
the caller in the queue and provide queue music.
• Block 5: Set up variables. Call flow returns to this block if the caller elects to receive a callback.
Otherwise, the call remains queuing in the queuing application (BillingQueue in this example) on the
VXML Server.
• Block 6: Run external to Callback engine to keep the call alive. If the agent becomes available and there
is no caller, then agent can't interrupt (do not want an agent to pick up and have no one there).
• Block 7: Has the caller rejected the callback call? If no, then go to block 8.
• Block 8: Compute average wait time, as in block 2.
• Block 9: Set up variables.
• Block 10: Put caller briefly into queue (after caller accepts the actual callback call).

Modifiable Example Scripts and Sample Audio Files
The courtesy callback feature is implemented using Unified CCE scripts. Modifiable example scripts are
provided. These scripts determine whether or not to offer the caller a callback, depending on the callback
criteria (previously described). Sample audio files are also provided.
The example scripts and audio files are located on the CVP installation media in the \CVP\Downloads
and Samples\ folder.
The files provided are:
• CourtesyCallback.ICMS, the ICM script, in the ICMDownloads subfolder
• CourtesyCallbackStudioScripts.zip, a collection of Call Studio scripts, in the
helloStudio Samples subfolder.
The following example scripts are provided:
◦BillingQueue: Plays queue music to callers. Can be customized.
◦Callback Engine: Keeps the VoIP leg of the call alive when the caller elects to receive the callback
(and hangs up) and when the caller actually receives the callback. Do not modify this script.
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◦CallbackEntry: Initial IVR when caller enters the system and is presented with opportunity for a
callback. Can be customized.
◦CallbackQueue: Handles the keepalive mechanism for the call when callers are in queue. Do not
modify this script.
◦CallbackWait: Handles IVR portion of call when caller is called back. Can be customized.
• CCBAudioFiles.zip, in the CCBDownloads subfolder, contains sample audio files that accompany
the sample studio scripts.

Overview of CCE Script Configuration for Courtesy Callback
The provided CCE script for Courtesy Callback contains the necessary sample elements for the Courtesy
Callback feature. However, you must merge this script into your existing CCE scripts.
As a starting point and to run a simple test, import the script into the CCE script editor, validate it with the
CCE script editor validation tool to locate nodes that need extra configuration (such as for Network VRU
scripts and expanded call variables), and then modify the script according to your existing CCE environment.
The general process is as follows:
1 Locate each queue point in every CCE script. For example: Queue To Skill Group, Queue to Enterprise
Skill Group, Queue to Scheduled Target or Queue to Agent.
2 Categorize each queue point according to the pool of resources that it is queuing for. Each unique pool of
resources will ultimately require a queue in VXML Server if Courtesy Callback is going to be offered for
that resource pool. For example, using the following example, QueueToSkill X and QueueToSkill Z are
queuing for the exact same resource pool (despite the different queuing order). Queue to Skill Y, however,
is queuing to a different pool because it includes Skill Group D.
• QueueToSkillGroup X is queuing for Skill Group A, B, C in that order.
• QueueToSkillGroup Y is queuing for Skill Group A, C and D in that order.
• QueueToSkillGroup Z is queuing for Skill Group C, B, A in that order.
3 Assign a unique name to each unique resource pool. In the above example, we can use names ABC and
ACD as example names.
4 For each resource pool, decide whether callbacks will be allowed in that resource pool. If yes, then every
occurrence of that resource pool in all ICM scripts must be set up to use VXML Server for queuing. This
is to ensure that the Courtesy Callback mechanism in the VXML Server gets a full, accurate picture of
each resource pool's queue.
5 For any queue point where Courtesy Callback will be offered, modify all CCE scripts that contain this
queue point according to the guidelines in the following CCE script examples.

Configure the CCE Script for Courtesy Callback
Many of the following configuration items relate to the numbered blocks in the diagram and provide
understanding for CCE Script for Courtesy Callback (for more information, see CCE Script for Courtesy
Callback, on page 60). Steps that refer to specific blocks are noted at the beginning of each step.
To configure CCE to use the sample Courtesy Callback CCE script, perform the following steps:
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Procedure
Step 1

Copy the CCE example script, CourtesyCallback.ICMS to the CCE Admin Workstation.
The example CCE script is available in the following locations:
• On the CVP install media in \CVP\Downloads

and Samples\.

• From the Operations Console in %CVP_HOME%\OPSConsoleServer\ICMDownloads
Step 2

Perform these steps:
a) Enable the user.CourtesyCallbackEnabled ECC variable.
b) Enable the user.microapp.ToExtVXML ECC variable and verify that it is set up as an array with a maximum
array size of 5 elements.
c) Enable the user.microapp.FromExtVXML ECC variable and verify that it is set up as an array with a
maximum array size of 4 elements.

Step 3

Make sure the VXML_Server_Interruptible and the VXML_Server_Noninterruptible Network VRU scripts
exist.
Once the script is open in Script Editor, open the Set media server node and specify the URL for your VXML
Server.
For example: http://10.86.132.139:7000/CVP

Step 4

With the current implementation of CVP, you do not have to specify the VXML Server URL. You do, however,
have to enter some numeric value; for example "1" (with quotes).
Step 5

Map the route and skill group to the route and skill group available for courtesy callback.
a) In Script Editor, select File > Import Script....
b) In the script location dialog, select the CourtesyCallback.ICMS script and click Open.
c) In the Import Script - Manual Object Mapping window, map the route and skill group to the route and
skill group available for courtesy callback (identified previously).
In Packaged CCE deployments, the route tool does not exist. Routes have one-on-one mappings with skill
groups, so when you create a skill group, a route is created with the same name.

Step 6

Block #2: If you wish to use a different estimated wait time (EWT), modify the calculation in block #2. You
must do this if you use a different method for calculating EWT or if you are queuing to multiple skill groups.
Block #3: Set up the parameters to be passed to CallbackEntry (VXML application).
Note
This step assumes that you have already configured the CCE and expanded call variables not related
to Courtesy Callback.
Variable values specific to Courtesy callback include:

Step 7

ToExtVXML[0] = concatenate("application=CallbackEntry",";ewt=",Call.user.microapp.ToExtVXML[0])
ToExtVXML[1] = "qname=billing";
ToExtVXML[2] = "queueapp=BillingQueue;"
ToExtVXML[3] = concatenate("ani=",Call.CallingLineID,";");
Definitions related to these variables are:
• CallbackEntry is the name of the VXML Server application that is executed.
• ewt is calculated in Block #2.
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• qname is the name of the VXML Server queue into which the call is placed. There must be a unique
qname for each unique resource pool queue.
• queueapp is the name of the VXML Server queuing application that is executed for this queue.
• ani is the caller's calling Line Identifier.
Step 8
Step 9

Verify that you have at least one available skill group to map to the skill group in the example script.
Save the script, then associate the call type and schedule the script.
For information about scheduling scripts, see the Cisco Packaged Contact Center Enterprise Administration
and Configuration Guide at http://www.cisco.com/c/en/us/support/customer-collaboration/
packaged-contact-center-enterprise/products-maintenance-guides-list.html.

View Courtesy Callback Deployment Status
You can verify the latest deployment status of the Courtesy Callback configuration using the Unified CVP
Operations console. The deployment status is listed for each Unified CVP Call Server.

Procedure
To view the deployment status of Courtesy Callback configurations:

Procedure
Step 1

Select System > Courtesy Callback.
The configuration window opens.

Step 2

From the toolbar, click Deployment Status.
The Courtesy Callback Deployment Status window displays the device IP address and current status. Note
that you can click Refresh to view the latest status.
In the following cases, the Deployment Status displays a warning message:
• If you have only saved the configuration details and have not deployed them.
• If you have edited or deleted an existing configuration and have not deployed the changes.
• If you changed the call server association.
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Administration and Usage
Element Specifications for Courtesy Callback
The example IVR scripts provided for Courtesy Callback work as installed. To change how Courtesy Callback
works, you can change the configuration of Courtesy Callback elements. This section lists the elements
associated with Courtesy Callback and briefly describes the purpose of each one.

Callback_Add
The Callback_Add element is used to add a callback object to the database after all the callback information
has been collected from the caller. In addition, it can be optionally configured to automatically delete old
recorded files at specified intervals. These recorded files are the files produced by the Record element when
the user records his/her name if they want a call back in the CallbackEntry application.

Callback_Disconnect_Caller
The Callback_Disconnect_Caller element is responsible for disconnecting the caller’s leg of the call. The
IP leg of the call for Unified CVP is preserved to hold the caller’s place in line until the callback is made
back to the caller.

Callback_Enter_Queue
The Callback_Enter_Queue element is responsible for adding a new caller to queue. This element must be
executed for all callers even if the caller may not be offered a callback.

Callback_Get_Status
The Callback_Get_Status element is responsible for retrieving all information about the callback related
to the current call (if a callback exists).

Callback_Reconnect
The Callback_Reconnect element is responsible for reconnecting the caller’s leg of the call.
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Callback_Set_Queue_Defaults
The Callback_Set_Queue_Defaults element is responsible for updating the DBServlet with the values that
should be used for each queue. There is always a default queue type. The values are used whenever a queue
type is encountered for which there are no explicitly defined values. For example, if an administrator has
defined values for a billing and default queues, but the caller is queued for mortgages. In that case, the
application uses the values from Callback_Set_Queue_Defaults.
Note

When the DBServlet is not reachable to check the callback status for the duration of keepalive
interval, the callback entry in the Reporting Server gets marked as a stale cached entry and
subsequently gets cleared. As a result, a callback is not initiated.

Callback_Update_Status
The Callback_Update_Status element is responsible for updating the database after a callback disconnect
or reconnect.

Callback_Validate
The Callback_Validate element is responsible for verifying whether or not a callback can be offered to
the caller during this call. Depending on the outcome of the validation, the Validate element exits with one
of four states.

Callback_Wait
The Callback_Wait element is responsible for sleeping the application for X seconds. The application hands
control back to cvp_ccb_vxml.tcl with the parameter wait=X.
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Capabilities
About Cisco Interaction Manager
Cisco Interaction Manager is a suite of web and email interaction management applications that includes:
• Cisco Unified E-Mail Interaction Manager (Unified EIM) and
• Cisco Unified Web Interaction Manager (Unified WIM)

Cisco Interaction Manager Capabilities
This section briefly describes the key Cisco Interaction Manager features but does not cover all of them. For
information on the full set of Cisco Interaction Manager capabilities, including Supervisory Loop, Preferred
Agent, Auto Pushback, and Proactive Chat, refer to the Cisco Interaction Manager documentation on the
Cisco website (http://www.cisco.com/c/en/us/support/customer-collaboration/unified-email-interaction-manager/
tsd-products-support-series-home.html).

Email
Email is supported by Unified EIM to create a communication channel between a customer and an agent.
There are various steps involved in efficiently responding to emails from customers. Emails are first retrieved
into the system and routed to appropriate users or queues. Once a response is created, it is processed through
the system and sent to the customer.
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Chat
A chat is a real-time interaction between an agent and a customer during which they exchange text messages.
As part of a chat, agents can also push web pages to customers. Based on how chat activities are routed to
agents, they can be categorized as Standalone chats and Integrated chats. An integrated chat is routed to an
integrated queue, and a message is sent to Packaged CCE. The system processes the activity and assigns the
chat to an available agent.

Web Callback
The Web Callback feature allows the user to request a callback by submitting a form on a website. Unified
WIM processes the submitted information and connects the user with an agent. Unified WIM sends a message
to Packaged CCE requesting to route the callback request to the agent.

Delayed Callback
The Delayed Callback feature is similar to the Web Callback feature, but when the Unified WIM receives the
delayed callback request, it adds the request in the Delayed Callback table. Unified WIM sends the HTML
page to the caller, indicating that the caller will receive a callback within a specified time. When the specified
time arrives, Unified WIM moves the request to the Packaged CCE queue for routing to Unified CCE.

Installation
Cisco Interaction Manager Installation in a Packaged CCE Deployment
For Packaged CCE, you can run a single-server installation of Unified EIM and Unified WIM, where all VM
components are installed on the same machine, or you can have a distributed-server installation, where each
VM component is installed on a separate machine.

Note

Keep in mind that an all-in-one deployment may be two actual servers, with the Web Server split into the
DMZ.
If you deploy in a distributed-server environment, you must create and install one each of these six components,
and components must be installed in this sequence:
1 File Server
2 Database Server
3 Messaging Server
4 Application Server
5 Web Server
6 Services Server
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The section that follows explains common tasks are required for virtual machines.

Common Tasks for Virtual Machines
Obtain Installation Media
Obtain the Unified WIM and Unified EIM installation media from a partner or by ordering from Cisco Systems,
Inc.

Download OVA for Unified WIM and EIM
Download .rar file for the OVA for Unified WIM and EIM from https://software.cisco.com/download/
type.html?mdfid=280970910&catid=null. Click the link for EIM/WIM Virtual Machine Templates.
1 Download the .rar file.
2 Extract it locally.
The OVA files are identified by number of agents supported.
3 Select the OVA for the number of email and chat agents that you require.
Packaged CCE supports a maximum of 1000 agents for Unified WIM and EIM.

Create Virtual Machines from the OVA
Procedure
Step 1
Step 2
Step 3

Select the Host in the vSphere client.
Choose File > Deploy OVF Template.
Browse to the location on your local drive where you stored the Unified WIM and EIM OVA. Click Open
to select the file. Click Next.
Step 4 Click Next at the OVF Template Details page.
Step 5 Enter the virtual machine name. It cannot contain spaces or special characters. Enter a maximum of 32
characters. Click Next.
Step 6 On the Name and Location page, enter a name of your choice in the Name field.
Step 7 Choose a datastore on which to deploy the new virtual machine. Click Next.
Step 8 Confirm that the Network Mapping page is correct.
Step 9 Click Finish.
Step 10 At the Successfully Completed message, click Close.

Install Microsoft Windows Server
Complete the following procedure to install Microsoft Windows Server 2012 R2 on all virtual machines for
server-based applications.
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Procedure
Step 1

Mount the Microsoft Windows Server ISO image to the virtual machine.
Check the Connect at power on checkbox when mounting the ISO.

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Power on the VM.
Enter the Language, Time and Currency Format, and Keyboard settings. Click Next.
Click Install Now.
Enter the product key for Windows Server 2012 R2 and click Next.
Select Windows Server 2012 R2 Standard (Server with a GUI) and click Next.
Accept the license terms and click Next.
Select Custom: Install Windows only (advanced), select Drive 0 to install Microsoft Windows Server, and
then click Next.
The installation begins. After the installation is complete, the system restarts without prompting.

Step 9 Enter and confirm the password for the administrator account, and then click Finish.
Step 10 Enable Remote Desktop connections as follows:
a) Navigate to Control Panel > System and Security > System.
b) Click Remote Settings.
c) Click the Remote tab.
d) Select the Allow remote connections to this computer radio button, and click OK.
Step 11 Navigate to Control Panel > System and Security > System and change the name of the computer from the
name randomly generated during Microsoft Windows Server installation. The name cannot contain underscores
or spaces.
You must restart for the change to take effect.

Microsoft Windows Server 2012 R2 is installed. In addition, Internet Explorer 11 is installed automatically.

Note

If you want to install Unified CCE on a multilingual version of Windows Server 2012 R2, run the MUI
language pack. See http://www.microsoft.com/oem/en/installation/downloads/Pages/
Windows-Server-2012-Language-Packs.aspx#fbid=EwmxpS7EfPf.
If Unified CCE language pack is applied on Chinese Windows machine, set the screen resolution to 1600
x 1200.

Install VMware Tools
Use this procedure to install and upgrade VMware tools from the VMware vSphere Client.
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Procedure
Step 1
Step 2

Ensure your Windows virtual machine is powered on.
Right-click the VM in the virtual machine menu, and select Guest > Install/Upgrade VMware Tools. Click
OK on the popup window.

Step 3
Step 4

Log in to the VM as a user with Administrative privileges.
Run VMWare tools from the DVD drive.
The installation wizard starts.
Follow the prompts in the wizard to complete the VMware Tools installation. Choose the Typical installation
option.
When the VMware Tools installation has finished, restart the virtual machine for the changes to take effect.
Once the process is complete, the tools are listed as Running (Current) on the VM's Summary tab in vSphere.

Step 5
Step 6

Install Microsoft SQL Server
Install Microsoft SQL Server on the database server only.
For details on the database installation and the roles of the domain user, see the Cisco Unified Web and E-Mail
Interaction Manager Installation Guide, at http://www.cisco.com/c/en/us/support/customer-collaboration/
unified-email-interaction-manager/products-installation-guides-list.html.

Mount and Unmount ISO Files
Upload ISO image to data store:
1 Select the host in the vSphere client and click Configuration. Then click Storage in the left panel.
2 Select the datastore that will hold the ISO file.
3 Click Browse this datastore.
4 Click the Upload icon and select Upload file.
5 Browse to the location on your local drive where you saved the ISO file, and upload the ISO to the datastore.
Mount the ISO image:
1 Right-click the VM in the vSphere client and select Edit virtual machine settings.
2 Click Hardware and select CD|DVD Drive 1.
3 Check Connect at power on (Device status panel upper right).
4 Click the Datastore ISO File radio button and then click Browse.
5 Navigate to the data store where you uploaded the file.
6 Select the ISO.
Unmount the ISO image:
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1 Right-click the VM in the vSphere client and select Edit virtual machine settings.
2 Click Hardware and select CD|DVD Drive 1.
3 Uncheck Connect at power on (Device status panel, upper right).

Install Cisco Integration Manager
The installation procedures for Unified WIM and EIM are documented in the Cisco Unified Web and E-Mail
Interaction Manager Installation Guide at http://www.cisco.com/c/en/us/support/customer-collaboration/
unified-email-interaction-manager/products-installation-guides-list.html.

Add MR PIM for Unified WIM and Unified EIM
Before You Begin
Packaged CCE customers who intend to use Unified WIM and EIM must access Peripheral Gateway Setup
on both CCE Call Servers to set up a Multichannel PIM that associates Unified WIM and EIM with the MR
PG (PG2).

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Sign in to Unified CCE Administration and navigate to System > Information. Open the Peripheral Gateways
tab to determine the Peripheral ID for a Multichannel peripheral that is unused.
Access the CCE Call Server on Side A.
From Cisco Unified CCE Tools, select Peripheral Gateway Setup.
On the Components Setup screen, in the Instance Components panel, select the PG2A Instance component
for Side A. (Select PG2B for Side B.) Then click Edit.
In the Peripheral Gateways Properties screen, click Media Routing. Then click Next.
Click Yes at the prompt to stop the service.
In the Peripheral Interface Manager pane of the Peripheral Gateway Component Properties dialog box, click
Add , select PIM1, and configure with the Client Type of Media Routing as follows:
a) Check Enabled.
b) In the Peripheral name field, enter MR.
c) In the Peripheral ID field, enter the Peripheral ID for the unused Multichannel peripheral that you identified
in Step 1.
d) In the Application Hostname (1), field, enter the hostname or the IP address of the Unified WIM and EIM
services server machine.
e) In the Application Connection Port (1), field, enter the port number on the Unified WIM and EIM services
server machine that the PIM will use to communicate with the application. The default port is 38001.
f) In the Application Hostname (2), field, leave the field blank.
g) In the Application connection port (2), field, leave the field blank.
h) In the Heartbeat interval (sec) field, enter 5.
i) In the Reconnect interval (sec) field, enter 10.
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j) Click OK.
Step 8
Step 9
Step 10
Step 11
Step 12
Step 13

Accept defaults and click Next until the Setup Complete screen opens.
At the Setup Complete screen, check Yes to start the service. Then Click Finish.
Click Exit Setup.
Repeat from Step 1 for the CCE Call Server on Side B.
Navigate to Web Administration > System > Deployment.
Add E-Mail and Web Interaction Manager as an external machine.
a) Click Add Machine.
b) Select E-Mail and Web Interaction Manager from the drop-down list.
c) Add the name.
d) Add the hostname or IP address.
e) Click Save.

Configuration
Configure and Integrate Packaged CCE with Cisco Interaction Manager
This section describes the process of configuring Packaged CCE objects that are required for integration with
Unified WIM and Unified EIM in Cisco Interaction Manager. The values that you enter during this configuration
are used when you run the Cisco Integration Wizard. Keep a note of them as you configure to facilitate the
wizard process. Having the values on hand will be helpful when you run the Cisco Interaction Manager Wizard.
These objects must be configured in the order in which they are presented here.
Table 3: Overview of Configuration

Object

Configured

Application Instance

The Application Instance (MultiChannel) is created
by the Packaged CCE base configuration.

Configure Media Classes, on page 74

The Media Classes are created by the Packaged CCE
base configuration.

Configure Media Routing Domains, on page 74

Four MRDs are configured by the Packaged CCE
base configuration.

Configure Network VRU

The Network VRU (MR_Network_VRU) is
configured by the Packaged CCE base configuration.

Configure Network VRU Scripts, on page 75

By the user, in Unified CCE Administration.

Configure Call Types, on page 75

By the user, in Unified CCE Administration.

Configure Media Routing Peripheral Gateways (MR By the user, in Configuration Manager.
PGs)
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Object

Configured

Generic PG

This PG, with CTI server address and port number,
is created by the Packaged CCE base configuration.

Configure Application Path, on page 76 and add
members to the path

By the user, in Configuration Manager.

Configure Agents, on page 77

By the user, in Unified CCE Administration.

Agent Desk Settings

The Agent Desk Setting
(Default_Agent_Desk_Settings) is created by the
Packaged CCE base configuration.

Configure Skill Groups, on page 78

By the user, in Unified CCE Administration.

Configure Dialed Numbers, on page 79

By the user, in Unified CCE Administration.

Create Scripts, on page 80

By the user, in Script Editor.

Configure Agent Targeting Rule, on page 80

By the user, in Configuration Manager.

Configure ECC Variables, on page 81

Four ECC variables are configured by the Packaged
CCE base configuration.

Configure Media Classes
A media class defines the type of request you want to set up for routing. Configure a media class for each
media supported by the Unified EIM and WIM deployment. Media classes are required for creating MRDs
and categorize the MRDs based on media type (email, for example).
The following media classes are created automatically. No action is required from you.
• CIM_BC
• CIM_EIM
• CIM_WIM
• CIM_OUTBOUND
Callback and Delayed callback use the existing Cisco_Voice media class, which is already created by the
system.

Configure Media Routing Domains
A Media Routing Domain (MRD) is a collection of skill groups and services that are associated with a common
communication medium. Packaged CCE uses an MRD to route tasks to agents who are associated with a skill
group and a particular medium. A media routing domain is created in Packaged CCE for mapping to queues
in Unified WIM and EIM.
The following media routing domains are created automatically. No action is required from you.
• Cisco_BC
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• Cisco_EIM
• Cisco_EIM_Outbound
• Cisco_WIM

Configure Network VRU Scripts
Configure Network VRU scripts if you want to display dynamic content to chat customers (for example, wait
time, activity ID, etc) while chat requests are being processed by the system. This is an optional feature. The
dynamic messages are configured in Unified EIM and WIM . The name of the Network VRU script that is
configured here is used while configuring the dynamic messages.
Network VRU scripts need to be configured for chat, callback, and delayed callback activities only.
After you configure a Network VRU script, it is visible in the Script Editor Run External Script node. Processing
this script node sends the network VRU script parameters to Unified CVP. Once the system establishes that
the call has been successfully delivered, the Run VRU Script node executes, instructing Unified CVP to run
the network VRU script and apply the call treatment.
For more information Network VRU scripts and creating routing scripts for Packaged CCE, see the Cisco
Packaged Contact Center Enterprise Administration and Configuration Guide at http://www.cisco.com/c/en/
us/support/customer-collaboration/packaged-contact-center-enterprise/products-maintenance-guides-list.html.

Procedure
Step 1
Step 2
Step 3

Sign in to Unified CCE Administration.
Navigate to Manage > Network VRU Scripts.
Click New on the List of Network VRU Scripts window.

Step 4

Complete the fields, referring to the Online Help for field descriptions.
For Routing Type, select Multichannel to route the script to Unified E-Mail Information Manager/Web
Interaction Manager (EIM/WIM) to support customer-agent chat.

Step 5

Save the Network VRU script to return to the List window.

Configure Call Types
Call Types are required to categorize dialed numbers and are used in routing scripts. Individual call types are
required for the following activities: inbound email, outbound email, chat, callback, and delayed callback
activities. Make sure you complete these steps to create a call type for each type of activity.
For example, create call types for CIM_BlendedCollaboration, CIM_Callback, CIM_Delayed_Callback,
CIM_EIM_Inbound,CIM_EIM_Outbound, and CIM_WIM.
Accept the Packaged CCE defaults for each Cisco Interaction Manager (CIM) call type.
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Procedure
Step 1
Step 2
Step 3

Sign in to Unified CCE Administration.
Navigate to Manage > Call Types.
Click New on the List of Call Types window.

Step 4
Step 5

Complete fields, referring to Online Help for field descriptions.
Click Save.

Configure Application Path
Create a single application path and add all the peripheral-MRD combinations for the generic PG to the
application path member list. You do not need to add the voice MRD (Cisco_Voice) to this list.

Procedure
Step 1

In the Configuration Manager window, browse to Tools > List Tools > Application Path List.

Step 2

Double-click Application Path List.

Step 3

In the Name field, click Retrieve. Then click Add to display the Attributes panel.

Step 4

In the Application Instance field, select MultiChannel.

Step 5

In the Name field, select Generic_PG_MultiChannel.

Step 6

In the Application Path Members section, click Add and set the following:
a) From the Peripheral drop-down list, select CUCM_PG1. In the Media Routing Domain field, enter
Cisco_EIM.
b) From the Peripheral drop-down list, select CUCM_PG1. In the Media Routing Domain field, enter
Cisco_EIM_Outbound.
c) From the Peripheral drop-down list, select CUCM_PG1. In the Media Routing Domain field, enter
Cisco_WIM.
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d) From the Peripheral drop-down list, select CUCM_PG1. In the Media Routing Domain field, enter
Cisco_BC.
Step 7

Click Save.

Configure Agents
Agents respond to contacts from customers. All Packaged CCE agents are ICM-Picks-the-Agent (IPTA)
agents. To work with Unified WIM and EIM, agents must be members of skill groups for those features.

Procedure
Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Sign in to Unified CCE Administration.
Navigate to Manage > Agents.
Click New on the List of Agents window.
The New Agent window opens. This window has four tabs: General, Attributes, Skill Groups, and Supervisor.
You cannot save the agent until you have entered all required fields on the General tab. You can complete
other tabs as needed and in any order.
Complete the fields on the General tab, referring to Online Help for field descriptions.
When you complete General tab information, click Save to return to the List window, where a message
confirms the successful creation of the agent. To enter fields in the other tabs, click those tabs.
Complete the Skill Groups tab:
This tab shows the skill group membership for this agent. If the agent is not a member of any skill groups,
the List of Skill Groups shows No Items Found and No Items.
a) Click the magnifying glass to open a popup list of all configured skill groups. Then click the skill groups
you want to add for this agent or supervisor.
Select a skill group that is responsible for Unified WIM and EIM features, such as Chat or an Inbound
Email skill group.
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b) Click Save to return to the List window, where a message confirms the successful creation of the agent.
To enter or change fields in the other tabs, click those tabs.
Step 7
Step 8

Complete the Supervisor tab.
Click Save to return to the List, where a message confirms the successful creation of the agent.

Configure Skill Groups
A skill group is a collection of agents who share a common set of competencies that equip them to handle the
same types of requests. Some examples of skill groups for Unifed WIM and EIM are agents who respond to
chats and agents who handle call backs.
An agent's skill group membership determines the types of contacts that are routed to her.
To integrate Packaged CCE with Unified WIM and EIM, you will create skill groups for each Unified WIM
and EIM feature: callback, delayed callback, outbound email, inbound email, and chat.

Procedure
Step 1
Step 2
Step 3

Sign in to Unified CCE Administration.
Navigate to Manage > Skill Groups.
Click New on the List of Skill Groups window.
The New Skill Group window opens and has two tabs: General and Members. You can complete the tabs in
any order, but you cannot save the skill group until you have entered all required fields on the General tab.

Step 4
Step 5

Complete the fields on the General tab, referring to Online Help for field descriptions.
Complete the Members tab:
This tab shows the list of agents for this skill group. If the skill group has no agents, the Agent field shows
No Items Found and No Items.
a) Click the magnifying glass to open Add Agents.
b) Click the agents you want to add to this skill group. There is no limit to the number of agents in a skill
group.
c) Close Add Agents. The agents you chose appear on the List of Agents, as well as the total agents (number
of entries) for this skill group.
d) Save this tab to return to the List window, where a message confirms the successful creation of the skill
group.
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Configure Dialed Numbers
Dialed numbers are string values used to select the appropriate routing script so that a voice call or a non-voice
task (such as an email or a request for a web chat) can be delivered to an agent. Each dialed number string is
configured with a routing type and a Media Routing Domain, and can be mapped to a call type.
A typical call center requires multiple dialed number strings. To integrate with Unified WIM and EIM, you
must set up dialed number strings for each feature. For example, create call types for CIM_Callback,
CIM_Delayed_Callback, CIM_EIM_Inbound,CIM_EIM_Outbound, and CIM_WIM.
Each dialed number string must have the routing type of E-Mail and Web Interaction Manager and the call
type that corresponds to the Unified WIM or EIM feature.

Before You Begin
Configure the MR PIM for Unified EIM and WIM, and add E-Mail and Web Interaction Manager as an
External Machine in the System Inventory. The configuration must pass validation. See Add MR PIM for
Unified WIM and Unified EIM, on page 72.

Procedure
Step 1
Step 2
Step 3

Sign in to Unified CCE Administration.
Navigate to Manage > Dialed Numbers.
Click New on the List of Dialed Numbers window.

Step 4

Complete fields, referring to Online help.
For Routing Type, select E-Mail and Web Interaction Manager.
For Call Type, select the call type that corresponds to the Unified WIM or EIM feature.

Step 5

Save the dialed number to return to the List screen, where a message confirms the successful creation.
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Create Scripts
This illustration is an example of a routing script for Unified WIM and EIM:

Configure Agent Targeting Rule
To configure integrate Unified WIM and EIM in Packaged CCE, you must configure an Agent Targeting
Rule on the appropriate Multichannel routing client. The routing client for Unified EIM/WIM can be
Multichannel, Multichannel 2, or Multichannel 3, depending on the number of Multichannel peripherals in
the deployment, and the order in which you configured them.
Based on agent targeting rules, if an agent attempts to log in to an extension to which the router cannot target
a call, the peripheral gateway rejects the login request and returns an error that includes why the login request
failed.

Procedure
Step 1

Sign in to Unified CCE Administration, and identify the routing client for the Agent Targeting Rule as follows:
a) Navigate to System > Information.
b) Open the Peripheral Gateways tab, and find the row in the MR_PG Peripherals table with the Peripheral
ID for the Unified EIM/WIM Multichannel PIM. The value in the Name column is the routing client.
You will select this routing client when configuring the Agent Targeting Rule in Configuration Manager.
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Step 2

In the Configuration Manager on either Unified CCE Data Server, browse to Tools > List Tools > Agent
Targeting Rule.

Step 3

Click Retrieve in the Select filter data pane.

Step 4

Click Add in the Agent Targeting Rule pane.

Step 5

On the Attributes tab:
a) Enter a name for the rule in the Name field.
b) Select CUCM_PG_1 from the Peripheral drop-down menu.
c) Select Agent Extension from the Rule type drop-down menu.

Step 6

In the Routing client pane:
a) Click Add.
b) Select the routing client you identified in step 1.
c) Click OK.

Step 7

Click Save.

Configure ECC Variables
ECC variables are used in scripts to facilitate and influence routing.
ECC variables are required for inbound email, outbound email, chat, callback, and delayed callback activities.
These ECC variables are created automatically:
• user.cim.activity.id—For inbound and outbound email activities:
• user.cim.activity.id and user.wim.customer.name—For chat activities: user.cim.activity.id,
user.wim.customer.name
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• user.cisco.cmb and user.cisco.cmb.callclass—For callback and delayed callback activities: user.cisco.cmb
and user.cisco.cmb.callclass

Important

Only one action is required of you. All of these ECC variables are disabled by default. You must open
and enable each of them. To do this:
1 Sign in to Unified CCE Administration.
2 Navigate to Manage > Expanded Call Variables.
3 Select each ECC variable to open its edit page.
4 Check Enabled.

Other Configuration
All configuration that is not directly relevant to Packaged CCE is documented in Cisco Email Interaction
Manager and the Cisco Web Interaction Manager documents.
This information includes:
• Starting services
• Configuring browser settings
• Installing the license
• Running the Cisco Interaction Manager Wizard
• Configuring Chat, Email, and Callback
• Configuring and starting EAAS and the Listener Process
Unified EIM and WIM documentation is available at http://www.cisco.com/c/en/us/support/
customer-collaboration/unified-email-interaction-manager/tsd-products-support-series-home.html. Refer
specifically to the following documents:
• Cisco Unified Web and E-Mail Interaction Manager Deployment and Maintenance Guide
• Cisco Unified Web and E-Mail Interaction Manager Installation Guide
• Cisco Unified Web and E-Mail Interaction Manager Browser Settings Guide

Cisco Interaction Manager Reporting
Sample custom report templates for Cisco Interaction Manager are available through the Cisco Developer
Network, at http://developer.cisco.com/web/ccr/documentation. Each report template includes online help
describing that template.
For directions on importing report templates into Cisco Unified Intelligence Center and configuring Cisco
Unified Intelligence Center data sources for Cisco Interaction Manager, see the Cisco Packaged Contact
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Center Enterprise Installation and Upgrade Guide at http://www.cisco.com/c/en/us/support/
customer-collaboration/packaged-contact-center-enterprise/products-maintenance-guides-list.html.
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• Reference a Media Server in CCE Scripts, page 87

About CVP Media Server
Many of the optional features in Packaged CCE require a Cisco Unified Customer Voice Portal (CVP) media
server to store and serve supporting .wav files. This chapter describes how to set up a CVP media server. It
also describes expanded call variable settings related to the media server and requirements for accessing a
media server in call routing scripts.
The features that require a CVP media server include Agent Greeting, Courtesy Callback, Post-Call Survey,
and Whisper Announcement.

Prepare a Media Server
A media server is installed by default on each of the four CVP servers in a Packaged CCE deployment.

Procedure
Step 1

Step 2
Step 3

Ensure that IIS is properly configured and running on the server. It must be listening on port 80. To validate
proper configuration of the media server, launch a browser from a remote machine that is able to ping the
CVP server and attempt to access and play one of the default media files installed during the CVP installation
such as http://<cvp_ip>/en-us/app/en_1.wav. If the file is accessible, the media server is installed correctly.
Note
Use Microsoft IIS with Unified CVP. This component is automatically installed as part of the CVP
server package installation.
Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.
Perform the following steps:
a) On the taskbar, click Start, point to Administrative Tools, and then click Server Manager.
b) In the Server Manager hierarchy pane, expand Roles, and then click Web Server (IIS).
c) In the Web Server (IIS) pane, scroll to the Role Services section, and then click Add Role Services.
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d) On the Select Role Services page of the Add Role Services wizard, expand FTP Server.
e) Select FTP Service
Note
To support ASP.NET membership or IIS Manager authentication for the FTP service, you need
to select FTP Extensibility.
f)
g)
h)
i)
j)
k)
l)
m)
n)

Click Next.
On the Confirm Installation Selections page, click Install.
On the Results page, click Close.
In the sites section, click Add FTP Site. Provide a site name and path to the same location as the http
directory c:\inetpub\wwwroot.
Select your desired binding method, and specify to start immediately.
On the FTP SSL Settings, select Allow SSL Connections.
On the Authentication and Authorization section select the type of authentication required. If using
basic, note the name and password of the account.
Select the authorization; for anonymous select Anonymous users.
Set the read and write permissions.
Note
Make note of your FTP connection information -- connection type, user name, password, and
port number.

Step 4

Make sure that the FTP and the IIS share the same root directory, because the recording application writes
the file to the media server directory structure, and the greeting playback call uses IIS to fetch the file. The
en-us/app directory should be under the same root directory for FTP and IIS.

Step 5

Create a dedicated directory on the server to store your greeting files. This lets you specify a lower cache
timeout of 5 minutes for your agent greeting files that does not affect other more static files you may be serving
from other directories. By default, the Record Greeting application posts the .wav file to the en-us/app
directory under your web/ftp root directory. You may create a dedicated directory such as ag_gr under the
en-us/app directory, and then indicate this in the Unified CCE script that invokes the recording application.
Use the array for the expanded call variable call.user.microapp.ToExtVXML to send the ftpPath parameter
to the recording application. Make sure the expanded call variable length is long enough, or it may get truncated
and fail.
To allow re-recorded greetings to replace their predecessor in a reasonable amount of time while minimizing
requests for data to the media server from the VXML Gateway, configure a cache expiration value in IIS
Manager. The ideal value varies depending on the number of agents you support and how often they re-record
their greetings. Two minutes may be a reasonable starting point.
To configure a cache expiration value in IIS Manager:

Step 6

a) Find the site you are using, go to the agent greeting folder you created (ag_gr), and then select HTTP
Response Headers.
b) Click Set Common Headers on Actions panel.
c) Select Expire Web Content and set the desired value.

What to Do Next
After specifying the cache timeout, it is a good idea to clear the cache on the VXML Gateway. This ensures
the gateway requests the latest files from the media server. You need only clear the gateway cache once. Reset
the gateway to clear the cache.
The HTTP client response timeout setting on the gateway must be greater than the time it takes to complete
the largest anticipated FTP file transfer. If an FTP file transfer takes longer than the configured duration in
seconds for HTTP client response timeout, the FTP transfer completes correctly, but the call drops as soon
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as the configured timeout duration is met. To change the HTTP client response timeout setting, open a command
prompt on the CVP VXML Gateway, log into IOS, and enter the following commands:
my_server# conf t
my_server(config)# http client response timeout <new value in seconds>
my_server(config)# exit
my_server(config)# wr

By default, the HTTP client response timeout value for CVP VXML Gateway is 30 seconds.

Reference a Media Server in CCE Scripts
Specify Media Server in Routing Scripts
When you configure media servers in CVP, you can specify a default media server. The benefit to specifying
a default media server is that your scripts do not need a Set Variable node to access the default media server.
For this to work, you must make sure that the files a script requests are stored on the default server.
If you do not define a default media server, or if you define a default but the files that your script requires are
not stored on the default, then the script must include a Set Variable node to identify a media server.
To specify a media server that stores the files required by your script, use the following settings in the Set
Variable node:
• Object Type: Call.
• Variable: Must use the user.microapp.media_server expanded call variable.
• Value: Specify the HTTP path to the server. For example: “http://myserver.mydomain.net.” You must
enclose the path in quotes.
• Alternately you can specify an IP address in place of a hostname.
See the following example.

Specify Greeting File Locale and Application Directories in Routing Scripts
CVP uses a default storage directory for media files: <web_server_root>/en-us/app. The physical
location of the default storage directory is c:\inetpub\wwwroot\en-us\app. To take advantage of
this, Packaged CCE call routing scripts automatically add en-us/app to the server name when constructing
HTTP requests for media files. For example:
• If the script node that defines the media server has a value of “http://myserver.mydomain.com,” and
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• The script node that defines which audio file to play has a value of “agent123_1.wav”, then
• The HTTP request for the file is automatically constructed as
http://myserver.mydomain.com/en-us/app/agent123_1.wav

If your greeting audio files are stored in a different locale directory, you must add a Set Variable node to your
script that identifies the locale directory. As you must store your greeting files in a dedicated subdirectory
under the locale, you must always add a Set Variable node that identifies that directory.
Use these settings in the Set Variable node to specify your locale directory:
• Object Type: Call.
• Variable: Must use the user.microapp.locale expanded call variable.
• Value: Specify the directory name. For example: “pt-br” (Portuguese-Brazil). You must enclose the path
in quotes.
Use these settings in the Set Variable node to specify your application directory:
• Object Type: Call.
• Variable: Must use the user.microapp.app_media_lib expanded call variable.
• Value: Specify the directory name. For example: to use a directory “greet” in place of the default directory
“app”, enter “greet”. To use a sub-directory “greet” under “app” enter “app/greet”. You must enclose the
path in quotes.

Verify Length for Media Server Locale and Application Directory Variables
If you include Set Variable nodes for the media server, locale, and/or application directories, make sure that
the values you set for them do not exceed the Maximum Length settings for their corresponding expanded
call variables.
For example, if you include a Set Variable node for the media server with a value of
“http://mysubdomain.mydomain.co.uk”, the string is 33 characters long. Therefore, the Maximum Length
setting for the user.microapp.media_server expanded call variable must be 33 or greater. Otherwise, the server
name is truncated in the HTTP request for the file and the file is not found.
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Mobile Agent
• Capabilities, page 89
• Initial setup, page 95
• Administration and usage, page 105

Capabilities
Cisco Unified Mobile Agent Description
Unified Mobile Agent supports call center agents using phones that Packaged CCE does not directly control.
You can deploy a Mobile Agent as follows:
• Outside the contact center, by using an analog phone or a mobile phone in the home.
• On an IP phone connection that is not CTI-controlled by Packaged CCE, by Unified CCE, or by an
associated Unified Communications Manager.
• On any voice endpoint of any ACD (including endpoints on other Unified Communication Managers)
that the contact center Unified Communication Manager can reach by a SIP trunk.
A Mobile Agent can use different phone numbers at different times; the agent enters the phone number at
login time. An agent can access the Mobile Agent functionality using any phone number that is included in
the Unified Communications Manager dial plan.

Unified Mobile Agent Provides Agent Sign-In Flexibility
Agents can be either local agents or Mobile Agents, depending on how they sign in at various times.
Regardless of whether agents sign in as local or Mobile Agents, their skill groups do not change. Because
agents are chosen by existing selection rules and not by how they are connected, the same routing applies
regardless of how the agents log in. If you want to control routing depending on whether agents are local or
mobile, assign the agents to different skill groups and design your scripts accordingly.
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Nailed Connections
In nailed connection delivery mode, the agent is called once, at login, and the phone line remains connected
through multiple customer calls. See the following figure.
Figure 8: Nailed Connection Call Flow

The nailed connection call flow works as follows:
1 At login, the agent enters the directory number of the local CTI port (LCP) in the Instrument Number field
and the remote phone number in CTI OS Desktop.
The remote phone number can be any phone number reachable by Unified CM.
When the agent clicks the Login button, a call is initiated to the agent's remote CTI port (RCP) and the
agent's remote phone rings.
2 When the agent answers the call, the call is then nailed up. This means that the agent will remain on this
call until the agent logs out or hangs up.
3 A customer's call arrives in the system and, through normal Packaged CCE configuration and scripting,
is queued for a skill group/precision queue. (This is no different than existing processing for local agents.)
4 When the agent clicks the Answer button, the voice path between the agent and the customer phone is
established, and the two parties can talk.
5 When the system assigns an agent to the call, the call is routed to the agent's LCP port. The agent then
hears the connect tone on the headset.
6 When the call ends, the customer connection is terminated and the agent state returns to Ready.

Connect Tone
The Connect Tone feature in the nailed connection mode enables the system to play a tone to the Mobile Agent
through the agent's headset to let the agent know when a new call is connected.
Connect Tone is particularly useful when Auto Answer is enabled or the agent is an Outbound agent. Here
are its features:
• An audible tone (two beeps) is sent to the Mobile Agent headset when the call to the nailed connection
Mobile Agent is connected. It is a DTMF tone played by Unified CM and cannot be modified.
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• The Connect Tone plays only when the nailed connection Mobile Agent receives a call, as in the following
examples:
◦The agent receives a consultation call.
◦The agent receives an outbound call.
• The Connect Tone does not play when the Mobile Agent initiates a call, as in the following examples:
◦The agent makes a call.
◦The agent makes the consultation call.
◦Outbound direct preview call is made.
◦Supervisor barge-in call is made.

Related Topics
Enable Mobile Agent Connect Tone, on page 105

Agent Greeting and Whisper Announcement
The Agent Greeting and Whisper Announcement features are available to Unified Mobile Agents. The following
sections explain more about how these features apply to Unified Mobile Agents.

Agent Greeting
You can use the Agent Greeting feature to record a message that plays automatically to callers when they
connect to you. Your greeting message can welcome the caller, identify you, and include other useful
information.
Limitations
The following limitations apply to the Agent Greeting feature for Mobile Agents.
• A supervisor cannot barge in when an Agent Greeting is playing.
• If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting
plays for a Mobile Agent, the call fails.
• If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent
Greeting before the call ends.

Note

In the Agent Greeting Call Type Report, this call does not appear as a failed agent
greeting call.

For more information about Agent Greeting, see Capabilities, on page 11.
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Whisper Announcement
With Whisper Announcement, agents can hear a brief prerecorded message just before they connect with each
caller. The announcement plays only to the agent; the caller hears ringing (based on existing ringtone patterns)
while the announcement plays. The announcement can contain information about the caller, such as language
preference or customer status. This information helps the agent prepare for the call.
Configuration Requirement
For the Whisper Announcement feature for Unified Mobile Agents, you require a Media Termination Point
(MTP) resource on an incoming SIP device. .
For more information about Whisper Announcement, see Whisper Announcement Capabilities, on page 183.

Feature Requirements
Phone Requirements
A Unified Mobile Agent can use an analog, digital, or IP phone to handle calls.

Note

When Unified Mobile Agent phones are located on a cluster and a SIP Trunk is used to connect the cluster
to another cluster under Packaged CCE control, you must either use SIP phones as Mobile Agent phones
or select mtp required on the Packaged CCE cluster to allow Mobile Agent calls to work.

Conference Requirements
To use Agent Greeting for Mobile Agents, you must configure external conference-bridge (hardware) resources.
To estimate the number of required resources, you can use the following formula:
Number of conference bridge resources = Mobile Agent call rate × Average greeting time (in seconds)
For information about configuring external conference-bridge resources, see the dspfarm profile 1
for conference configuration section in the sample configuration gateway, listed in Media Termination
Points Configuration, on page 100.
For information about using Agent Greeting from CTI OS Agent Desktop, see the note in Verify Login, on
page 107.

CTI Port Requirements
You need two CTI ports (local and remote) for every logged-in Mobile Agent.
Unified Mobile Agent uses Unified CM CTI Port as a proxy for the agent's phone. When this proxy is set up,
whenever a Mobile Agent is selected to handle a customer call, the following happens:
• The call is directed to the CTI port extension.
• Packaged CCE intercepts the call arriving on the CTI Port and directs Unified CM to connect the call
to the Mobile Agent.
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For Unified Mobile Agent to work properly, you must configure two CTI ports:
• One port to serve as the agent's virtual extension.
• The other port to initiate calls to the agent.
You must assign these CTI ports to thePackaged CCE application. The ports are recognized by Packaged
CCE when receiving the Unified CM configuration.
For these CTI ports in IPv6 enabled deployments, you have to set IP Addressing Mode to IPv4 Only. You
do this by creating a Common Device Configuration and referencing it to these CTI ports.

Important Considerations
Before you proceed, consider the following Unified Mobile Agent limitations and considerations:

Failover
• During a prolonged Peripheral Gateway (PG) failover, if an agent takes call control action for a Unified
Mobile Agent-to-Unified Mobile Agent call, the call can drop. This occurs because the activating PG
might not have information for all agents and calls at that point.
• Unified CM failover causes a Mobile Agent call to be lost because call preservation on H.323 devices
is not supported.

Performance
• For the total number of supported Unified Mobile Agents and more information about Unified Mobile
Agent capability, see Cisco Packaged Contact Center Enterprise Design Guide at http://www.cisco.com/
c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
products-technical-reference-list.html.
• Because Unified Mobile Agent adds processing steps to Unified CCE default functionality, Mobile
Agents might experience some delay in screen popup windows.

Codec
The codec settings on the Peripheral Gateway and Voice Gateway must match. Perform the following procedure:
1 Launch the Peripheral Gateway Setup.
2 In the Peripheral Gateway Component Properties, select the UCM PIM and click Edit.
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3 In the CallManager Parameters section, select the appropriate codec from the Mobile Agent Codec drop
down list.
Figure 9: Mobile Agent Codec Selection

Silent Monitoring
Unified Mobile Agent provides the following silent monitoring support:
• Mobile Agent supports CTI OS server-based silent monitoring only. Unified CM-based silent monitoring
is not supported.
• Unified Mobile Agent requires that caller and agent voice gateways be on separate devices if silent
monitoring is to be used.
• Unified Mobile Agent does not support desktop monitoring.
• Whenever silent monitoring is used on Unified Mobile Agent, caller and agent voice gateways must be
on separate devices. Similarly, if MTP is enabled when silent monitoring is used, MTP resources for
caller and agent must also be on separate devices.

Unsupported Features
The following is a list of unsupported features for Mobile Agent:
• Web Callback
• Unified CM-based Silent Monitoring
• Agent Request
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Unified Mobile Agent Reporting
Unified Mobile Agent-specific call data is contained in the following Cisco Unified Intelligence Center reports:
Agent Team Historical, Agent Real Time, and Agent Skill Group Historical. These “All Field” reports contain
information in multiple fields that show what kind of call the agent is on (nonmobile, call by call, nailed
connection) and the Unified Mobile Agent phone number.

Note

The service level for Unified Mobile Agent calls might be different than the service level for local agent
calls, because it takes longer to connect the call to the agent.
For example, a call by call Mobile Agent might have a longer Answer Wait Time Average than a local
agent. This is because Packaged CCE does not start to dial the Mobile Agent phone number until after
the call information is routed to the agent desktop. In addition, the customer call media stream is not
connected to the agent until after the agent answers the phone.

Initial setup
Summary of Unified Mobile Agent System Configuration Tasks
The following table describes system configuration tasks for Unified Mobile Agent.
Table 4: Unified Mobile Agent System Configuration Tasks

Task

See

Configure Unified CM CTI Port
pools

Unified CM CTI Port Configuration and Mapping for Unified Mobile
Agent, on page 95

Configure Unified CM Call Duration Maximum Call Duration Timer configuration, on page 98
Timer
Configure Agent Desk Settings

Agent Desk Setting Configuration for Unified Mobile Agent, on page
99

Configure CTI OS

Cisco CTI OS Configuration for Unified Mobile Agent, on page 99

Configure Media Termination Points Media Termination Points Configuration, on page 100

Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent
Unified Mobile Agent must have two CTI ports configured on Unified CM:
• A local CTI port, which Unified Mobile Agent uses as the agent's virtual extension.
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• A remote CTI port, which Unified Mobile Agent uses to initiate a call to the Mobile Agent's phone.
Naming Conventions for Local and Network Ports
• The local port must begin with the string LCP.
• The remote port must begin with the string RCP.
• The remaining characters in the device names for the LCP and RCP pair must match. For example an
LCP port named LCP0000 has a corresponding RCP port named RCP0000.

Music on Hold Design
If you want callers to hear music when a Mobile Agent places the caller on hold, you must assign Music on
Hold (MoH) resources to the ingress voice gateway or trunk that is connected to the caller (as you do with
traditional agents). In this case, the user or network audio source is specified on the local CTI port configuration.
Similarly, if a Mobile Agent must hear music when the system puts the agent on hold, you must assign MoH
resources to the ingress voice gateway or trunk that is connected to the Mobile Agent. In this case, the user or
network audio source is specified on the remote CTI port configuration.
Do not assign MoH resources to local ports and remote CTI ports, because it might affect the system
performance.
If a remote Mobile Agent calls over a nailed connection and if there is no active call to the agent, the agent
is put on hold. Enable MoH to the Mobile Agent phone for nailed connection calls. If MoH resources are an
issue, consider multicast MoH services.
If a remote Mobile Agent calls over a nailed connection, and if MoH is disabled, the hold tone plays to the
agent phone during the hold time. Because the hold tone is similar to the connect tone, it is difficult for the
agent to identify if a call arrived from listening to the Mobile Agent connect tone. The hold tone prevents the
agent from hearing the connect tone. You must disable the hold tone.
Perform the following steps to disable the hold tone:
1 Log in to Unified CM Administration and navigate to System > Service Parameters.
2 Scroll down to the Tone on Hold Time field and set the value to 0.
3 Click Save.

Note

Because Tone on Hold Time is a cluster-wide setting, it will be applied to all nodes, not just the currently
selected node.

Configure Unified CM CTI Ports for Unified Mobile Agent
Perform the following steps to configure CTI Ports.
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Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

In Unified CM Administration, select Device > Phone.
Click Add a New Phone.
From Phone Type, select CTI Port.
Click Next.
In Device Name, enter a unique name for the local CTI Port name; click OK when finished.
Using the naming convention format LCPyyyy:
• LCP identifies the CTI Port as a local device.
• yyyy is the local CTI Port.
The name LCP0000 represents the local port.

Step 6
Step 7
Step 8
Step 9
Step 10
Step 11
Step 12
Step 13

In Description, enter text that identifies the local CTI port.
Use the Device Pool drop-down list to choose where you want to assign the network CTI port. Do not select
Default. ( The device pool defines sets of common characteristics for devices.)
For Device Security Profile, select Cisco CTI Port - Standard SCCP Non-Secure Profile.
Click Save.
Click Apply config.
In the Association section, select Add a New DN.
Add a unique directory number for the CTI port you just created.
In Maximum Number of Calls, enter 2.

Step 14 In Busy Trigger, enter 1.
Step 15 When finished, click Save, and click Apply config.
Step 16 Repeat the preceding steps to configure the network CTI port.
In Device Name, using the naming convention format RCPyyyy, where:
• RCP identifies the CTI port as the Remote CTI port where the call between the agent's remote device
and the Unified CM Port is nailed up at agent login time.
• yyyy is the network CTI port.
The name RCP0000 represents the local port.
Note

The port number for both LCP and RCP must be the same even though the directory numbers are
different.

Step 17 In Description, enter text that identifies the network CTI port.
Step 18 Use the Device Pool drop-down list to choose where you want to assign the network CTI port. Do not select
Default.. (The device pool defines sets of common characteristics for devices.)
Step 19 Click Save.
Step 20 In the Association Information section, select Add a New DN.
Step 21 Add a unique directory number for the CTI port you just created.
The extension length can be different from the extension length of the LCP Port if your dial plan requires it.
Step 22 When finished, click Save, and click Close.
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Map Local and Remote CTI Ports with Peripheral Gateway User
After you define the CTI Port pool, you must associate the CTI Ports with PG users.

Procedure
Step 1
Step 2
Step 3

In Unified CM Administration, select Application User.
Select a username and associate ports with it.
When finished, click Save.
Note
If CTI ports for Unified Mobile Agent are disassociated at the Unified CM while a Mobile Agent is
on an active call, the call can drop.

Maximum Call Duration Timer configuration
By default, Mobile Agents in nailed connection mode log out after 12 hours. This happens because a Unified
CM Service Parameter—the Maximum Call Duration Timer—determines the amount of time an agent phone
can remain in the Connected state after login.
If you anticipate that Unified Mobile Agent will be logged in longer than 12 hours, use the following
instructions to either one of the following:
• Increase the Maximum Call Duration Timer setting.
• Disable the timer entirely.
If your Mobile Agent deployment uses intercluster trunks between your CTI ports and your mobile agent's
phone, you must set these service parameters on both the local and remote Unified CM clusters.

Procedure
Step 1
Step 2
Step 3

In Unified CM Administration, choose System > Service Parameters.
In the Server drop-down list, choose a server.
In the Service drop-down list, choose Cisco CallManager Service.
The Service Parameters Configuration page appears.

Step 4
Step 5

In the Cluster-wide Parameters (Feature - General) section, specify a Maximum Call Duration Timer setting.
Click Save.
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Agent Desk Setting Configuration for Unified Mobile Agent
Configure Desk Settings with Unified CCE Administration
This section describes Desk Settings configuration settings you should specify in Unified CCE Administration
to accommodate Unified Mobile Agent features.
The following instructions describe how to configure one Desk Setting. Repeat this process for each different
Desk Setting in your deployment.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

From the Unified CCE Administration, choose Manage > Desk Settings.
Click New to create a new Desk Setting or click the name of an existing Desk Setting to edit it.
Complete the required fields.
Check the Enable Mobile Agent check box. This enables the Mobile Agent feature so that the agent can log
in remotely and take calls from any phone.
Click Save.

Associate Desk Setting with a Mobile Agent
After you have configured agent desk settings, you need to associate the desk setting with a mobile agent.

Procedure
Step 1
Step 2

Access Unified CCE Administration.
Select Manage > Agents.
The List of Agents window appears.

Step 3

Select the agent that you want to associate.
The Edit <agent> window appears.

Step 4
Step 5

In the Desk Settings box, select the desk setting that has the Mobile Agent enabled.
Click Save.

Cisco CTI OS Configuration for Unified Mobile Agent
This section describes information about CTI OS configuration settings that you need to know after initial
installation of a Mobile Agent-enabled CTI OS Server.
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CTI OS Installation and Unified Mobile Agent
To configure Mobile Agent, run the CTI OS server setup by double-clicking
<drive-letter>:\icm\CTI_OS\bin\setup.exe from Unified CCE call server.
During the peripheral identification step of CTI OS Server installation, follow these steps:
1 Click Yes to stop the service and to acknowledge the license agreement.
2 Select CTIOS server from CTI OS Instance and click Edit.
3 Click Next to navigate to Peripheral Identifier.
4 Check the Enable Mobile Agent checkbox.
5 Select Nailed connection for Mobile agent mode. (It is the only call delivery mode supported.)
6 Click Save.

Call Delivery Mode and Agent Profiles
• The nailed connection call delivery mode selected during CTI OS Server installation enables CTI OS
to send an agent profile to each desktop client for that mode.
• The nailed connection call delivery mode the agent uses at login must match the nailed connection mode
that is configured for the agent in the Agent Desk Setting.
• You can add profiles manually using the CTI OS registry. For more information, refer to the CTI OS
Developer Guide for Cisco Unified ICM/Contact Center Enterprise at http://www.cisco.com/en/US/
products/sw/custcosw/ps14/tsd_products_support_series_home.html.

Media Termination Points Configuration
If you use SIP trunks, you must configure Media Termination Points (MTPs). You must also configure MTPs
if you use TDM trunks to create an interface with service providers.
Additionally, MTPs are required for Mobile Agent call flows that involve a Cisco Unified Customer Voice
Portal (CVP) solution. Because in DTMF signaling mode the Mobile Agent uses out-of-band signaling,
whereas Unified CVP supports in-band signaling, the conversion from out-of-band to in-band signaling
requires an MTP resource.
MTPs may be allocated as required in deployments that use a mix of IPv4 and IPv6 connections. MTP resources
are allocated provided that the Media Resource Group List is configured on the IPV4 endpoint.
MTPs are available in the following forms, but not all are supported in Mobile Agent environments:
• Software-based MTPs in Cisco IOS gateways—use these MTPs for Mobile Agent as they provide codec
flexibility and better scalability compared with other MTP options. The following is a sample
configuration on a gateway.
sccp local GigabitEthernet0/0
sccp ccm 10.10.10.31 identifier 1 priority 1 version 7.0
sccp ccm 10.10.10.131 identifier 2 priority 2 version 7.0
sccp
!
sccp ccm group 1
associate ccm 1 priority 1
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associate ccm 2 priority 2
associate profile 3 register gw84xcode
associate profile 1 register gw84conf
associate profile 2 register gw84mtp
!
dspfarm profile 3 transcode
codec g729abr8
codec g729ar8
codec g711alaw
codec g711ulaw
codec g729r8
codec g729br8
maximum sessions 52
associate application SCCP
!
dspfarm profile 1 conference
codec g729br8
codec g729r8
codec g729abr8
codec g729ar8
codec g711alaw
codec g711ulaw
maximum sessions 24
associate application SCCP
!
dspfarm profile 2 mtp
codec g711ulaw
maximum sessions software 500
associate application SCCP

• Hardware-based MTPs in Cisco IOS gateways—These MTPs are supported. However, Cisco does not
recommend them because of the extra cost, codec restrictions, and scalability constraints.
• Software-based MTPs using the Cisco IP Voice Media Streaming Application—These MTPs are not
supported with Mobile Agents.

Note

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to
avoid using them. Create a new Media Resource Group (MRG) as a place holder, and place the software
MTPs in that MRG. For instructions, refer to the Unified CM help documentation.
The following table lists the steps in configuring MTPs in Unified CM. Make sure you have completed the
tasks in the checklist.
Table 5: Checklist for Unified CM SIP Trunk Configuration

Check when
done

Task
Add MTP resources to Unified CM, on page 102
Configure MTP resources in Unified CM , on page 102
Associate a Media Resource Group List with Device Pools, on page 103
Quarantine Unified CM software-based resources, on page 103
Configure MTPs with SIP Trunks, on page 103
Enable Call Progress Tones for Agent-Initiated Calls, on page 104
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Check when
done

Task
Verify MTP Resource Utilization, on page 104

Add MTP resources to Unified CM
Perform these steps to add MTPs to Unified CM.

Procedure
Step 1
Step 2

In Unified CM Administration click Media Resources > Media Termination Point.
Click Add New.

Step 3

Choose Cisco IOS Enhanced Software Media Termination Point from the Media Termination Point Type
drop-down list.
Enter an MTP name. This name must match the device name you chose in IOS. In the example in the previous
section, the MTP was called gw84mtp, as from the configuration line: associate profile 2 gw84mtp.

Step 4
Step 5
Step 6

Choose the appropriate device pool.
Click Save and then click Apply config.

Step 7

Navigate back to Media Termination Point and ensure that the newly added MTP is listed as being registered
with <Unified CM subscriber IP address> in the Status column.
Repeat Steps 1 through 7 for each Cisco Call Manager server group you configured on each of your gateways.

Step 8

Configure MTP resources in Unified CM
The following section explains how to create media resource groups and media resource group lists.

Procedure
Step 1
Step 2

Navigate to Media Resources > Media Resource Group in Unified CM Administration.
Click Add New.

Step 3
Step 4

Specify a name and description.
From the Available Media Resources that you just created, move the devices from the Available to the Selected
list by clicking the down arrow. Ensure that you do not include Unified CM Software resources. For example,
type anything that starts with ANN_, MTP_, or MOH_.
Navigate to Media Resources > Media Resource Group List.
Click Add New.

Step 5
Step 6
Step 7
Step 8

Move the Media Resource Group you just created from the Available Media Resource Groups to the Selected
Media Resource Groups.
Click Save.
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Associate a Media Resource Group List with Device Pools
The following procedure shows how to associate a media resource group list (MRGL) with device pools.

Procedure
Step 1
Step 2

Navigate to System > Device Pool and click on the device pool that contains the CTI ports for Mobile Agent.
If there are multiple pools, perform the next step for each device pool that applies.
In the Media Resource Group List drop-down list, select the Media Resource Group List that you just created,
click Save, and then click Apply config.

Quarantine Unified CM software-based resources
Unified CM-based software MTP's are used by default. However, these resources may sometimes be used to
provide MTPs for Unified Mobile Agent calls without proper configuration, causing performance problems.
For this reason, Cisco does not support the use of Unified CM-based software MTP's. You must add a special
configuration so that they are not used, which quarantines them. Perform the following steps:

Procedure
Step 1
Step 2

Create a new Media Resource Group (MRG) as a place holder.
Place the software MTPs in that MRG.
For further instructions, refer to the Unified CM help documentation.

Configure MTPs with SIP Trunks
If you use SIP trunks, you must configure MTPs. Mobile Agent cannot use an MTP with codec pass-through.
When you configure the MTP, you must select No pass through. KPML is not supported with Mobile Agent.

Procedure
Step 1
Step 2

Log in to Unified CM Administration and select Device > Trunk.
Select the trunk on which you want to configure MTPs.
At a minimum all trunks whose destination is unified CVP need to have this configuration. This requirement
also applies to all TDM trunks that are used to connect to Mobile Agent phones through service providers.

Step 3

Depending on the scenario listed below, perform the corresponding step. Note that if you configure trunk
groups to dynamically insert MTPs, only the calls that require MTPs use them.
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• Insert MTPs for inbound and outbound calls through a given trunk: In the Trunk Configuration settings,
check the Media Termination Point Required check box.
• Dynamically allocate MTPs when Cisco Unified Intelligent Contact Management detects media or
signaling incompatibility between the caller and called endpoints: In the Trunk Group Configuration
settings, for the DTMF Signaling Method, select RFC2833.

Enable Call Progress Tones for Agent-Initiated Calls
For an agent to hear call progress tones for agent-initiated calls, additional configuration is required if MTP
Required is not enabled. If instead you have dynamic MTP allocation by forcing mismatched DTMF settings,
then you should configure the Unified CM to enable Early Offer.
For information on configuring the Unified CM, see the Unified CM product documentation at http://
www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html. Ringback and
other call progress tones are not generated by the Cisco Annunciator, as is the case for regular phones and
softphones. Instead, Mobile Agent relies on these tones being generated by the called party (and the Early
Offer setting triggers these tones to be sent to the agent).

Note

This selection does not affect MTP sizing for IP phones and other endpoints that support RFC 2833
signaling, as is the case for many Cisco phones (including the 6900 series and the 794x and 796x phones).

Verify MTP Resource Utilization
Because Unified CM comes preconfigured with software MTP resources, these resources may sometimes be
used to provide MTP for Unified Mobile Agent calls without proper configuration. Cisco does not support
the use of Unified CM-based software MTPs. You can quarantine the Unified CM-based MTPs. (See Quarantine
Unified CM software-based resources, on page 103.) To ensure that the IOS-based MTPs are being used for
Unified Mobile Agents, perform the following verification steps:

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Install the Unified CM Realtime monitoring tool. This tool can be downloaded under Application > Plugins
within Unified CM Administration.
Place a call to a logged-in Mobile Agent.
Open the Unified CM Realtime monitoring tool and navigate to System > Performance > Open Performance
Monitoring.
Expand the nodes that are associated with your IOS-based MTP resources and choose Cisco MTP Device.
Double-click Resources Active and choose all of the available resources to monitor. This includes both IOS
and Unified CM-based resources. Ensure that only the IOS-based resources are active during the Mobile
Agent phone call. Also, ensure that all Unified UC-based MTP resources are not active.
Repeat the previous step for each node that has MTP resources associated with it.
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Enabled Connect Tone Feature
In a nailed connection, the system can play a tone to the Unified Mobile Agent through the agent headset to
let the agent know when a new call is connected. In the default Installation, the Mobile Agent Connect Tone
feature is disabled.

Enable Mobile Agent Connect Tone
If you require Unified Mobile Agent Connect Tone, you must make the following change in the Windows
Registry for the key PlayMAConnectTone under the JTAPI GW PG registry entries.
Perform the following procedure to allow a Mobile Agent in the nailed connection mode to hear a tone when
a new call is connected.

Procedure
Step 1
Step 2

On the PG machine, open the Registry Editor (regedit.exe).
Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\,<InstanceName>\PG1A\PG\CurrentVersion\JGWS\jgw1\JGWData\Config\PlayMAConnectTone
.
The Edit DWORD Value dialog box appears.

Step 3
Step 4

In the Value data: field, enter 1 to enable Mobile Agent Connect Tone and click OK.
Exit the Registry Editor to save the change, and cycle the PG service.

Administration and usage
CTI OS Agent Desktop
Unified Mobile Agent is available with the Cisco CTI OS Agent Desktop.
CTI OS Agent Desktop provides an interface that:
• Enables you to perform telephony call control, such as call answer, hold, conference, and transfer, and
agent state control, such as ready/not ready and wrap-up
• Presents customer call data in the form of a popup window
• Provides you with agent statistics and chat capability

Note

CTI OS supports chat only between agents on the same peripheral.
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Note

For more information about using CTI OS Agent Desktop to handle calls, see the CTI OS Agent Desktop
User Guide for Cisco Unified ICM/Contact Center Enterprise at http://www.cisco.com/en/US/products/
sw/custcosw/ps14/tsd_products_support_series_home.html.

Log in to CTI OS Agent Desktop
Perform the following steps to log in to the CTI OS Agent Desktop.

Procedure
Step 1

From the desktop, click Login.
The CTI Login dialog box appears.
Figure 10: CTI Login

Step 2

In the CTI Login dialog box, enter the following information in the corresponding fields:
Option

Description

Connect to

Use the drop-down menu to select the connection mode you want to use.

Agent ID or Agent Login Your supervisor assigns your Agent ID.
Name
Note
You are prompted to enter either your Agent ID or Agent Login Name.

Password

Login options are determined during the installation of the CTI OS
Server.
Your supervisor assigns your this password.

Instrument

The directory number for the local CTI port.
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Option

Description

Mobile Agent

You must select this check box to log in as a Mobile Agent.

Phone Number

The dial number for the phone the agent intends to use.
The format for the phone number must follow the dial plan, for example,
91201-123-xxxx.
Select nailed connection.
Note

Call Mode

Step 3

Click OK.
The desktop automatically enters the state that is configured on the switch (either Ready or Not Ready) and
the buttons for actions for that state are enabled.
Note

For a nailed connection, the desktop must receive and answer a setup call before agent login is
complete.

Verify Login
Perform the following procedure to verify your login.

Procedure
Step 1
Step 2

Check to be sure that your desktop is in the Ready or Not Ready state.
Check to be sure the status bar of your Unified Mobile Agent Desktop displays the following:
• Agent ID for the logged-in agent
• Agent Extension
• Agent Instrument
• Current Agent Status
• The server that the desktop is connected to

Step 3

Check to be sure the action buttons that are allowed for your current agent state are enabled.
Note
If you log in as a Mobile Agent and want to make a phone call from CTI OS Agent Desktop, you
must use the CTI Dialing Pad on the desktop.

Enable Ringtone
By default, a CTI OS Agent Desktop in nailed connection delivery mode does not ring when a call arrives.
Instead, an alert message appears on the desktop to indicate the arrival of a call.
Perform the following procedure to enable a ringtone on the CTI OS Agent Desktop:
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Procedure
Step 1

Click Dial.
The CTI Dialing Pad dialog box appears.

Step 2

Click More.
The Options dialog box appears.

Step 3

Click the Mute Tones tab and uncheck the Ring Back check box.
This action disables the Mute setting of the ringback tone.

Step 4

Click Close.

This setting remains in effect until you change it or log out. You need to repeat these steps each time you log
in.

Cisco Finesse
Finesse provides a browser-based desktop for agents and supervisors. Mobile agents can perform the same
call control functions as Packaged CCE agents. Mobile supervisors can perform all call control functions
except for silent monitoring.

Sign In to Cisco Finesse Desktop
Procedure
Step 1

Enter the following URL in your browser: https://FQDN of Finesse server, where FQDN is the fully-qualified
domain name of the Finesse server.
In an IPv6-enabled environment, you must include the port number in the URL (https://<FQDN of Finesse
server>:8445/desktop.

Step 2

In the ID field, enter your agent ID.
In the Password field, enter your password.
In the Extension field, enter your extension.
For a mobile agent, the extension represents the virtual extension for the agent, also known as the local CTI
port (LCP).

Step 3
Step 4

Step 5

Check the Sign in as a Mobile Agent check box.
The Mode and Dial Number fields appear.

Step 6

From the Mode drop-down list, choose Nailed Connection.
In Nailed Connection mode, your phone is called when you sign in and the line stays connected through
multiple customer calls.

Step 7

In the Dial Number field, enter the number for the phone you are using.
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Step 8

Option

Description

ID

The agent ID.

Password

Your supervisor assigns your this password.

Extension

The agent's extension.

Sign in as Unified Mobile Agent

Select to sign in as a Unified Mobile Agent.

Mode

Nailed Connection is the only available selection.

Dial Number

The number of the phone being used.

Click Sign In.
Note
In Nailed Connection mode, the desktop must receive and answer a setup call before sign-in is
complete.

Verify Sign-In to Cisco Finesse
Procedure
Check to be sure the Finesse Agent Desktop displays the following in the header:
• Mobile Agent before your agent name
• The mode used (Nailed Connection)
• The dial number you provided
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Enable Ready State
You must be in Ready state to process incoming calls. Choose Ready from the drop-down list below the agent
name.

Note

Because you are automatically in Nailed Connection mode, after you answer the initial setup call, you
must perform all other call control functions using the desktop.

Make a Call
Procedure
Step 1

Step 2
Step 3

From the drop-down list below the agent name, choose Not Ready.
Note
You must be in Not Ready state to make a
call.
Click Make a New Call.
Enter the number you want to call on the keypad, and then click Call.
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Outbound Option
• Capabilities, page 111
• Initial Setup and Maintenance, page 115
• Administration and usage, page 135

Capabilities
Features
Outbound Option enables call centers to manage outbound calls. With Outbound Option, you can configure
a contact center to automatically dial customer contacts from imported lists and direct a call to an available
agent. This application transfers a call to an agent only if a live contact is reached.
A summary of major features in Outbound Option follows:
Automated dialing
The dialer automatically dials contact numbers, screens for busy signals, no answers, and answering
machines, and transfers calls to agents. The dialer transfers a call to an available agent only when it
reaches a live contact.
Campaigns
Users create calling campaigns using a set of tabs in a graphical user interface (GUI). A campaign is a
filtered set of numbers that will be automatically dialed and a set of agents who will talk to contacted
customers.
More specifically, a campaign consists of imported contact lists, query rules that filter the contact list
to create a dialing list, and agent skill groups.
Imported contact lists and Do Not Call lists
You can import lists of customers you want to call and lists of customers who you do not want to call.
You can configure Outbound Option to import both types of lists either by continuously polling or at
scheduled intervals. You can also specify whether imported lists will replace existing lists or be appended
to them.
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Query rules
Query rules define a set of criteria to filter contact lists. In this way, you can define specific dialing
lists for campaigns. A campaign can have multiple query rules, but only one query rule and resulting
dialing list is active at a time.
Agent skill groups
You assign agents to campaigns by using skill groups. A skill group defines a set of agents with specific
capabilities, such as language skills, product knowledge, or training that is associated with a campaign.
Agents might belong to multiple skill groups and thus be part of multiple campaigns.
Campaign management
Outbound Option uses a dialing list that is associated with the active query rule in a campaign and
directs dialers to place calls to customers. The dialer then directs contacted customers to agents. Advanced
campaign-management features provide flexibility in campaign configurations. You can do the following:
• Assign customer records to multiple lists.
• Merge lists into a single campaign.
• Configure rules that define when the various lists are called. Only one rule is active at a time but
you can set up multiple rules and switch among them.
• Assign agents to campaigns using skill groups.
Dedicated or Blended modes
You can specify either of the following modes for agents:
• Dedicated mode is designed for agents who make only outbound calls.
• Blended mode allows agents to receive inbound calls and make outbound calls without switching
between skill groups. In this mode, inbound calls receive precedence.
Choice of dialing modes
Outbound Option supports the following dialing modes:
• Preview mode lets the agent preview the contact information on the desktop and decide whether
the SIP dialer should dial a contact.
• Direct Preview mode is similar to Preview mode; however, the dialer places the calls from the
agent's phone. This mode prevents abandoned calls and false positive detection of answering
machines.
• Progressive mode dials a configured number of calls per available agent.
• Predictive mode adjusts the number of calls dialed per agent based on the current abandon rate.
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Callbacks
If a customer requests a callback for a later date and time, the agent can enter the request in the system,
and the dialer schedules the call appropriately. The following callback types are supported:
• Personal callbacks specify that the customer receive a callback from the same agent who made
the initial contact.
• Regular callbacks are handled by any available agent.
Call analysis
The Call Progress Analysis (CPA) feature uses a combination of call signaling and media stream analysis
to identify different types of calls, such as faxes and modems, answering machines, and operator
intercepts.
Sequential dialing
The sequential dialing feature allows up to ten phone numbers per customer record.
Abandoned and retry calls
You can configure campaigns to retry abandoned calls.
Campaign prefix digits for dialed numbers
You can configure a prefix for customer number, which can be used to identify specific campaigns.
Activity reports
Outbound Option reporting features include agent, campaign, dialer, and skill groups report templates.

Dialing Modes
Outbound Option supports various dialing modes, described in the following sections.

Note

All dialing modes reserve an agent at the beginning of every outbound call cycle by sending a reservation
call to the agent.

Predictive Dialing
In predictive dialing, the dialer determines the number of customers to dial per agent based on the number of
lines available per agent and the configured maximum abandon rate. The agent must take the call if that agent
is logged in to a campaign skill group.
A Predictive Dialer is designed to increase the resource utilization in a call center. It is designed to dial several
customers per agent. After reaching a live contact, the Predictive Dialer transfers the customer to a live agent
along with a screen pop to the agent’s desktop. The Predictive Dialer determines the number of lines to dial
per available agent based on the target abandoned percentage.
Outbound Option predictive dialing works by keeping outbound dialing at a level where the abandon rate is
below the maximum allowed abandon rate. Each campaign is configured with a maximum allowed abandon
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rate. In Predictive mode, the dialer continuously increments the number of lines it dials per agent until the
abandon rate approaches the configured maximum abandon rate. The dialer lowers the lines per agent until
the abandon rate goes below the configured maximum. In this way, the dialer stays just below the configured
maximum abandon rate. Under ideal circumstances, the dialer internally targets an abandon rate of 85% of
the configured maximum abandon rate. Due to the random nature of outbound dialing, the actual attainable
abandon rate at any point in time may vary for your dialer.

Preview Dialing
Preview dialing reserves an agent before initiating an outbound call and presents the agent with a popup
window. The agent can then Accept, Skip, or Reject the call with the following results:
• Accept: The customer is dialed and transferred to the agent.
• Skip: The agent is presented with another customer call.
• Skips-Close: The customer will not be called again, and the agent is presented with another customer
call.
• Reject: The agent is released. The system then delivers another call to the agent, either another Preview
outbound call, or a new inbound call.
• Rejects-Close: The agent is released and the record is closed so it is not called again. The system then
delivers another call to the agent, either another Preview outbound call or a new inbound call.

Direct Preview Dialing
The Direct Preview mode is similar to the Preview mode, except that the dialer automatically places the call
from the agent's phone after the agent accepts. Because the call is initiated from the agent's phone, the agent
hears the ringing, and there is no delay when the customer answers. However, in this mode, the agent must
deal with answering machines and other results that the Dialer Call Progress Analysis (CPA) handles for other
campaign dialing modes.

Note

• The CPA feature is not available while using Direct Preview Dialing mode.
• A zip tone is a tone that announces incoming calls. There is no zip tone in Direct Preview mode.

Progressive Dialing
Progressive Dialing is similar to predictive dialing (see Predictive Dialing, on page 113). The only difference
is that in Progressive Dialing mode, Outbound Option does not calculate the number of lines to dial per agent,
but allows users to configure a fixed number of lines that will always be dialed per available agent.
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Initial Setup and Maintenance
This section is intended for system administrators who install and configure Packaged CCE. It describes the
one-time tasks required to set up Outbound Option. It also discusses occasional upgrade and maintenance
tasks. It contains the following topics:
• Outbound SIP Dialer Call Flows, on page 115
• Initial Setup Task Lists, on page 118
• Unified CCE configuration for Outbound Option, on page 118
• Unified Communications Manager and Gateway Configuration, on page 121
• Outbound Option Software Installation Steps, on page 127
• Maintenance Considerations, on page 134

Outbound SIP Dialer Call Flows
Call Flow Diagram for Packaged CCE
This figure illustrates a transfer to agent call flow for a SIP dialer Outbound Option campaign.
Figure 11: SIP Dialer Agent Campaign Call Flow

The call flow works as follows:
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1 You schedule the import and the campaign starts. Records are delivered to the dialer.
2 The dialer looks for an available agent through the media routing interface.
3 The media routing peripheral gateway (MR PG) forwards the request to the router.
4 The routing script identifies an agent and responds to the MR PG.
5 The MR peripheral interface manager (PIM) notifies the dialer that the agent is reserved.
6 The dialer signals the gateway to call the customer.
7 The gateway calls the customer and notifies the dialer of the attempted call.
8 Call Progress Analysis (CPA) is done at the gateway. When voice is detected, the gateway notifies the
dialer.
9 The dialer directs the voice gateway to transfer the call to the reserved agent by the agent extension.
10 The gateway directs the call to the agent through Unified Communications Manager (using dial peer
configuration to locate the Unified Communications Manager). Media are set up between the gateway and
the agent's phone.
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Unattended VRU Call Flow Diagram for Packaged CCE
This figure illustrates a transfer-to-VRU call flow for a SIP dialer Outbound Option campaign.
Figure 12: SIP Dialer Unattended IVR Campaign Call Flow

The call flow works as follows:
1 An unattended VRU campaign starts and schedules an import. Records are delivered to the dialer.
2 The dialer sends a SIP INVITE to the voice gateway to call a customer.
3 The gateway calls the customer.
4 Call Progress Analysis (CPA) detects an answering machine (AMD) and notifies the dialer.
5 The dialer sends a VRU route request to the MR PG.
6 The MR PG forwards the route request to the router which invokes the routing script.
7 The router sends the route response with the network VRU label to the MR PG.
8 The MR PG forwards the route response to the dialer.
9 The dialer sends a SIP REFER request for the label to the voice gateway.
10 The voice gateway transfers the call to Unified CVP.
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Unified CVP then takes control of the call.

Initial Setup Task Lists
This section includes summary lists of all tasks for Outbound Option initial setup.

System Configuration for Outbound Option
The first phase is to configure Outbound Option to handle the optional Outbound Option components.
Table 6: Configure Packaged CCE for Outbound Option

Step Number

Procedure

1

Configure Dialer Component, on page 118

2

Configure Port Map, on page 120

3

Configure System Options, on page 120

4

Enable Expanded Call Variables, on page 120

5

Packet Capture, on page 120

6

Configuration of Voice Gateways, on page 124

7

Create Outbound Option Private Database, on page 128

Unified CCE configuration for Outbound Option
This section provides procedures for configuring Unified CCE for Outbound Option.

Configure Dialer Component
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Make sure that all Packaged CCE services are running.
Open the Unified CCE Configuration Manager.
Expand Outbound Option, and double-click Dialer to display the Outbound Option Dialer configuration
window.
Click Retrieve.
Click Add to add a new dialer.
Enter the following information in the Dialer General Tab fields.
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Table 7: Dialer General Tab Fields

Field

Description

Dialer Name (required)

The name of the system where the dialer is located.
When you install the dialer component , enter the Dialer Name in
the Peripheral Gateway Setup exactly as you enter the name here.
Otherwise, the dialer cannot register with Campaign Manager.
This check box enables the dialer for all campaigns.
Note

Enable
ICM Peripheral Name
(required)

Select the CUCM peripheral.

Dialer Type

Select SIP (Session Initiation Protocol)

General Telephony Section
Include Area Code when
Dialing

When this option is enabled, the dialer uses the area code to reach local
telephone numbers. The default is Disabled.

Dial prefix

Enter any dialing prefix required by your location or by your campaigns.
For example, some locations require the prefix 9 to reach an outside telephone
line.

Long distance prefix

Enter the long distance prefix. The dialer checks the local area codes against
the contact number. The dialer appends the prefix for any contact number
in an area code outside the configured local area codes.
For dialers in contact centers outside the United States, either enter
the locally specific long distance prefix in the Long distance prefix
field or leave the field blank.
Enter the area/city codes for your location. Enter multiple local area codes
separated by commas; for example, “508,617,978” represents three local area
codes.
Note

Local area code (comma
delimited) (required)

Step 7

Hangup Delay (1-10)

Enter the number of seconds that the dialer waits before reusing a port after
a hangup event. The default is 1 second.

Port Throttle

The maximum calls-per-second (CPS) rate at which the dialer dials outbound
calls. For example, a port throttle count=5 indicates that no more than 5 calls
are started during a 1 second period. If 5 calls are ready to dial, they are
spaced evenly over that period. The range is from 1 to 10 CPS for SIP dialer.

Click Save.
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Configure Port Map
Perform the following steps to configure the port map for each dialer.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

In the Unified CCE Configuration Manager Outbound Option Dialer configuration window, select the
Port Map Selection tab to display the port map configuration.
To begin adding ports to this dialer, click Add.
Configure a set of ports and their associated extensions.
Click OK. The port mappings appear on the Port Map Selection tab.
Click Save to save all the configuration information.

Configure System Options
Procedure
Step 1

In Unified CCE Configuration Manager, expand Outbound Option, and then select System Options.

Step 2

Click the General Options tab and define the dialing time range to use for all your Outbound Option campaigns,
and then click OK.

Enable Expanded Call Variables
Perform the following steps to enable the expanded call variables.

Procedure
Step 1
Step 2

In Unified CCE Administration, click Manage > Expanded Call Variables.
Enable all BAxxxx variables (BAAccountNumber, BABuddyName, BACampaign, BADialedListID,
BAResponse, BAStatus, and BATimezone).

Packet Capture
For the SIP Dialer to capture data, ensure that the dialer on the call server machine uses the active interface
from the Ethernet Interface list. You can determine the active interface with a network protocol analyzer tool
such as Wireshark, which you can download from www.wireshark.org. The interface with network packets
is the active interface.
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You can change the SIP Dialer packet capture parameters to use the active interface from the Windows Registry
Editor. Change the interface name option (-i) in the CaptureOptions key to the number of the active
interface. For example, to use the third interface, set the value for -i to -i 3.
Capture files are in the HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customer
instance>\Dialer registry key location.

Unified Communications Manager and Gateway Configuration
In the next phase of Outbound Option installation, you set up Unified Communications Manager and its related
gateway.
The following table lists the steps that comprise Unified Communications Manager setup.
Table 8: Unified CM Configuration Steps for Deployments with SIP Dialer

Step Number

Procedure

1

Disable Ringback During Transfer to Agent for SIP, on page 121

2

Configuration of Voice Gateways, on page 124

3

Configure SIP Trunks, on page 126

Disable Ringback During Transfer to Agent for SIP
The voice gateway generates a ringback tone to the customer. To prevent the gateway from generating a
ringback, apply a SIP normalization script to the Unified Communications Manager SIP trunk.
Apply this SIP normalization script only to the SIP trunk that handles the inbound call from the voice gateway
for agent transfer.
• If your deployment uses the same gateway for both PSTN calls and the dialer, complete all steps, 1 to
13, to create a dedicated SIP trunk and apply the normalization script.

Note

The trunk for PSTN calls still needs a 180 RINGING SIP message for inbound calls to
trigger the gateway to play ringback to the PSTN.

• If your deployment has a dedicated SIP trunk to handle the agent transfer dialer, complete steps 1 to 2
and 8 to 13 to apply the normalization script to your SIP trunk.
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Procedure
Step 1
Step 2
Step 3

Navigate to https://<IP_address>:8443 where <IP_address> identifies the Unified
Communications Manager server.
Sign in to Unified Communications Manager.
To create a SIP trunk security profile in Unified Communications Manager, select Communications Manager
GUI > System > Security > SIP Trunk Security Profile > [Add New].
The default port is 5060.
Figure 13: SIP Security Profile

Step 4
Step 5

Click Save.
Create a new SIP trunk and add the new SIP Trunk Security Profile.
Figure 14: Create a New SIP Trunk
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Step 6
Step 7
Step 8

Click Save.
Click Reset.
In Communications Manager GUI > Devices > Device Settings > SIP Normalization Scripts > [Create
New], enter the following SIP normalization script into the content field. All other values remain set to default.
M = {}
function M.outbound_180_INVITE(msg)
msg:setResponseCode(183, "Session in Progress")
end
return M

Figure 15: Add Normalization Script
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Step 9 Click Save.
Step 10 Associate the new normalization script with the SIP trunk.
Figure 16: Associate Script with Trunk

Step 11 Click Save.
Step 12 Click Reset.

Configuration of Voice Gateways
The carrier sometimes sends an ISDN Connect message without an alerting message. In this case, the SIP
Dialer disconnects the call because a 200 OK message arrives before a SIP 183 Session In Progress message.
To correct this situation, add the following configuration to the POTS dial-peer of the voice gateway:
"progress_ind connect enable 8". This code sends the SIP 183 Session In Progress message before the
200 OK message.
Enable 100rel for Outbound Option. Otherwise, Outbound calls from the SIP Dialer fail. The following two
sections provide examples of voice gateway configuration from the command line.
Configure Rel1xx Supported for Dial-Peer for the SIP Dialer
The following example shows how to enable rel1xx on a voice dial-peer for the SIP dialer. It uses 8989 for
the tag of the voice dial-peer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 8989 voip
GW(config-dial-peer)#voice-class sip rel1xx supported 100rel
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration. (Only the bolded line is relevant to this
discussion.)
dial-peer voice 8989 voip
incoming called-number 978T
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw

Configure Outgoing Dial-Peer for a Dialing Customer
The following example shows how to configure an outgoing dial-peer for a dialing customer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 97810 voip
GW(config-dial-peer)#destination-pattern 97810[1-9]
GW(config-dial-peer)#port 1/0:23
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GW(config-dial-peer)#forward-digits all
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration for a dialing customer.
dial-peer voice 97810 pots
destination-pattern 97810[1-9]
port 1/0:23
forward-digits all

Configure Rel1xx Disable for Unified CVP Voice Dial-Peer
The following example shows how to disable rel1xx for a Unified CVP voice dial-peer. It uses 8989 for the
tag of the voice dial-peer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 8989 voip
GW(config-dial-peer)#voice-class sip rel1xx disable
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration. (Only the bolded line is relevant to this
discussion.)
dial-peer voice 8989 voip
description CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw
no vad

Configure an Outgoing Dial-Peer for Transferring Call to Agent
The following example shows the outgoing dial-peer configuration for transferring calls to agents.
dial-peer voice 11000 voip
destination-pattern 11T
session protocol sipv2
session target ipv4:10.10.10.31(this is Call Manager's IP address)
voice-class codec 1
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte h245-signal h245-alphanumeric
no vad

Note

In a SIP Dialer with Unified CVP VRU deployment, dialer-related call flows do not invoke call-survivability
scripts that are enabled on an incoming POTS dial-peer in the Ingress gateway. However, enabling a
call-survivability script on an Inbound POTS dial-peer does not negatively affect dialer-related call flows.

Configure Transcoding Profile for Cisco Unified Border Element
The following example shows the transcoding profile for Cisco UBE.

Note

Transcoding impacts port density.
dspfarm profile 4 transcode universal
codec g729r8
codec g711ulaw
codec g711alaw
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codec g729ar8
codec g729abr8
maximum sessions 250
associate application CUBE
!

Outbound Gateways and Packaged CCE System Inventory
Configure Outbound Gateways in the Unified CVP OAMP to allow them to appear in the Packaged CCE
inventory on the System Deployment tool.

Configure Cisco Unified Border Element
While configuring Cisco UBE, ensure that you:
• Configure the three dial-peers in the Cisco UBE.
The dial-peers are used for:
◦Incoming calls from the dialer.
◦Outgoing calls to the terminating network from the Cisco UBE.
◦Calls to be routed to the Cisco Unified Communications Manager.
• Issue the following commands globally to configure the Cisco UBE:
◦no supplementary-service sip refer
◦supplementary-service media-renegotiate

Configure SIP Trunks
Unified CM is connected to the voice gateway by SIP Trunks, which you configure on Unified CM.
See the System Configuration Guide for Cisco Unified Communications Manager at http://www.cisco.com/
en/us/products/sw/voicesw/ps556/prod_maintenance_guides_list.html for instructions on how to configure
SIP trunks. For information about logging in to Ingress or VXML gateways, refer to the sections on configuring
gateways for Courtesy Callback in the Configuration and Administration Guide for Cisco Unified Customer
Voice Portal at http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_
home.html.

Configure E1 R2 Signaling
The Outbound Option Dialer may be configured with systems using the E1 R2 signaling protocol. E1 R2
signaling is a channel associated signaling (CAS) international standard that is used with E1 networks in
Europe, Latin America, Australia, and Asia. For more information, see E1 R2 Signaling Theory
The high-level procedure for configuring an E1 R2 controller for use with the Outbound dialer is summarized
below. For full configuration details, see E1 R2 Signaling Configuration and Troubleshooting.
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Procedure
Step 1
Step 2

Set up an E1 controller connected to the private automatic branch exchange (PBX) or switch. Ensure that the
framing and linecoding of the E1 are properly set for your environment.
For E1 framing, choose either CRC or non-CRC.

Step 3

For E1 linecoding, choose either HDB3 or AMI.

Step 4

For the E1 clock source, choose either internal or line. Keep in mind that different PBX's may have different
requirements for their clock source.
Configure line signaling
Configure interregister signaling
Customize the configuration with the cas-custom command

Step 5
Step 6
Step 7

Example E1 R2 Settings
controller E1 0/0/0
framing NO-CRC4
ds0-group 1 timeslots 1-15,17-31 type r2-digital r2-compelled ani
cas-custom 1
country telmex
category 2
answer-signal group-b 1
caller-digits 4
dnis-digits min 4 max 13
dnis-complete
timer interdigit incoming 1000
groupa-callerid-end

Outbound Option Software Installation Steps
This section discusses the tasks that are associated with installing Outbound Option and related components.
Before proceeding, navigate to the Side A data server and stop all ICM services there. Then perform the steps
in the following sections.

Software Installation and Database Creation
In the next phase, you install the Outbound Option component software and create its database. The following
table lists the steps that comprise software installation and database creation.
Table 9: Software Installation and Database Creation Steps

Step

Procedure

1

Configure Logger, on page 129

2

Create Outbound Option Private Database, on page 128

3

Add MR PIM for Outbound, on page 130
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Step

Procedure

4

Install Dialer Component on the PG Platform, on page 130

5

Installation of Cisco CTI Controls, on page 132

Create Outbound Option Private Database
Before you use Outbound Option, estimate the size for the Outbound Option private database. Then, create
the private database on the Logger Side A platform with the ICM ICMDBA utility.

Important

Create the Outbound Option private database on Side A only.

Procedure
Step 1

Collect the following information:
• The size, in bytes, of each customer record in the import file. If the size is less than 128 bytes, use 128.
(RecordSize)
• The number of records that are imported. (RecordCount)
• Do the records from new imports replace or append to records that are already in the database?

Step 2

Estimate the contact table size as follows:
• If imports overwrite existing records: Do not change record count.
• If imports append to existing records: RecordCount = total number of rows kept in a customer table at
a time.
• contact-table-size = RecordSize * RecordCount * 1.18

Step 3

Estimate the dialing list table size as follows:
• If imports overwrite existing records: RecordCount = number of rows imported * 1.5. (50% more rows
are inserted into the dialing list than are imported.)
• If imports append existing records: RecordCount = total number of rows kept in customer table at a time
* 1.5
• dialing-list-table-size = rows in dialing list * 128 bytes * 4.63

Step 4

Calculate the database size using this formula:
(Number of rows in all DL tables * (size of one row + size of index) ) +
(Number of rows in personal call back table * (size of one row + size of index) ) +
(Number of rows in Contact List table * (size of one row + size of index))
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Step 5

Start ICMDBA by entering ICMDBA in the Microsoft Windows Run dialog box or command window.

Step 6
Step 7

Select the Logger. Then, select Database > Create.
In the Create Database window, specify the Outbound Option database type.
Note
Enable autogrow on the
database.
Click Add. The Add Device window appears.
Use this window to create a new data device and log device for the Outbound Option database. Specify the
disk drive letter and size in megabytes for each new device.

Step 8

Step 9

Click OK to create the device.

Step 10 Click Create, and then click Start.
Step 11 Click Close.

If necessary, you can later edit the device to change storage size, or remove a device, using the Database >
Expand option.

Caution

You cannot make manual changes to the contents of the Outbound database. Do not use triggers in the
Outbound database. Do not add or modify triggers for the dialing lists or personal callback list. The
Dialer_Detail table in the logger or HDS contains the information that custom applications require. Extract
that information from the historical database server (HDS) to a separate server where the custom application
can process the data without impacting the HDS.

Configure Logger
Perform the following steps to configure the logger.

Procedure
Step 1
Step 2
Step 3
Step 4

Click Web Setup.
Load the Logger and click Edit Logger.
Check Enable Outbound Option.
Click Save.
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Add MR PIM for Outbound
Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Access the CCE Call Server on Side A.
From Cisco Unified CCE Tools, select Peripheral Gateway Setup.
In the Instance Components panel of the Components Setup screen, select the PG2A Instance component
for Side A. (Select PG2B for Side B.) Then click Edit.
In the Peripheral Gateways Properties screen, click Media Routing. Then click Next.
Click Yes at the prompt to stop the service.
From the Peripheral Gateway Component Properties screen, click Add and select PIM2. and
Note
Select PIM2 and peripheralID 5006 even if you are not using PIM1 for SocialMiner or Unified
WIM and Unified EIM.
Configure with the client type of Media Routing as follows:
a) Check Enabled.
b) Enter MR2 or a name of your choice for the Peripheral name.
c) Enter 5006 for the Peripheral ID.
d) Enter CCE call server side A IP for the Application Hostname(1).
e) Retain the default value for the Application Connection port (1).
f) Enter CCE call server side B IP for the Application Hostname(2).
g) Retain the default value for the Application Connection port (2).
h) Enter 5 for the Heartbeat interval (sec).
i) Enter 10 for the Reconnect interval (sec).
j) Click OK.

Step 8

Accept defaults and click Next until the Setup Complete screen opens.

Step 9

At the Setup Complete screen, check Yes to start the service. Then click Finish.

Step 10 Click Exit Setup.
Step 11 Repeat from Step 1 for the CCE Call Server on Side B.

Install Dialer Component on the PG Platform
Procedure
Step 1
Step 2
Step 3
Step 4

Stop all Packaged CCE Services.
On both the call server Side A and Side B, run Peripheral Gateway Setup. Select Start > All Programs >
Cisco Unified CCE Tools > Peripheral Gateway Setup.
In the Cisco Unified ICM/Contact Center Enterprise & Hosted Setup dialog, select an instance from the
left column under Instances.
Click Add in the Instance Components section.
The ICM Component Selection dialog opens.
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Step 5

Click Outbound Option Dialer.
The Outbound Option Dialer Properties dialog opens.

Step 6

Check Production mode and Auto start at system startup, These options set the Dialer Service startup type
to Automatic, so the dialer starts automatically when the machine starts up.
For Dialer Type, select the radio button for SIP (Session Initiation Protocol).
Click Next.
Note
After you create a dialer, you cannot change the Dialer Type. To switch dialer types, delete the
existing dialer and create a new dialer.
An Outbound Option SIP Dialer Properties dialog appears. Supply the following information on this page:

Step 7
Step 8
Step 9

• In the SIP Dialer Name field, enter the name of the SIP dialer, for example,
Dialer_for_Premium_Calling_List. There is a 32-character limit. The name entered here must match
the name that is configured in Configuration Manager.
• For SIP Server Type, select Cisco voice gateway.
• In the SIP Server field, enter the hostname or IP address of the Cisco voice gateway.
• In the SIP Server Port field, enter the port number of the SIP Server port. Default is 5060.
Click Next.
Step 10 On the Outbound Option Dialer Properties dialog, specify the following information:
• Campaign Manager server—The hostname or IP address of the Outbound Option server (the hostname
or IP address of Data Server Side A).
• CTI server A—The hostname or IP address of Call Server Side A.
• CTI server port A—The port number that the dialer uses to create an interface with CTI server Side
A. The default is 42027.
• CTI server B—The hostname or IP address of Call Server Side B.
• CTI server port B—The port number that the dialer uses to create an interface with CTI server Side
B. The default is 43027.
• Heart beat—The interval between dialer checks for the connection to the CTI server, in milliseconds.
The default value is 500.
• Media routing port—The port number that the dialer uses to create an interface with the Media Routing
PIM on the Media Routing PG. The default is 38001. Make sure the Media routing port matches that of
the MR PG configuration.
Step 11 Click Next. A Summary screen appears.
Step 12 Click Next to begin the dialer installation.

Optional - Edit Dialer Registry Value for AutoAnswer
If you enable auto answer in the CallManager with a zip tone, you must disable auto answer in the Dialer. A
zip tone is a tone sent to the agent's phone to signal that a customer is about to be connected.
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To disable auto answer in the Dialer, after the Dialer process runs for the first time, change the value of the
Dialer registry entry, AutoAnswerCall, to 0.

Auto Answer Configuration on Agent Phones
The dialer component is preconfigured during installation to auto answer Outbound Option related calls to
the Outbound Option agent. However, this default configuration does not provide a zip tone to the agent
(which notifies of incoming calls), so agents must monitor the agent application for incoming customer calls.
To enable zip tone, enable auto-answer on the agent’s phone configuration in Unified CM. This solution adds
about a second onto the transfer time. This solution is identical to the solution that is used for Unified CCE.
For Mobile Agents using the nailed connection, the Unified CM auto answer setting does not provide a zip
tone, but Packaged CCE does provide an option for playing a notification tone to the agent using the agent
desk settings.
Enabling auto answer in the agent desk settings or in the dialer component in conjunction with the Unified
CM can be problematic. Therefore, Cisco recommends that you disable the auto answer option in the dialer
component, and enable it either in the agent desk settings or in Unified CM.

Installation of Cisco CTI Controls
This section describes the installation process for the Cisco CTI controls. It also describes how to install the
Cisco CTI Toolkit Outbound Desktop (Win32) for Packaged CCE.
Perform the following procedures to install CTI controls to support Outbound Option on the desktop.

Configure CTI OS Server for Outbound Option
If you are running Outbound Option with CTI OS, perform the following procedure to add Outbound Option
expanded call variables to CTI OS Server:

Procedure
Step 1
Step 2

Log in to the CTI OS server.

Step 3
Step 4

Right-click the file, select Properties, and then uncheck the read-only check box.

Step 5
Step 6
Step 7
Step 8

Rename the <Drive Letter>:\ICM\CTIOS_bin\blendedagent_addecc.reg.txt file to
blendedagent_addecc.reg.
Edit the blendedagent_addecc.reg file and globally change “InstanceName” to the system instance
name from your Unified ICM setup.
Save the file.
Double-click the blendedagent_addecc.reg file to add the Outbound Option expanded call variables
to CTI OS.
In the Node Manager, restart the CTI OS service on the call server.
Restart all CTI OS Desktop clients to automatically download the new expanded call variables.
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Install CTI Toolkit Outbound Desktop (Win32)
A sample CTI OS Desktop (known as the “Cisco CTI Toolkit Outbound Desktop (Win32)”), which supports
Outbound Option, is shipped with the product. It is located in <Drive Letter>:\Program Files\Cisco
Systems\CTIOS Client\CTIOS Toolkit\Win32 CIL\Samples\CTI Toolkit Outbound Desktop.

Procedure
Step 1

Install CTI OS Client and confirm that the CTI Toolkit SDK and Win32 check boxes are checked.

Step 2

Access the CTI Toolkit Outbound Desktop (Win32) from the following location:
<Drive Letter>:\Program Files\Cisco Systems\CTIOS Client\CTIOS Toolkit\Win32
CIL\Samples\CTI Toolkit Outbound Desktop

Step 3

Double-click the CTIOSOutOptSSoftphone.exe file. The CTI Toolkit Outbound Desktop (Win32) displays.

Integrate Outbound Option with Standard CTI Toolkit Agent Desktop
Outbound Option is fully compatible with the CTI OS CIL library and the CTI Toolkit Agent Desktop (Win32).
While there are no Outbound Option-specific controls available for the CTI Toolkit Agent Desktop (Win32),
the standard CTI Toolkit Agent Desktop (Win32) can be modified to display all Outbound Option expanded
call variables in the call variable grid.

Set Outbound Option Expanded Call Variables
After you add the Outbound Option expanded call variables to the standard CTI Toolkit Agent Desktop
(Win32), you can set the values through the grid on the Agent Desktop with Outbound Option. When the
agent logs in, the Outbound Option-related expanded call variables are visible. The agent can then change
values for those variables.

Verify connections
The Diagnostic Framework Portico provides details about the health of the installation even before any
campaign configuration is initiated or before any call is placed. The interface contains the following details
about the dialer status.

Procedure
Step 1

Navigate to the Outbound Option Dialer component in the Diagnostic Framework Portico.
The Node Name is Dialer. The Process name is BADialer.

Step 2
Step 3
Step 4
Step 5

Verify that the Campaign Manager (CM) has a status of Active (A).
Verify that the CTI Server (CTI) has a status of Active (A).
Verify that the number of Configured Ports equals the number of Ready Ports.
Verify that the MR has a status of Active (A).
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Maintenance Considerations
This section contains information about maintaining the Outbound Option application.

SIP Dialer Voice Gateway Over-capacity Errors
Your network monitoring tool might receive an alarm from the SIP dialer about being over capacity. You can
ignore the alarm unless it becomes an ongoing issue. This section describes the source of the alarm and
remedial actions.
If the Voice Gateway in a SIP dialer implementation is over capacity, the SIP Dialer receives the following
message: SIP 503 messages if the SIP Dialer is deployed with Voice Gateway
only.
The SIP dialer raises an alarm when the percentage of SIP 503 messages reaches 1% of all messages.
If Voice Gateway capacity becomes an ongoing issue, use one of the following measures to attempt to remedy
the problem:
• Check the Voice Gateway configuration. If there are errors, fix them and reset Port Throttle to its original
value. Port Throttle, the calls-per-second rate at which the dialer dials outbound calls, is set on the Dialer
General tab in Unified CCE Configuration Manager.
• Check the sizing information. Adjust the value of Port Throttle according to the documented guidelines.
• Enable the auto-throttle mechanism by setting the Dialer registry setting EnableThrottleDown to 1.
To set EnableThrottleDown, open the Registry Editor (regedit.exe) on the PG machine and navigate
to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customerinstance>\Dialer .
When the auto-throttle mechanism is enabled, the SIP dialer performs an automatic throttle down when the
percentage of SIP 503 messages reaches 2% of all messages,. This throttle down means that the SIP dialer
decreases the configured value of Port Throttle by approximately 10%.
If one throttle down does not correct the problem, the SIP dialer performs additional throttle downs until either
the problem is corrected or the value of Port Throttle is throttled down to 50% of the originally configured
value.
For each automatic throttle down, alarm and trace messages clearly provide detailed information about the
adjusted port throttle value, the configured port throttle value, and time duration.

Update the North American Numbering Plan Data
The Regional Prefix Update Tool (RPUT) is used to update the Packaged CCE database to the latest North
American Local Exchange NPA NXX Database (NALENND).
You can use this tool only if Packaged CCE is using the North American Numbering Plan.
The RPUT is composed of the following two files (installed in the ICM\bin directory on the data server):
• region_prefix_data.txt (or the <DatafileName>)
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Contains the data this tool uses to update the region prefix table in the Packaged CCE database. Note
that you should change paths to the ICM\bin directory.
• regionfix.exe
This executable reads the region_prefix_data.txt data file and updates the region prefix table.
The RPUT is run from the command line as described in the following procedure.

Procedure
Step 1

Open a command prompt (Select Start > Run, and enter cmd, then click OK).

Step 2

Change the path to ICM\bin.

Step 3

Enter the following at the prompt: regionfix.exe <DatafileName> (where <DatafileName> is the name of
the data file).
The Regional Prefix Update Tool then shows the version of the input data file and asks if you want to proceed.
If you proceed, the tool connects to the Packaged CCE database. The number of records that are to be updated,
deleted, and inserted appear. These records are put into two different files:
• region_prefix_update.txt (which includes deleted entries)
• region_prefix_new.txt

Step 4
Step 5

Check the contents of the two files before proceeding.
Answer Yes to proceed with the update.
When the update is complete, the tool displays the following message:
Your region prefix table has been successfully updated.

Administration and usage
Campaign configuration
Campaign Task List
The following table lists the steps that are required to create both an agent and IVR campaign, and the location
of the instructions for the task.
Table 10: Steps for Creating a Campaign

Step Number

Task

Where Discussed

1

Create one or more skill groups for the campaign.

Configure Skill Group,
on page 136
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Step Number

Task

Where Discussed

2

Configure the call type using the Packaged CCE Call Type
gadget.

Create a Call Type, on
page 136

3

Create a dialed number on the MR client using the Packaged Configure Dialed
CCE Dialed Number gadget. This dialed number is for agent Numbers, on page 137
reservation.

4

Create DN for Abandon to IVR on the MR PG for the SIP
dialer.

5

Create DN for AMD to IVR on the MR PG for the SIP dialer. Configure Dialed
Numbers, on page 137

6

Configure import rule using the Outbound Option Import
Rule Tool.

Create Import Rule, on
page 137

7

Configure query rules using the Outbound Option Query
Rule tool.

Create a Query Rule, on
page 143

8

Configure a campaign using the Outbound Option Campaign Create a Campaign, on
tool.
page 144

9

Configure a routing script using the Script Editor.

Set Up Routing Scripts,
on page 162

10

Configure an administrative script using the Script Editor.

Set Up Administrative
Scripts, on page 158

11

Voice gateway configuration.

Voice Gateway and
Unified CVP
configuration for an VRU
campaign, on page 157

Configure Dialed
Numbers, on page 137

Configure Skill Group
Add at least one skill group. For an agent campaign, add at least one agent to the skill group. Log the agent
in to the skill group, and make the agent ready for the agent campaign. You do not need to add an agent for
a VRU campaign skill group. For information about configuring skill groups, see the Cisco Packaged Contact
Center Enterprise Administration and Configuration Guide at http://www.cisco.com/en/US/products/ps12586/
tsd_products_support_series_home.html.

Create a Call Type
The dialed numbers and routing scripts that you will create will reference call types, so you should create
them as needed. For information about creating call types, see the Cisco Packaged Contact Center Enterprise
Administration and Configuration Guide at http://www.cisco.com/en/US/products/ps12586/tsd_products_
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support_series_home.html. For example, you can create one call type for an agent campaign and another for
a VRU campaign. You need to associate the call types with the dialed numbers you created earlier.

Configure Dialed Numbers
Configure at least two dialed numbers on the outbound routing client: one for the agent campaign and one
for the VRU campaign. See the Cisco Packaged Contact Center Enterprise Administration and Configuration
Guide at http://www.cisco.com/en/US/products/ps12586/tsd_products_support_series_home.html for
information about configuring dialed numbers.

Create Import Rule
The Import Rule defines how Outbound Option:
• Locates the imported file and defines the name of the contact table into which the import process places
the contact information.
• Recognizes and defines the contact list data in the imported file. The Import Rule defines the import
format of the user contact list (fixed length, comma-delimited, or pipe delimited fields), and the
information to be found in the fields of the file, such as the first and last names of contacts.
• Schedules updates for your calling lists imports.
There are two types of import rules in Outbound Option:
• Contact - An import rule that you create for a specific campaign. It is possible to have a single import
rule with many contacts, and use query rules to separate those contacts into different campaigns.
• Do Not Call - An import rule, created once and applicable to all campaigns, that provides do-not-call
information to all campaigns

Note

When you edit an existing import rule, changing the target table name creates a new table, but does not
remove the old table. The old table remains in the database, but the system does not use it.
When you import records, take note of the following:
• The dialing rate/CPS is affected.
• The “record fetch query performance” is also affected if you are importing huge number of records. The
performance of the query impacts the call rate.
Perform the following steps to create an import rule.

Procedure
Step 1
Step 2
Step 3

In Unified CCE Configuration Manager, expand the Outbound Option menu, then double-click the Outbound
Option Import Rule component.
Click Retrieve.
Click Add at the bottom of the list box area of the window. Then fill out the information that is required on
the following tab pages:
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a) Import Rule General Tab Page, on page 138.
b) Import Rule Definition Tab Page, on page 139.
c) Import Rule Schedule Tab Page, on page 142.
Step 4

Note

Click Save.

If you edit an import rule, the changes that you make to that import rule take effect on the next import.

Import Rule General Tab Page
Specify the following information on the Import Rule General tab page.
Field

Description

Import name (required)

There is a 32-character limit.

Enable option

This option enables or disables importing for the import rule.

Import type

Select either Contact or Do_Not_Call from the drop-down list.
If you are creating a Do_Not_Call import, be sure to also
properly format the Do Not Call list file as described in
Create Do Not Call List, on page 141. If you are creating
a contact import, format the contact import file as
described in Create Contact Import File, on page 141.
If you selected Do_Not_Call as the import type, the Import Rule
component automatically assigns it to the DoNotCall table.
Note

Target table name (required)

If you selected Contact as the import type, you can enter any name
for the target table within the following restrictions:
The name must be a maximum 32-character string, including
alphanumeric characters, periods (.), underscores (_), and hyphens
(-). Alphabetic characters can be upper- or lowercase. The name
must begin with an alphanumeric character and must not contain
spaces.
Import file path (required)

Enter the directory path name for the import file. The maximum
number of characters allowed is 255. Click Browse to the right of
the Edit field to browse for the location.

Import data type

Select the Comma delimited, the Pipe delimited, or the
Fixed-length setting, to indicate if the file is comma-delimited,
pipe-delimited, or if it uses fixed-length columns to separate fields.
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Field

Description

Overwrite table

When this option is enabled, you can overwrite the current import
with a new import.
When this option is disabled, new import data is appended to the
existing data. You cannot append a new field to existing import
data. Also, you cannot modify or remove existing fields.
Note

Do not perform a file import with the Overwrite table
option while a campaign is in progress. If you do, the dialer
becomes unable to access records, because a database
operation is in progress on the dialing List table.

Import Rule Definition Tab Page
Specify the following information on the Import Rule Definition tab page.
Field

Description

Standard column type

Choose a column type to use for this data field in the import rule.
The following column types are allowed:
• AccountNumber - VARCHAR (30)
• Custom
• FirstName - VARCHAR (10)
• LastName - VARCHAR (20)
• Phone01 through Phone10 - VARCHAR (20)
Allowed data: digits 0-9, pound sign (#), and asterisk (*)
• PhoneExt01 through PhoneExt10 - VARCHAR (8)
This column is for future use. Do not use it.
Outbound Option removes single quotation marks present in the
Import file.
Outbound Option does not send data from Custom columns to the
agent desktop. They are available for use only in the query rule
select clause for business-specific filtering into different dialing
lists.

Field name

The name that you assign to this field, disabled unless you select
Custom for the Standard column type. The maximum length is 32
characters.
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Field

Description

Type

The field name and its drop-down list are disabled unless you select
Custom for the Standard column type. For a Custom type, select
the data type that this field uses. The following Custom column
types are allowed:
• Custom CHAR (up to 255 characters)
• Custom VARCHAR (up to 255 characters)
• Custom DATETIME (date followed by time: MM/dd/yy
HH:mm:ss)
• Custom REAL (up to 4 characters, including the decimal
point)
• Custom INT (up to 255 characters; decimal point counts as
one character.)
The default is the VARCHAR data type.

Field length (1-255)

The number of characters that this field uses to store data. The
default is 1.

Decimal places (1-10)

For numeric data fields, enter the number of decimal places you
want the import rule to use.

Allow nulls to be entered for this field If you enable this option, you can have empty data in the import
file for this column.
If you disable this option, you must have data.
The default is Disabled.

Imports
This section provides procedures for creating an import rule file, creating a Do Not Call list, and adding
attributes for a contact list.
Import Procedure
Before you run an import, first create an import rule file that contains the data to be imported. This import
rule can have a maximum of 1024 characters per row, and can be in one of three formats:
• Comma Delimited - Each column's data is separated by a comma.
• Fixed Format - Each column has a fixed character width as specified on the Definition tab of the Import
rule tool. The number of characters in the entry for each column must exactly match the column definition.
If the data for a field does not fill the specified width of the column, pad the entry with spaces to the
defined character width.
• Pipe Delimited - Each column's data is separated by a pipe.
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Create Do Not Call List
When creating a Do_Not_Call list file, format it correctly using the following instructions.

Procedure
Step 1
Step 2
Step 3

Using a text editor, create a text file that contains all the do-not-call phone numbers.
Enter a phone number for each Do Not Call entry on a new line.
Observe the following characteristics for each Do Not Call entry:
• Each phone number can be a maximum of 20 characters long.
• The Do Not Call table can support up to 60 million entries, but note that the information is stored in
memory in the Campaign Manager process.

Step 4

Save the text file to the local server.

The following is an example of a Do_Not_Call list:
2225554444
2225556666
2225559999

To add a customer to this list, import a Do Not Call list.
The Campaign Manager reads the Do Not Call import files. Dialing List entries are marked as Do Not Call
entries only when the Campaign Manager fetches the Dialing List entry and only when there is an exact,
digit-for-digit match. This allows Do Not Call imports to happen while a Campaign is running without
rebuilding the Dialing List.

Note

If the Dialing List includes a base number plus extension, this entry must match a Do Not Call entry for
that same base number and same extension. The dialer will not dial the extension.
When the Campaign Manager starts it automatically imports from the DoNotCall.restore file that is stored in
the <drive>\icm\<instance>\la\bin directory. When reading Do Not Call import files, the Campaign Manager
appends the data to the DoNotCall.restore file. This restore file allows recovery of Do Not Call records after
the Campaign Manager stops unexpectedly or for planned maintenance, such as a Service Release installation.
The restore file can grow to approximately 1 GB if 60 million DNC records are imported, each having ten-digit
numbers plus five-digit extensions. Sufficient disk space must be available on LoggerA to store the
DoNotCall.restore file.

Note

To clear the Do Not Call list, import a blank file with the Overwrite table option enabled.

Create Contact Import File
When creating a contact import file, observe the format you designed according to the database rules set up
in Import Rule Definition Tab Page.
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The following example assumes that you have contact information with AccountNumber, FirstName, LastName,
and Phone column types.

Procedure
Step 1
Step 2

Using a text editor, create a text file that contains the information for these fields.
Enter an account number, first name, last name, and phone number for each entry on a new line.
Use either Comma Delimited, Pipe Delimited, or Fixed Length, as defined on the Import Rule General Tab
Page.

Step 3

Save the text file to the local server.

The following is an example of a contact import file in the comma-delimited format:
6782,Henry,Martin,2225554444
3456,Michele,Smith,2225559999
4569,Walker,Evans,2225552000

The following is the same example in Fixed Format with the following column definitions:
• Custom - VARCHAR(4)
• FirstName - VARCHAR(10)
• LastName - VARCHAR(20)
• Phone - VARCHAR(20)
6782Henry

Martin

2225554444

3456Michele

Smith

2225559999

4569Walker

Evans

2225552000

Import Rule Schedule Tab Page
Specify the following information on the Import Rule Schedule tab page.
Field

Description

Schedule start time

Enter or select the time when the process starts. Because the setting
uses 12-hour time notation, be sure to select AM or PM. The time
is based on the local time at the data server. The default is 9:00
AM.

Weekly option

Enable this option for the import rule process to execute on the
same days each week. Enable the days of the week when you want
the process to execute. Disable this option if you do not want the
process to execute weekly.
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Field

Description

Monthly option

Enable this option for the import rule process to execute on selected
days each month. Enter the day of the month on which you want
the process to execute. If you select a date that does not occur
during a particular month, such as the 31st day of April, the import
does not execute on that month.

Start import when file is present
option

Enable this option to import a file as soon as it is copied into the
specified location. The folder that you specify must have write
permissions. Otherwise, import file copying and renaming cannot
occur.
The import process polls every second to see when the import file
becomes available. After the file is available, the import begins
immediately.

Rename File After Import

When selected, specifies that the import file is renamed by
appending “.bak” to the filename after the import is complete.

Delete File After Import

When selected, specifies that the import file is deleted after the
import is complete.

Create a Query Rule
The Query Rule component defines the SQL rule that the Outbound Option Import process uses to build the
dialing list for a particular campaign. Based on SQL queries to the database, the rule defines how the contact
records from the Outbound Option database are selected to be inserted in the dialing list.
Perform the following steps to create a query rule.

Procedure
Step 1
Step 2

In Unified CCE Configuration Manager, expand the Outbound Options menu, then open the Outbound Option
Query Rule component.
Click Retrieve.

Step 3

Click Add at the bottom of the list box area of the window.

Step 4

Specify the following information on the Query Rule General tab page.
Table 11: Query Rule General Tab Page

Field

Description

Query rule name (required)

Maximum 32-character string, including alpha-numeric characters,
periods (.), and underscores (_). Alphabetic characters can be
uppercase or lowercase. The name must begin with an alphanumeric
character, and must not contain spaces.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
143

Outbound Option
Campaign configuration

Field

Description

Enable option

Specifies that the rule is available for all campaigns. The default
is Enabled.

Import

Select the name of the import rule to use as part of this query rule.
The drop-down list displays all the import rules that you created
with the Outbound Option Import Rule component.

Description

(Optional) Enter a description of this query rule.

Rule Clause (required)

To create a rule clause for selecting records, select items from the
Column Name, Operators, and SQL Functions columns on this tab
page, and then click Paste to enter them in the Rule Clause area
of the tab page. After you have created the rule clause, click
Validate Rule Clause to perform SQL syntax checks on everything
in the Rule Clause area. If SQL returns any syntax warning or error
messages, correct any problems before clicking Save at the bottom
of the tab page.
If you want a rule clause to select all records in the input, specify
a rule clause of 1=1.

Update Dialing List

If you change this query rule, clicking this button causes the
changes to be updated in the dialing list for all the campaigns that
use this particular query rule (dynamic update). If you do not click
this button, the changes occur during the next import.

If Update Dialing List fails, check whether the AW is pointing to Logger Side A. The AW must point
to Logger Side A, not Side B. If the AW is pointing to Logger Side B rerun setup and repoint it to
A.
Click Save.
Note

Step 5

Create a Campaign
Use the Outbound Option Campaign tool to add, delete, and modify campaigns.
Before you create a campaign, first configure the following information:
• At least one skill group
• At least one query rule
• The following dialed numbers with Routing Type set to Outbound Voice:
◦One for accessing the agent reservation script (not required for transfer to VRU campaigns).
◦One for transferring the call to the VRU for abandon treatment when no agents are available. This
number must be different from the previous number.
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◦One for transferring the call to the VRU for answering machine detection (AMD) or transfer to
VRU campaign treatment. This number can be the same as the previous number, but different from
the first number.
Perform the following steps to create a campaign.

Procedure
Step 1
Step 2
Step 3
Step 4

Step 5

In Unified CCE Configuration Manager, expand the Outbound Option menu, then open the Outbound Option
Campaign component.
Click Retrieve.
Click Add at the bottom of the list box area of the window.
Fill in the fields described on the following pages:
a) Campaign General Tab Page, on page 145.
b) Campaign Purpose Tab Page, on page 149.
c) Query Rule Selection Tab Page, on page 151.
d) Skill Group Selection Tab Page, on page 152.
e) Call Target Tab , on page 153.
Click Save.

Campaign General Tab Page
Specify the following information on the Campaign General tab page.
Field

Description

Campaign Name (required)

Maximum 32-character string, including alphanumeric characters,
periods (.), and underscores (_). Alphabetic characters can be upperor lowercase. The name must begin with an alphanumeric character.

Description

Optional description for the campaign; maximum 255 characters.

Enable option

This option enables or disables the campaign.

Power Dialing Section
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Field

Description

Lines per agent (required)

The number of lines dedicated to each agent in this campaign. If this
value and the Maximum lines per agent value are both set to 1, the
mode defaults to Progressive.
Default = 1.5 (Three lines for every two agents.)
Allowable Range = 1 – 100
This value performs as follows in the Outbound Option dialing modes:
• Preview mode: Ignored (always 1).
• Progressive mode: Used as defined.
• Predictive mode: Used as an initial value.

Dialing Options Section
Maximum lines per agent
(required)

The upper bound for the number of customers the dialer dials for a
reserved agent at a time when the campaign is running in predictive
mode.
Default = 2
Range = 1 – 100

Abandon calls limit (1-100)

This option only applies to Predictive campaigns.
Enable this option to set an Abandon calls limit (1-100) for the
percentage of abandoned calls in this campaign. The granularity is to
one-tenth of a percent. Default = 3.0.
If the option is disabled, the campaign dials without regard to the
abandon limit.
Note
A call is considered abandoned if a person answers it and the
contact center does not connect the call to a sales
representative within two seconds of the person's completed
greeting.

Advanced

Clicking the Advanced button opens a Predictive Dialing Settings
dialog box. On this dialog box, you can change the Voice Calls Per
Adjustment and the Gain parameters that control how adjustments are
made to the lines per agent in this campaign. Accept the default in
most cases. For more information, see Parameter Tuning, on page
148.

Dial Settings Section
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Field

Description

No answer ring limit (2 to 10)

Defines the number of times the software allows a dialed telephone
number to ring. Enter the maximum number of rings allowed. The
length of one ring is specified at the dialer level in the
TimeToRingCustomer registry entry. Default = 4.
The default behavior is to allow calls to ring for 32 seconds
(No answer ring limit –4, TimeToRingCustomer key –8
seconds). Assuming the default 8-second
TimeToRingCustomer key is used, setting the "No answer
ring limit" to the minimum 2 rings meets 15-second ring-time
requirements.
Defines the maximum number of attempts, including callbacks and
retries. Enter the maximum number of attempts to be made in zone 1
and zone 2. Default = 3. Increasing the number of attempts causes
closed records to be reopened, which can result in slower performance.
For more information, see Modification of Maximum Number of
Attempts in a Campaign, on page 148.
Note

Maximum attempts (1 to 100)

Abandoned call wait time (0 to 10) Minimum duration (in seconds) of an outbound call. If the duration
of an outbound call is less than this specified value, Outbound Option
(required)
considers the call as customer abandoned, and the customer record
that is associated with that call is scheduled for a retry. To disable this
feature, set this value to 0. Enter the number of seconds. Default = 1.
If this feature is disabled, then Outbound Option does not consider
this call as customer abandoned. It affects the reporting of this call in
the Outbound Option dialer_detail table.
Campaign Prefix Digits

Digits to be prefixed to each customer number dialed from this
campaign. For the SIP Dialer, this field represents the phone number
that is advertised as the calling number for the campaign. Enter a
maximum of 15 digits in this field.

Retries Section
No answer delay

Defines (in minutes) how often the software waits before calling back
a no-answer call. Enter the number of minutes. Default = 60.

Busy signal delay

Defines (in minutes) how long the software waits before calling back
a busy telephone number. Enter the number of minutes. Default = 60.

Customer abandoned delay

If a customer abandons a call, the time (delay in minutes) before the
dialer calls the customer back. Default = 30.

Dialer abandoned delay

If the dialer abandons a call, the time (delay in minutes) before the
dialer calls the customer back. Default = 60.

Answering machine delay

If an answering machine answers the call, how long the software waits
(in minutes) before calling back. Default = 60.
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Field

Description

Customer not home delay

If the customer was not at home and should be called back, the time
(in minutes) before the dialer calls the customer back. Default = 60.

Callback Settings Section
Personalized callback

Enables the personal callback option. This option allows an agent to
schedule a callback to a customer for a particular date and time, which
connects the customer to the agent they originally spoke to at the time
the customer requested.

Reschedule callback mode
(required)

Determines how Outbound Option handles the personal callback if
the agent is not available:
• Use Campaign DN.
• Reschedule the personal callback to the same time the next
business day.
• Abandon the personal callback.

Modification of Maximum Number of Attempts in a Campaign
You can recall customers who were previously not reached without having to import their phone numbers
again by increasing the maximum number of attempts amount in the Maximum attempts field on the Campaign
General tab page This option is useful if the campaign import is an append type instead of an overwrite type.

Note

Do not update the Maximum attempts field while the campaign is in progress. Modifying this option in
the campaign configuration results in an update of all customer records that were not successfully contacted.
The Campaign Manager can update only about 20 records per second, and no new customer records are
delivered to the dialer for this campaign while this update is in progress.
You can view how many records have been closed and how many were successfully reached by using the
Call Summary Count per Campaign Real Time report. See Reports, on page 170 for more information.

Parameter Tuning
The Voice Calls Per Adjustment and Gain parameters are settings in the Advanced Users configuration tab
used to control the way the predictive dialing behaves. Do not modify the default values unless you understand
the parameters and the possible risks incurred when changing the pacing.
• The Voice Calls Per Adjustment parameter is a count of the number of live voice connections that are
required to trigger a correction. (The default value is 70 voice calls.) If the abandon rate exceeds the
target by a significant margin, the dialer can make corrections before collecting 70 calls.
• The Gain parameter controls the size of the Lines per agent corrections.
Setting the Voice Calls Per Adjustment parameter to a smaller setting leads to larger fluctuations in the
measured Abandon Rate because the sample size is less significant. This results in less change in the Lines
per agent value over time.
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Caution

Be careful when modifying both parameters (Gain and Voice Calls Per Adjustment) at the same time. For
example, increasing the Gain while decreasing the Voice Calls Per Adjustment results in larger changes
in the “Lines per agent correction rate,” which might overcorrect changes in measured values.
Decreasing the Gain while increasing the Voice Calls Per Adjustment can similarly cause too slow of a
change to underlying changes in the hit-and-abandon-rates. A campaign that is reaching more than 20 live
voice customers every minute (600 per half hour) might benefit from reducing the Gain, but a lower Gain
becomes less effective as the number of agents in the campaign dwindles or the hit rate changes rapidly.

Campaign Purpose Tab Page
Specify the following information on the Campaign Purpose tab page.
Field

Description

Agent Based Campaign
Agent Based Campaign

This type of campaign uses an outbound mode that causes the dialer
to transfer every customer call that is associated with a specific skill
group to an agent.

Enable IP AMD

Selecting this option enables answering machine detection for the IP
dialers in the system only. If this option is enabled, when the dialer
detects an answering machine, it performs one of the following actions.
(Default = Enabled.)
• Abandon Call (default): Drops the call, marks it as an
answering machine, and schedules a retry.
• Transfer to Agent: Transfers the call to an agent.
• Transfer to IVR Route Point: Transfers the call to play a
prerecorded message. (The IVR route point is configured in the
Skill Group Selection dialog box in the Campaign Skill Group
Selection tab.)
Note
Once transferring to an agent or to a VRU is configured,
there is no way to set the AMD records as Retry. Use
a customized query to identify such calls and create a
new campaign.
• Terminate Tone Detect: Transfers the call after detecting the
answering machine beep.
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Field

Description

Call Progress Analysis

If this option is disabled, all Call Progress Analysis for all calls made
from this dialer is disabled on a campaign-by-campaign basis,
including voice detection, fax/modem detection, and answering
machine detection. (Default = Disabled.)
If Call Progress Analysis is enabled, specify the Record CPA
parameter. The Gateway provides a media stream and the dialer
records .wav files. This parameter improves Call Progress Analysis
performance.
Note

If you have a SIP dialer, enable IP AMD for Call Progress
Analysis to function. If you do not enable IP AMD, the SIP
dialer instructs the gateway to transfer the call to agent
without waiting for detection.

Transfer to IVR Campaign
Transfer to IVR Campaign

This type of campaign uses an outbound mode that causes the dialer
to transfer every customer call that is associated with a specific skill
group to a service control-based VRU instead of an agent. This feature
allows a contact center to run unassisted outbound campaigns using
prerecorded messages in the VRU.

Enable IP AMD

Selecting this option enables answering machine detection for the IP
dialers in the system only. If this option is enabled, when the dialer
detects an answering machine, it does one of the following actions.
(Default = Enabled.)
• Abandon Call (default): Drops the call, marks it as an
answering machine, and schedules a retry.
• Transfer to IVR Route Point: Transfers the call to play a
prerecorded message. (The IVR route point is configured in the
Skill Group Selection dialog box in the Campaign Skill Group
Selection tab.)
Note
Once transferring to an agent or to an IVR is configured,
there is no way to set the AMD records as Retry. Use
a customized query to identify such calls and create a
new campaign.
• Terminate Tone Detect: Transfers the call after detecting the
answering machine beep.

Call Progress Analysis Parameters
Minimum Silence Period
(100-1000)

Minimum silence period required to classify a call as voice detected.
If many answering machine calls are being passed through to agents
as voice, then increasing this value accounts for longer pauses in
answering machine greetings. Default is 608.
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Field

Description

Analysis Period (1000-10000)

Number of milliseconds spent analyzing this call. If there is a short
agent greeting on an answering machine, then a longer value here
categorizes that answering machine call as voice. If the call is to a
business where the operator has a longer scripted greeting, a shorter
value here categorizes the long, live greeting as answering machine.
Default is 2500.

Minimum Valid Speech (50-500)

Minimum number of milliseconds of voice required to qualify a call
as voice detected. Default is 112.

Maximum Analysis Time
(1000-10000)

Maximum number of milliseconds allowed for analysis before
identifying a problem analysis as dead air/low volume. Default is
3000.

Maximum Termination Tone
Analysis (1000-60000)

Maximum milliseconds the dialer analyzes an answering machine
voice message looking for a termination tone. If the message has an
odd tone and the analysis does not recognize it, the call is not
transferred or dropped until this timeout occurs. Default is 30000.

Reset to System Default

Resets all items in the Call Progress Analysis (CPA) Parameters
section to the system defaults.

Query Rule Selection Tab Page
Press the Add button on the Query Rule Selection tab page and specify the following information.
Field

Description

Query rule name

The name of the query rule.

Enable

Enables the query rule for this campaign. Default = Enabled.

Start time

The local time at the Packaged CCE Central Controller when a query
rule can begin to execute.

End time

The local time at the Packaged CCE Central Controller when a query
rule must stop executing.

Penetration (0-400):

The maximum number of calls that this campaign tries during a query
rule execution; for example, 400 contact attempts. When a query rule
reaches the penetration number, it stops executing and the next query
rule in the list begins to execute. Default = 100. If this option is
enabled, Duration and Hit Rate are disabled.
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Field

Description

Duration (0-120):

The total amount of time that this query rule can run; for example, 30
minutes. When the query rule reaches the time limit, it stops executing
and the next query rule in the list can begin to execute. Default = 30.
If this option is enabled, Penetration and Hit Rate are disabled.

Hit Rate (0-100):

The minimum percentage of calls that can be answered (excluding
answers by answering machines) during this query rule execution;
for example, 30 percent. If the hit rate drops below this value, the
next query rule begins to execute. Default = 30. If this option that is
enabled, Duration and Penetration are disabled.

Skill Group Selection Tab Page
From the Skill Group Selection tab page, press Add to display the fields available to fill out.
Field

Description

Skill Group Name

The name of the skill group that is assigned to this campaign.

Overflow Agents per Dialer (0-100) This setting can be useful for Progressive campaigns to reduce the
abandon rate at the cost of increasing agent idle times. This setting
ensures that there is always at least one extra agent reserved before
the dialer begins dialing. When this setting is set to 1, at least two
agents must be reserved before the dialer begins dialing. The intention
is to increase the odds that an agent is available when two or more
customers answer, which increases agent idle times while decreasing
the abandon rate.
Dialed number

For agent campaign, enter the dialed number that you created earlier
for agent campaign on the Outbound routing client. For IVR campaign,
leave this field empty.

Records to cache (1-400)

The minimum number of dialing numbers that each dialer caches for
each of the Outbound Option skill groups. This amount is based on
how many campaigns are configured. If you have many campaigns,
cache fewer records; that is, set the number lower. Default = 1.

Number of IVR Ports

The total number of VRU ports that are allocated for the specific skill
group. This value indicates how many ports are available for the dialer
to transfer customer calls. Because this value indicates the total
number of ports supported by the IVR for the current skill group,
multiple skill groups can make transfer-to-IVR calls.
Dialed Numbers for Transferring to an IVR Section
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Field

Description

After AMD and for transfer to IVR If the campaign is configured to transfer AMD calls to a VRU, enter
the dialed number that you created earlier for transferring call to VRU
campaigns
on the outbound routing client. This number must be configured for
an IVR campaign.
When no agents are available

This number enables the dialer to play a message to the caller when
no agents are available. Enter the dialed number that you configured
earlier on the outbound routing client. This number can be the same
as the number for the previous field.

Call Target Tab
Specify the following information on the Call Target tab.
Field

Description

Daylight Savings Zone

Describes the default time zone to use for any numbers dialed which
do not map to the Outbound Option region prefixes.

Zone 1 and Zone 2 options

Enable this option, and then enter the start and end times for reaching
your calling targets. Zones are useful for distinguishing phone
locations. For example, Zone 1 can be designated as work, and Zone
2 can be home.
The start and end times are local to your contacts (Customer
Time). The same number can be assigned to one or both
zones at the same time. However, Zone 1 time and Zone 2
time cannot overlap.
Lists the phone numbers in dialing order for the Zone 1 or Zone 2.
Note

Numbers to dial

• To move a phone number into the Numbers to dial list, click a
number in the Available numbers list and then click the left
arrow to add it to the Numbers to dial list. Do not move phone
numbers after the campaign has started. Number added after
while the campaign is running might not be dialed.
• To remove a phone number in the Numbers to dial list, click
the number and then click the right arrow to add it to the
Available numbers list.
• To control the dialing order, use the up and down arrows to
move the phone numbers within the Numbers to dial list.
Note

Customers are dialed based on the time zone of the first
phone that is configured on this tab. The time zone is based
on the prefix of the phone number and the region prefix
configuration. If two phone numbers that are imported for
the same customer have different time zones, both phones
are called during times that are valid for the first phone.
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Field

Description

Available numbers

Contains the available phone numbers that can be added to the
Numbers to dial list for Zone 1 or Zone 2.

Notes on Editing a Campaign in Progress
You can edit most campaign configuration settings while a campaign is running. The changes take effect with
new calls after the setting has been changed. However, do not edit the following settings while a campaign
is in progress:
• Do not modify the MaxAttempts value. Modifying this value while a campaign is in progress can cause
a long delay in record retrieval and longer agent idle times.
• Do not delete a skill group while a campaign is in progress.

(Optional) Configure Personal Callbacks
Personal Callback is an optional feature in Outbound Option. Personal Callback enables an agent to schedule
a callback to a customer for a specific date and time. A personal callback connects the agent who originally
spoke to the customer back to the customer at the customer-requested time.
This section describes how to configure your system to handle personal callbacks. When you create campaigns,
you enable the callback feature individually for each campaign.
The following table outlines the process.
Table 12: Personal Callback Configuration Steps

Step Number

Procedure Description

1-6

Configure a campaign.

7

Configure a call type for personal callback.

8

Configure a correctly named dial number.

9

Configure a routing script.

10

Configure registry keys.

11

Configure Queue to Agent node.
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Procedure
Step 1

In the Unified CCE Configuration Manager, select Outbound Option.

Step 2
Step 3
Step 4

In the Campaign tool, select the Campaign General tab.
Open a predefined campaign.
Check personal callback.
Personal callback is now enabled. Next, you configure the personal callback registry entries.

Step 5

Configure a call type for personal callback.
For information about creating call types, see the administration documentation.

Step 6

Create a dialed number with the name PersonalCallback on the outbound routing client.
For information about configuring dialed numbers, see the administration documentation.

Step 7
Step 8
Step 9

In Script Editor, create a routing script that sets up the Personal Callback reservation.
Open regedit on the data server (DS).
Open HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\LoggerA\BlendedAgent\CurrentVersion in the Outbound Option registry.

Step 10 Configure the personal callback registry entries listed in the following table. (Enter the values in decimal
format.)
Note
Outbound Option enforces at runtime the minimum and maximum values in the table. The registry
does not validate the values.
Name

Default Description
Value
(integers)

CallbackTimeLimit

15

Calculates the callback time range, in minutes, for each
personal callback. Outbound Option queries the
Personal Callback List for callback records, where the
CallbackDateTime value is between the current time
and the CallbackTimeLimit.

PersonalCallbackTimeToRetryBusy

1

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying a personal callback
to a busy number. The valid range is from 1 to 10.

PersonalCallbackTimeToRetryNoAnswer 20

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying an unanswered
personal callback. The valid range is from 5 to 60.

PersonalCallbackTimeToRetryReservation 5

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying to reserve an
unavailable agent. The valid range is from 1 to 10.

PersonalCallbackMaxAttemptsDefault 5

Sets the maximum number of times a personal callback
is attempted. The valid range is from 1 to 10.
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Name

Default Description
Value
(integers)

PersonalCallbackTimeToCheckForRecords 5

The interval time, in minutes, at which the Outbound
Option Dialer checks the Campaign Manager for
personal callback records. The valid range is from 1 to
30.

PersonalCallbackDaysToPurgeOldRecords 5

The number of days after the personal callback was
scheduled (CallbackDateTime) to keep the record
before purging it. The valid range is from 1 to 30.

PersonalCallbackRecordsToCache

20

The number of personal callback records to send to the
Outbound Option Dialer at one time. The valid range
is from 5 to 200.

PersonalCallbackSaturdayAllowed

0

Indicates whether personal callbacks are allowed on
Saturdays:
• 0: Personal callbacks are not allowed on Saturdays
and are rescheduled for the next allowable day.
• 1: Personal callbacks are allowed on Saturdays.

PersonalCallbackSundayAllowed

0

Indicates whether personal callbacks are allowed on
Sundays:
• 0: Personal callbacks are not allowed on Sundays
and are rescheduled for the next allowable day.
• 1: Personal callbacks are allowed on Sundays.

PersonalCallbackCallStatusToPurge

C, M

If needed, create this registry entry.
String containing the call status types to consider when
purging old personal callback records. For example, if
the string contains “C,M,F,L,I,” all calls with these call
statuses are purged from the database. (If the registry
entry is missing, the default is assumed.)
Note
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Name

Default Description
Value
(integers)

PersonalCallbackNoAnswerRingLimit 4

If needed, create this registry entry.
The number of times a customer phone rings before
classifying the call as an unanswered. The valid range
is from 2 to 10.

Step 11 Configure the Queue to Agent node.

Voice Gateway and Unified CVP configuration for an VRU campaign
For a VRU campaign, you need to configure a dial-peer in the voice gateway. This dial peer is used to instruct
the voice gateway to transfer the call to Unified CVP. It must match the Network VRU label that is configured
on the MR routing client with type 10 Unified CVP network VRU.
In base configuration, this label is preconfigured with default value 66611110000. Follow the steps in this
example.

Procedure
Step 1

Add a dial-peer to match the network VRU label in the outbound routing client.
Example:
dial-peer voice 6661111 voip
description ******To CVP1*****
destination-pattern 6661111T
session protocol sipv2
session target ipv4:10.10.10.10
voice-class codec 1
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte h245-signal h245-alphanumeric
no vad

The call can be transferred to only one Unified CVP; in the above example, the call is transferred to
CVP1.
Configure a dial-peer for the VRU leg. This is the same dial-peer as the inbound call flow whose call is
transferred to Unified CVP.
Note

Step 2

Example:
dial-peer voice 777111 voip
description Used for VRU leg
service bootstrap
incoming called-number 7771111T
voice-class sip rel1xx disable
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw
no vad

Step 3

A dialed number pattern needs to be configured on Unified CVP OAMP so that Unified CVP can route the
call to the VXML gateway after it receives the run script request from the router. This dialed pattern is the
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same one as the inbound call flow that transfers a call to VRU. If the base configuration has not been changed,
the pattern is 777111*.
Note
It is possible that the procedures in Steps 2 and 3 may have been done already during installation.
For more information, see the Cisco Packaged Contact Center Enterprise Installation and Upgrade
Guide at http://www.cisco.com/en/US/products/ps12586/prod_installation_guides_list.html.

Outbound Option Scripting
Outbound Option uses Packaged CCE scripting configured on the Administrative Workstation to manage
campaigns.
There are two types of scripts:
• Outbound Option Administrative Scripts, on page 158
• Outbound Option Routing Scripts, on page 162

Outbound Option Administrative Scripts
Outbound Option administrative scripts enable, disable, or throttle campaign skill groups for outbound
campaigns. The scripts can also automatically close out a skill group for a specific campaign based on time
or any other conditional factor that the administrative script can access. This scripting is performed at the skill
group level to provide more flexibility when managing larger campaigns that are distributed across multiple
skill groups.
Enable a campaign skill group by setting the campaign mode to one of the available modes: Preview, Direct
Preview, Progressive, or Predictive. (For more information about these modes, see Dialing Modes, on page
113.) Schedule an administrative script to run at regular intervals. Disable the campaign skill group in the
administrative script by creating a script node to change the campaign mode to inbound for that skill group.
You can also use this script to control the percentage of agents to be used in a campaign skill group and
whether this skill group is used for other campaigns or inbound calls.

Note

An administrative script controls a campaign skill group. A campaign skill group can be mapped only to
one campaign at a time. A skill group can be reused if new campaigns are added. If a campaign skill group
is recycled, reuse its administrative scripting as well. However, note that although it is possible to have
two administrative scripts controlling the same skill group, conflicting campaign mode requests for
Outbound Option can result.

Set Up Administrative Scripts
Use the Script Editor application to create an administrative script for each skill group to set the
OutboundControl variable and the skill group reservation percentage. The Outbound Option Dialer uses the
value of this variable to determine which mode each skill group uses.

Note

If the OutboundControl variable is not set, the skill group defaults to inbound.
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Perform the following steps to create the administrative script:

Procedure
Step 1
Step 2
Step 3

Open the Script Editor application.
Select File > New > Administrative Script.
Create an administrative script.
One script can be used to control all Outbound Option skill groups or multiple scripts can control multiple
Outbound Option skill groups. For example, if you want to control skill groups at different times of the day,
you need multiple administrative scripts; however, if you are going to initialize the groups all in the same
way, you need only one script (with additional Set nodes).

Step 4

Set up the script with the following nodes (required): Start, Set Variable, and End.
The following diagram displays a simple administrative script where both the OutboundControl variable and
the outbound percentage are set for a skill group. A script in a production call center is typically more complex,
perhaps changing these variables according to time of day or service level.
Figure 17: Sample Administrative Script

Note

This script assumes that Unified CVP is functioning. If Unified CVP is not working, we advise you
to insert an IF node in the script to disable the VRU campaign. Also, to ensure timely responses to
VRU outages, set the administrative script to run every minute.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
159

Outbound Option
Campaign configuration

Step 5

Set the OutboundControl variable. Setting this variable enables contact center managers to control the agent
mode.
Right-click on the work space and select NEW > Object > Set Variable to open the Set Properties window.
• For Object Type, select a skill group.
• For variable, select OutboundControl.
Set this variable to one of the values listed in the following table.
Table 13: OutboundControl Variable Values

Value String

Description

INBOUND

Agents take inbound calls only. Outbound dialing is disabled for the
skill group.

PREDICTIVE_ONLY

Agents in the skill group are dedicated for outbound Predictive calls
only.

PREVIEW_ONLY

Agents in the skill group are dedicated for outbound Preview calls
only.

PROGRESSIVE_ONLY

Agents in the skill group are dedicated for outbound Progressive calls
only.

PREVIEW_DIRECT_ONLY

Agents only place outbound calls and hear ring tones, such as phone
ringing or busy signal.

If the administrative script is changed and the SET variable is removed, the value of the
OutboundControl variable is the same as it was the last time the script was executed. However, if
the Central Controller is restarted, the value resets to INBOUND.
Right-click on the work space and select NEW > Object > Set Variable to open the Set Properties window.
Note

Step 6

• For Object Type, select a skill group.
• For variable, select OutboundControl.
Step 7

Step 8

Set the OutboundPercent variable in the same administrative script; for example, select the OutboundPercent
variable in the Set Properties window and enter the agent percentage in the Value field. This variable controls
the percentage of agents, which are logged in to a particular skill group, used for outbound dialing. For example,
if 100 agents are logged in to a skill group, and the OutboundPercent variable is set to 50%, 50 agents are
allocated for outbound dialing for this campaign skill group. This setup allows the rest of the agents to be
used for inbound or other active campaigns. The default is 100%.
Note
This variable does not allocate specific agents for outbound dialing, just a total percentage. The
default is 100%.
Schedule the script.
a) Select Script > Administrative Manager. An Administrative Manager dialog box appears.
b) Click Add.
c) On the Script tab, select the administrative script.
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d)
e)
f)
g)

On the Period tab, specify the run frequency of the script. (For example, every minute of every day.)
(Optional) Enter a description on the Description tab.
Click OK to close the Add Administrative Schedule dialog box.
Click OK to close the Administrative Manager.

Sample Administrative Script: ServiceLevelControl
The following figure demonstrates how to control skill group modes based on “Service Level,” which maximizes
the resource utilization in a call center and maintains an acceptable service level at the same time.
Figure 18: ServiceLevelControl Script

This script divides the day into two parts:
• Peak Traffic Period (8:00 a.m. to 12:00 p.m.): During this period, the OutboundControl variable is
set to INBOUND only, because more agents are required to handle inbound calls.
• Other Periods: During all other time periods, the OutboundControl variable is set according to the
service level in the past half hour. If the skill group service level in the past half-hour period is over
85%, the OutboundControl variable gets set to PREDICTIVE_ONLY, which maximizes the efficiency
of outbound campaigns. If during any half-hour period the skill group service level drops below 85%,
the OutboundControl variable is switched to PREVIEW_BLENDED, so that the agents in the skill group
can accept inbound calls to improve the service level. When the agents are not in an inbound call,
Outbound Option presents the agents with a Preview outbound call, maximizing the resource utilization
for the call center at the same time.
Add the IF Node
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To add the IF node, follow these steps:

Procedure
Step 1
Step 2
Step 3

Select ObjectType as Skillgroup.
Select the skill group that was created for outbound as the Object.
Select ServiceLevelHalf as the variable.

Outbound Option Routing Scripts
Two types of routing scripts are described later in this document. One is for Agent Campaign and one is for
VRU Campaign.

Set Up Routing Scripts
Use the Script Editor application to create a reservation script that uses the dialed number for the Outbound
Routing Type and routes through a Select node to the previously configured skill group.
Before beginning this procedure, you must create and configure a skill group. For information about creating
skill groups, see the Cisco Packaged Contact Center Enterprise Administration and Configuration Guide at
http://www.cisco.com/en/US/products/ps12586/tsd_products_support_series_home.html.
The following three sections contain diagrams displaying sample routing scripts.
• Script for Agent Campaign Without Personal Callback, on page 162
• Script for Agent Campaign with Personal Callback, on page 163
• Script for VRU Campaign, on page 164
Script for Agent Campaign Without Personal Callback
The following steps and accompanying diagram provide an example of how to create a script for an agent
campaign without personal callback.

Procedure
Step 1
Step 2

Using the Dialed Number tool, associate the Outbound Voice dialed numbers with the configured call type.
Using the Script Editor Call Type Manager, associate the call type with the newly created reservation script.
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Figure 19: Sample Script for Agent Campaign Without Personal Callback

Script for Agent Campaign with Personal Callback
The following steps and accompanying diagram provide an example of how to create a script for an agent
campaign with personal callback.
Include the following nodes:
• Add a queue-to-agent node.
• Add a Queue to Skill Group Node after the Queue to Agent Node. Use a skill group that handles outbound
calls.
• End the script in a release call node for a successful case; otherwise end the script with the END node.

Procedure
Step 1
Step 2

Using the Dialed Number tool, associate the Outbound Voice dialed numbers and Personal Callback dialed
numbers with the configured call type.
Using the Script Editor Call Type Manager, associate the call type with the newly created reservation script.
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Figure 20: Sample Script for Agent Campaign with Personal Callback

Configure Queue to Agent Node

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

In Script Editor, double-click the Queue to Agent node.
In the Agent Expression column, enter Call.PreferredAgentID.
Confirm that the Peripheral column is left blank.
Click OK to save the Queue to Agent node.
Save and then schedule the script. When scheduling the script, use the call type that is configured for personal
callback.
For more information about script scheduling, see the Cisco Packaged Contact Center Enterprise
Administration and Configuration Guide at http://www.cisco.com/en/US/products/ps12586/tsd_products_
support_series_home.html.

Script for VRU Campaign
The following steps and accompanying diagram provide an example of how to create a script for a VRU
campaign.

Procedure
Step 1
Step 2

Using the Dialed Number tool, associate the Outbound Voice dialed numbers with the configured call type.
Using the Script Editor Call Type Manager, associate the call type with the newly created reservation script.
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Figure 21: Sample Script for VRU Campaign

SIP Dialer Recording Parameters Configuration
When recording is enabled in a campaign, the number of recording files that result can be large. The following
table lists registry settings that you can adjust to regulate the number of recording sessions and the maximum
recording file size.
Registry Setting

Default Setting Description

MaxAllRecordFiles

500,000,000

The maximum recording file size (in bytes) of all
recording files.

MaxMediaTerminationSessions

200

The maximum number of media termination sessions
if recording is enabled in the Campaign configuration.

MaxPurgeRecordFiles

100,000,000

The maximum recording file size (in bytes) when the
total recording file size, MaxAllRecordFiles, is reached.
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Registry Setting

Default Setting Description

MaxRecordingSessions

100

The maximum number of recording sessions if
recording is enabled in the Campaign configuration.

Recording files are in the HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<customer instance>\Dialer directory.

Note

Only the G.711 codec is supported for recording. To record outbound calls, configure the G.711 on the
voice gateway.

Verification of Dialed Number
Outbound Option places agents in the Reserved state before using them for an outbound call. The dialer uses
the dialed number to route to an agent. The following procedure describes how to verify that this mechanism
works properly.

Verify DN Configuration
When an Outbound Option Dialer is installed in a Unified CCE environment, the dialer uses the dialed number
to make routing requests through the Media Routing (MR) Peripheral Gateway. The following verification
steps assume that you have completed all the applicable configuration and reservation script generation.

Procedure
Step 1

Step 2
Step 3

Log in an agent to a skill group participating in an outbound campaign, and make the agent available. (Note
the dialed number, which was configured in the Skill Group Selection tab in the Campaign component.) If a
different dialed number is used for predictive and preview calls, make sure to verify both dialed numbers.
Run the Script Editor application and select the Call Tracer utility from the Script > Call Tracer menu.
Select the routing client that is associated with the MR PG and select the Dialed Number.
Press Send Call to simulate a route request and note the results. If a label was returned for the agent who was
logged in above, the reservation script is working properly and the dialer can reserve agents through this script.

Verify Campaign Configuration
As a final step to verify that you configured your Outbound Option campaign correctly, create a small campaign
of one or two entries that dial work phones or your mobile phone.

Campaign Management
To manage your campaigns most efficiently, use multiple query rules instead of using multiple campaigns.
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Single Campaign Versus Multiple Campaigns
You might choose to run multiple campaigns because of different calling policies (for example, time rules)
or to run different outbound modes simultaneously.
From the perspective of dialer port allocation, running fewer campaigns with a larger agent pool is more
efficient. Dialer ports are allocated based on the number of agents assigned and the current number of lines
per agent to dial. The more campaigns you have that are active, the more the ports are distributed across the
campaigns, which affects overall efficiency.
Use query rules to break down a campaign into smaller requirements. These rules can be enabled based on
penetration or scheduled times. Campaign reports are available on a query rule level.

Results from Individual Customers
After running a campaign, you can generate a list of customers who were reached, not reached, or have invalid
phone numbers.

Interpret Information from Dialer_Detail Table
The Dialer_Detail table is a single table that contains the customer call results for all campaigns. When you
view the Dialer_Detail table, note that each attempted Outbound Option call is recorded as an entry in the
table. Each entry lists the number called and which numbers are invalid.

Management of Campaign Manager Database Tables
The Campaign Manager tables, Dialing_List and Personal_Callback_List can grow to be large. If the database
size grows too large, Campaign Manager performance can significantly slow. To limit the size of the Outbound
Option database, a stored procedure is run daily at midnight to purge records that are no longer needed.
By default, records are removed from the Personal_Callback_List table when the record's CallStatus is C or
M, and the CallbackDateTime for the record is more than 5 days old. In the Dialing_List table, records are
removed by default when CallStatusZone1 has a value of C or M, and ImportRuleDate is more than 5 days
old.
You can change the status and age of the records to be removed, by modifying Campaign Manager registry
values on the Logger machine. The registry settings are located in
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\LoggerA\BlendedAgent\CurrentVersion in the Outbound Option registry.
• To specify the records to remove from the Personal_Callback_List table, set
PersonalCallbackCallStatusToPurge and PersonalCallbackDaysToPurgeOldRecords.

Note

PersonalCallbackCallStatusToPurge is not added by default. To change the call status
of the records to remove, create this registry setting manually.

• To specify the records to remove from the Dialing_List table, set DialingListCallStatusToPurge and
DialingListDaysToPurgeOldRecords.
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Note

DialingListCallStatusToPurgeis not added by default. To change the call status of the
records to remove, create this registry setting manually.

To specify the age of the records to be removed, set PersonalCallbackDaysToPurgeOldRecords or
DialingListDaysToPurgeOldRecords to the number of days to keep the record before it is removed. For the
Personal Callback list, this value is the number of days after the personal callback is scheduled
(CallbackDateTime). For the Dialing List, this value is the number of days after the record is imported
(ImportRuleDate). The default is 5. The valid range is 1 to 30. If the value is not set or set to 0, the automated
purge is disabled.
To set the call status of the records to be removed, set PersonalCallbackCallStatusToPurge or
DialingListCallStatusToPurge to a string containing the call status types to apply when purging personal
callback or dialing list records. For example, if the string contains “C,M,F,L,I,” all records with these call
statuses, that are also older than the number of days specified by PersonalCallbackDaysToPurgeOldRecords
or DialingListDaysToPurgeOldRecords, are removed from the database.
You can specify the following call status values:
Value

Description

U

Unknown

F

Fax

I

Invalid Number

O

Operator

L

Not Allocated

X

Agent Not Available

C

Closed

M

Max Calls

Management of Predictive Campaigns
The following sections provide guidelines to follow when working with predictive campaigns.

Initial Values for Lines per Agent
Determining the initial value for the number of lines per agent is not as simple as inverting the hit rate. If a
campaign has a 20% hit rate, you cannot assume that five lines per agent is the applicable initial value for the
campaign if you are targeting a 3% abandon rate. The opportunity for abandoned calls increases geometrically
as the lines per agent increases; therefore, set the initial value conservatively in the campaign configuration.
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If the reports show that the abandon rate is below target and does not come back in line very quickly, modify
the initial value in the campaign configuration to immediately correct the lines per agent being dialed.

End-of-Day Calculation for Abandon Rate
It is not unusual for a campaign to be over the abandon rate target for any given 30 minute period. The dialer
examines the end-of-day rate when managing the abandon rate. If the overall abandon rate is over target for
the day, the system targets a lower abandon rate for remaining calls until the average abandon rate falls into
line. This end-of-day calculation cannot work until after the campaign has been running for one hour. Small
sample sizes due to short campaigns or campaigns with fewer agents might not give the dialer enough time
to recover from an initial value that is too high.
Similarly, if the campaign is significantly under the target abandon rate, it might begin dialing more frequently
with an abandon rate over target for a while to compensate in the abandon rate.

Transfer of Answering Machine Detection Calls to Agents
When enabling the Transfer AMD (Answering Machine Detection) to agent option for an agent campaign or
enabling the Transfer AMD to IVR option for an IVR campaign, consider the increase in calls to the target
resources (agents or IVR) when determining the initial value. If the expectation is that the AMD rate and the
live voice rate are over 50%, perhaps start out with an initial value of 1.1 or even one line per agent to stay
under a 3% abandon rate.

Management of Agent Idle Time
One of the key reporting metrics for administrators managing campaigns is the amount of time agents spend
idle between calls.
There are many possible reasons for longer idle times, such as a combination of one or more of the following:
• A dialing list with a low hit rate. The solution is to create a better list.
• A small agent pool results in fewer calls, resulting in slower adjustments. One solution is to add more
agents to the pool.
• Shorter average handle times means agents become available more frequently. A shorter handle time
means that the agent idle time percentage will climb.
• Not enough dialer ports deployed or too many agents. Deploy more ports or use fewer agents.
• A large number of retry attempts at the beginning of a day when running with append imports resulting
in lower hit rates. Prioritize pending over retries.
• Modifying the maximum number of attempts up or down in an active campaign. This activity can
interrupt the Campaign Manager’s processing of dialer requests for records, as mentioned earlier in this
chapter. One solution is to perform the activity during off hours.
• Running out of records to dial. Import new records.

Sources of Higher Idle Times in Reports
The following Outbound Option reports provide information regarding sources of higher idle times:
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• Campaign Consolidated Reports: These reports provide a very useful overview of a campaign by
combining campaign and agent skill group statistics into a single report. They provide average idle time,
campaign hit rate, the number of agents working on the campaign, as well as their Average Handle Time
per call. Low hit rates and low average handle times result in more work for the dialer to keep those
agents busy.
• Dialer Capacity Reports: These reports show how busy the dialers are and how much time was spent at
full capacity when the dialer was out of ports. They also provide the average reservation call time as
well as the average time each dialer port spent contacting customers.

Dialer Saturation
If both Dialers have relatively low idle times and high all ports busy times, then it is likely the Dialers have
been oversubscribed. The combination of number of agents, Dialing List hit rate, and average handle time are
likely more than the deployed number of ports the Dialer can handle.
To solve this problem, perform one of the following actions:
• Reduce the number of agents working on the campaign.
• Add more Dialer ports to the solution.

Few Available Records
Call Summary Count reports show how many records in the aggregate campaign dialing lists have been closed
and how many are still available to dial.

Reports
This section provides an overview of the Outbound Option reports available in the Cisco Unified Intelligence
Center (CUIC).
For detailed report template descriptions, see the Cisco Packaged Contact Center Enterprise Reporting User
Guide at http://www.cisco.com/en/US/products/ps12586/tsd_products_support_series_home.html.
For directions on importing report templates into Cisco Unified Intelligence Center and configuring Cisco
Unified Intelligence Center data sources for Packaged CCE, see the Cisco Packaged Contact Center Enterprise
Installation and Upgrade Guide at http://www.cisco.com/en/US/products/ps12586/tsd_products_support_
series_home.html

Outbound Option Reports
This section describes the Outbound Option reports, created using the Unified Intelligence Center.
• Outbound Historical Reports Bundle, on page 171
• Outbound Realtime Reports Bundle, on page 172
• Agent Reports, on page 172
• Campaign and Dialer Reports, on page 174
• Skill Group Reports, on page 175
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• Import Rule Reports, on page 175
Additionally, sample custom report templates are available from the Cisco Developer Network (http://
developer.cisco.com/web/ccr/documentation.)

Note

Call Type reporting can be used on Outbound Option reservation calls and transfer to IVR calls. Call Type
reporting is not applicable for outbound customer calls because a routing script is not used.

Outbound Historical Reports Bundle
The Outbound Options Historical reports receive data from the historical data source. Reports are populated
with interval data that has a default refresh rate of 15 minutes.
Half-hour/Daily: Provides statistics for each half-hour period. Many of the half-hour reports are also available
in a daily report format.
The Outbound Historical bundle contains the following reports:
Report

Description

Attempts per Campaign Daily

Shows the status (summary and percentage) of each
campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Campaign Consolidated Daily

Shows the daily activity and performance of the
selected campaigns and their skill groups for the
selected time period and provides analysis of the
actual customer calls (outbound calls which reached
live voice, inbound calls, or calls transferred to the
campaign's skill group) for the selected campaigns
and their skill groups for the selected time period.

Campaign Consolidated Half Hour

Shows the list of Consolidated Calls and Agent
Statistics per Campaign by Half Hour and Breakdown
of completed calls.

Campaign Half Hour Summary

Shows the status for all campaigns for the selected
time period, the status (summary and percentage) of
each campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Dialer Call Result Summary Half Hour

Shows the status of each dialer for the selected time
period.

Dialer Capacity Daily
Dialer Capacity Half Hour
Import Rule

Shows the status of imported records for the selected
time period.
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Report

Description

Query Rule Within Campaign Daily

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period and the
status (summary and percentage) of each campaign
for the selected time period.

Query Rule Within Campaign Half Hour

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period, the status
(summary and percentage) of each campaign for the
selected time period and the status for each Query
rule within a campaign for the selected time interval.

Outbound Realtime Reports Bundle
The Outbound Real Time reports display current information about a system entity; for example, the number
of tasks an agent is currently working on or the number of agents currently logged in to a skill group. By
default, the reports automatically query the Admin Workstation database on the distributor every 15 seconds.
The data is written to the database by the Router almost every 10 seconds.
The Outbound Real Time Reports Bundle contains the following reports:
Report

Description

Call Summary Count per Campaign Real Time

Shows the status of each query rule within a
campaign, status of all campaign records, and the
currently valid campaign dialing times.

Dialer Real Time

Shows the status of each dialer, including the number
of contacts dialed today and the result of each attempt.

Import Status Real Time

Shows the status of Outbound Option import records.

Query Rule Within Campaign Real Time

Shows the status of all campaign records, dialing
times, and query rule within a campaign.

Agent Reports
In addition to the reports contained in the Outbound Reports bundles, other Agent reports also provide
information about Outbound activities:
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Report

Outbound Option Fields

Agent Queue Real Time

The Direction field indicates he direction of the call
that the agent is currently working on including Other
Out/Outbound Direct Preview, Outbound Reserve,
Outbound Preview, or Outbound
Predictive/Progressive.

Agent Real Time
Agent Skill Group Real Time
Agent Team Real Time

The Destination field indicates the type of outbound
task on which the agent is currently working.
Agent Team State Counts

The Active Out field shows the number of agents
currently working on outbound tasks.

Agent State Real Time Graph

For agents handling Outbound Option calls, the Hold
state indicates that the agent has been reserved for a
call because the Outbound Dialer puts the agent on
hold while connecting the call.

To interpret agent data for Outbound Option tasks, you need to understand how Outbound Option reserves
agents, reports calls that are connected to agents, and handles calls dropped by customers before the calls are
connected.
The Outbound Option Dialer, which places outbound calls to customers and connects these calls with agents,
assigns and connects calls differently than regular Packaged CCE routing. Report data for agents handling
Outbound Option calls therefore differs from data for agents handling typical voice calls and multichannel
tasks.
When the Outbound Dialer initiates a call to a customer, it reserves the agent assigned to handle the call by
placing a reservation call to the agent and changing the agent's state to Hold. This reservation call is reported
as a Direct In call to the agent.
For typical voice calls, the agent is placed into Reserved state when Packaged CCE software reserves the
agent to handle a call; the agent's state is reported as Reserved. For Outbound Option calls, reports show the
agent in Hold state when reserved for a call and the time that agent spends reserved is reported as Hold Time.
When the customer answers the call, the Outbound Option Dialer transfers the call to an agent. The call is
now reported as a Transfer In call to the agent. When the customer call is transferred to the agent, the reservation
call is dropped by the dialer and classified as Abandon on Hold.
The abandoned call wait time, set in the Campaign Configuration screen, determines how calls are reported
if the caller hangs up. Calls are counted in the Customer Abandon field in both Real Time and Historical
campaign query templates only if the customer hangs up before the abandoned call wait time is reached.
For agent reporting per campaign, Outbound Option provides reports that accurately represent the outbound
agent activity for a contact center, including information grouped by skill group.
The following list describes the data presented in the agent reports.
• A real-time table that shows Outbound Option agent activity related to Outbound Option calls.
• A historical table that shows agent daily performance for Outbound Option predictive calls, by skill
group.
• A historical table that shows agent daily performance for Outbound Option preview calls, by skill group.
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• A historical table that shows agent daily performance for Outbound Option reservation calls, by skill
group.

Campaign and Dialer Reports
Outbound Option provides a campaign report template that describes the effectiveness of a campaign and the
dialer. This list can be used for Agent and IVR campaigns.
Observe the following guidelines when using the campaign reports:
• Campaign Real Time reports describe how many records are left in the campaign dialing list.
• Both Campaign and Dialer Half Hour reports provide the call result counts.

Note

Campaign Real Time reports capture call results since the last Campaign Manager restart only. If the
Campaign Manager restarts, data collected before the restart is lost.
The following list describes the data that is presented in the campaign reports.
• A summary of call results for query rules within a campaign since the beginning of the day.
• A summary of call results for a campaign since the beginning of the day. It includes a summary of all
query rules within the campaign.
• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaigns.
The times are relative to the customer’s time zone.
• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaign
query rules. The zone times are relative to the customer’s time zone. The query rule start and stop times
are relative to the Central Controller time.
• How many records for selected query rules have been dialed to completion, and how many records
remain.
• How many records for selected campaigns have been dialed to completion, and how many records
remain.
• A summary of call results for selected campaign query rules for selected half-hour intervals.
• A summary of call results for all query rules for selected campaigns for selected half-hour intervals.
• A historical table by half-hour/daily report that shows the status (summary and percentage) of each
campaign for the selected time period.
• A historical table by breakdown of attempts (in percentage) of each campaign for the selected time
period.
• A historical table by half-hour/daily report that shows the status (summary and percentage) per query
rule of each campaign for the selected time period.
• A historical table by breakdown of attempts (in percentage) per query rule of each campaign for the
selected time period.
• A summary half-hour/daily report that shows activity and performance of the selected campaigns and
their skill group for the selected time period, including abandon rate, hit rate, and agent idle times.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
174

Outbound Option
Reports

• A historical table by breakdown of actual customer calls (outbound calls which reached live voice,
inbound calls, or calls transferred to the campaign skill group) for the selected campaigns and their skill
groups for the selected time period.
Dialer Reports
The Outbound Option Dialer reports provide information about the dialer. These reports include information
about performance andresource usage. The templates also enable you to determine whether you need more
dialer ports to support more outbound calls.
The following list describes the data presented in the Outbound Option Dialer reports:
• A real-time table that shows contact, busy, voice, answering machine, and special information tone (SIT)
detection for each dialer. A SIT consists of three rising tones indicating a call has failed.
• An historical table that records contact, busy, voice, answering machine, and SIT Tone detection for
each dialer by half-hour intervals.
• Displays information about the amount of time the dialer was idle or had all ports busy.
• Displays Dialer status on a port-by-port basis used for troubleshooting. If this report does not display
any records, then the data feed is disabled by default. It is only enabled for troubleshooting purposes.

Skill Group Reports
For skill group reporting per campaign, Outbound Option provides reports that represent the skill group activity
for a contact center.
The following list describes the data presented in the skill group reports:
• A real-time table that shows all skill groups and their associated Outbound Option status.
• A historical table that records Outbound Option counts for the agent states signed on, handle, talk, and
hold by half-hour intervals.

Import Rule Reports
Outbound Option reports also enable you to view the success of record imports. Using the Import Rule
templates, you can monitor whether records are being added successfully (good records) or are failing (bad
records), and how long it takes to import the records.
The same import rule reports are used for Do Not Call and Contact List imports. The reports display a historical
view of when the imports were done, the number of records imported, and the number of records that were
considered invalid because of length constraints or improper formatting.
For contact list imports, the reports also provide insight into the number of contacts that were assigned with
the default time zone information for the campaign, as well as the number of contacts that were imported into
the dialing list after the query rule and format validation was performed.
The following information is available in the Import Rule reports:
• Number of successful, unsuccessful, and total records imported by time range
• Current import status
• A real-time table that shows the number of successful, unsuccessful, and total records imported or to be
imported.
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• A historical table that shows the number of successful, unsuccessful, and total records imported by time
range. The Total Records column indicates the total number of records available in the import file.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
176

CHAPTER

10

Post Call Survey
• Capabilities, page 177
• Initial Setup, page 178
• Administration and Usage, page 182

Capabilities
A Post Call Survey takes place after normal call treatment. It is typically used to determine whether customers
are satisfied with their call center experiences. This feature lets you configure a call flow that, after the agent
disconnects from the caller, optionally sends the call to a Dialed Number configured for a Post Call Survey.
The Unified CCE script can enable and disable Post Call Survey on a per-call basis by testing for conditions
and setting an expanded call variable that controls post call survey. For example, the script can invoke a
prompt that asks callers whether they want to participate in a survey. Based on the caller's response, the script
can set the expanded call variable that controls whether the call gets transferred to the Post Call Survey dialed
number.
The Post Call Survey call works just like a regular call from the Unified CCE point of view. Scripts can be
invoked and the customer can use the keypad on a touch tone phone and/or voice with ASR/TTS to respond
to questions asked during the survey. During Post Call Survey, the call context information is retrieved from
the original customer call.

Note

The call context for the post call survey includes all context up to the point where the call is transferred
to the agent. Context that the agent creates after the transfer is not included in the post call survey context.

Design Considerations
Observe the following conditions when designing the Post Call Survey feature:
• A Post Call Survey is triggered by the hang-up event from the last agent. When the agent hangs up, the
call routing script launches a survey script.
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• The mapping of a dialed number pattern to a Post Call Survey number enables the Post Call Survey
feature for the call.
• The value of the expanded call variable user.microapp.isPostCallSurvey controls whether the call is
transferred to the Post Call Survey number.
◦If user.microapp.isPostCallSurvey is set to y (the implied default), the call is transferred to the
mapped post call survey number.
◦If user.microapp.isPostCallSurvey is set to n, the call ends.
◦To route all calls in the dialed number pattern to the survey, your script does not have to set the
user.microapp.isPostCallSurvey variable. The variable is set to y by default.
◦To test for conditions and dynamically route calls to the survey based on the results of the test,
your script must explicitly set user.microapp.isPostCallSurvey to y and n as appropriate.
• REFER call flows are not supported with Post Call Survey. The two features conflict: REFER call flows
remove Unified CVP from the call and Post Call Survey needs Unified CVP because the agent has
already disconnected.
• For Unified CCE reporting purposes, when a survey is initiated, the call context of the customer call
that was just transferred to the agent is replicated into the call context of the Post Call Survey call.

Initial Setup
To set up the Post Call Survey feature:

Procedure
Step 1
Step 2

Step 3

Step 4

Create one or more survey scripts and add the files to the CVP media servers. See Create a Survey Script,
on page 178.
Configure the Unified CVP server for Post Call Survey. This step enables the post call survey feature for
specific dialed number patterns. It also maps incoming dialed number patterns to survey dialed number patterns.
See Configure the Unified CVP Call Server for Post Call Survey, on page 179.
Configure Unified CCE for Post Call Survey. This step adds a required expanded call context variable, adds
a new call type for Post Call Survey, and associates your survey dialed number patterns (created in the previous
step) to the survey call type. See Configure Unified CCE for Post Call Survey, on page 179.
Modify your Unified CCE call routing scripts to launch the survey scripts. The scripts can optionally contain
nodes that test for conditions and dynamically control whether a call is transferred to the survey. See Modify
CCE Scripts for Post Call Survey, on page 180.

Create a Survey Script
To create a survey script or application that queries the caller for information, use the CVP Call Studio tool.
See the Unified Call Studio Installation and Call Studio Custom Voice Application chapters in the document
Getting Started with Cisco Unified Customer Voice Portal.
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What to Do Next
Map CVP dialed number patterns to the survey script numbers.

Configure the Unified CVP Call Server for Post Call Survey
In the following procedure, you enter a dialed number pattern for the inbound call and a dialed number pattern
for the post call survey. In both cases, the patterns can use alphanumeric characters and wildcard characters
such as the exclamation point (!), asterisk (*), and single digit matches such as the letter X or period (.). The
pattern can end with an optional greater than (>) wildcard character. The maximum length of the dialed number
pattern is 24 characters.

Procedure
Step 1
Step 2

Access the CVP Operations Console by typing https://<OAMP_server_IP>:9443/oamp.
Select System > Dialed Number Pattern.
The Dialed Number Pattern window opens.

Step 3
Step 4

Click Add New.
Enter a pattern in the Dialed Number Pattern field. This is the incoming Dialed Number for calls that you
want to direct to a Post Call Survey. Make sure that dialed number patterns entered here are unique. (An
incoming dialed number can not be associated with multiple survey numbers.)
Check Enable Post Call Survey for Incoming Calls. This action enables post call surveys for all incoming
calls with the specified dialed number pattern.
The Survey Dialed Number Pattern field appears.

Step 5

Step 6

In the Survey Dialed Number Pattern field, enter a dialed number for the Post Call Survey. This is the dialed
number to which the calls should be transferred to after the normal call flow completes.
Record the number you have entered. In the next task, you create this dialed number in CCE Administration
and create a call type to associate with this dialed number.

Step 7

Click Save to save the Dialed Number Pattern.
You are returned to the Dialed Number Pattern page.

Step 8

Click Deploy to deploy the configuration to all Unified CVP Call Server devices.

Configure Unified CCE for Post Call Survey
You can enable and disable Post Call Survey within a CCE routing script by using the ECC variable
variableuser.microapp.isPostCallSurvey. A value of n or y disables and enables the feature. (The value is
case-insensitive.)
Configure the ECC variable to a value of n or y before either the label node or the Queue toSkillgroup node.
This configuration sends the correct value to Unified CVP before the agent transfer. This ECC variable is not
needed to initiate a Post Call Survey call, but you can use it to control the feature once Post Call Survey is
configured using the Unified CVP Operations Console. As long as a DN is mapped in the Operations Console
for Post Call Survey, the call is automatically transferred to the configured Post Call Survey DN.
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Note

• The Post Call Survey DN is called if the Unified CVP has received at least one CONNECT message
from CCE (either from the VRU leg or from the Agent leg). Use the END node in your CCE routing
script if the Post Call Survey is not required for the calls disconnected from the IVR.
• If Router Requery is configured incorrectly and the Ring-No-Answer timeout expires, the caller is
still transferred to the Post Call Survey DN. This can occur if a Queue node is used and Enable target
requery is not checked.

Procedure
Step 1
Step 2

In Unified CCE Administration, select Manage > Expanded Call Variables.
Create a new ECC variable with Name:user.microapp.isPostCallSurvey.

Step 3
Step 4

Set Max Length: to 1.
Check the Enabled checkbox. Then click Save.
In your CCE routing scripts, remember that, at script start, the default behavior of Post Call Survey equals
enabled, even if user.microapp.isPostCallSurvey has not yet been set in the script. You can turn off Post
Call Survey in the script by setting user.microapp.isPostCallSurvey to n. You can later enable Post Call
Survey in the same path of the script by setting this variable to y.

Step 5
Step 6
Step 7
Step 8

Select Manage > Call Types.
Add the call type for Post Call Survey, and click Save.
Select Manage > Dialed Numbers.
Create a dialed number for each of the Post Call Survey Dialed Number Patterns created in Unified CVP.
Select the following for each dialed number:
• Routing Type: External Voice
• Call Type: Post Call Survey call type you created.

Step 9 Click Save.
Step 10 Restart the active generic PG (side A or B) to register the new ECC variable.
If the ECC variable already existed, you can skip this step.
Note
The user.microapp.isPostCallSurvey setting takes effect on Unified CVP only when it receives a
connect or temporary connect message. Therefore, if you do not want the survey to run, without first
reaching an agent (such as 'after hours of treatment'), you must set the isPostCallSurvey to n before
the initial 'Run script request'.

Modify CCE Scripts for Post Call Survey
In Script Editor, modify your CCE call routing scripts for incoming calls as follows:
• Add nodes to invoke the call studio survey script, if needed. The following notes explain when you
might need to explicitly add nodes to call the survey script.
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If a DN is mapped in the Operations Console for Post Call Survey, the call is automatically transferred
to the configured Post Call Survey dialed number.

Note

The Post Call Survey dialed number is only called if the script ends with a call to an
agent. If the script completes without going to an agent then the call is not directed to
the Post Call Survey dialed number . In these cases, you can, for example, use a Send
to Script node in your Unified CCE script to direct the call to the Post Call Survey
script.

• Optionally, you can add nodes in the script to test for conditions for which you want to turn the survey
off.
◦To dynamically control whether the survey is offered to callers, you must explicitly set the
user.microapp.isPostCallSurvey expanded call context variable to y and n.
◦To offer the survey to all callers, you do not need to set the variable in the script. It is set to y by
default.
◦Configure the expanded call context variable to a value of n or y before the Queue to Skillgroup
node. This sends the correct value to Unified CVP before the agent transfer.
The following example calls a script that asks callers if they want to participate in a survey. The script then
sets the user.microapp.isPostCallSurvey variable according to the caller's response.

Create a routing script for the Post Call Survey Call Type to play your survey script or application to the caller.
The following script is an example:
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Get Survey Results
For reporting purposes, in both the CVP and the CCE databases, a post call survey call has the same
RouterCallKey, Call GUID, and call context as the original inbound call.
To obtain survey results, you query or create a report that gathers survey data from the CVP database.
For more information on how to configure a Data Source, see the Cisco Packaged Contact Center Enterprise
Installation and Upgrade Guide at http://www.cisco.com/c/en/us/support/customer-collaboration/
packaged-contact-center-enterprise/products-installation-guides-list.html.

Procedure
Step 1
Step 2

In Cisco Unified Intelligence Center Reporting tool, connect to the CVP database.
Create a query that identifies survey calls, gathers call information from those calls, and extracts data related
to specific survey dialed numbers:
a) In the Call_Type table, test for Event_Type = Post_Call_Survey.
b) If true, use that entry's call information to query the VXML_Element table and get the VXML data for
the call.
c) In the VXML data, you can identify the exact survey that a caller participated in from the dialed number
used to place the Post Call Survey.

Step 3
Step 4

To report on the results of a particular survey, collate the VXML data for all calls with that survey's dialed
number.
To identify answers to survey questions, in the CauseRef table, the CauseID is 20, and the Cause is Post Call
Answer.
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• Whisper Announcement Capabilities, page 183
• Deployment Tasks, page 184
• Administration and Usage, page 190

Whisper Announcement Capabilities
Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with
each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone
patterns) while the announcement plays.
The content of the announcement can contain information about the caller that helps prepare the agent to
handle the call. The information can include caller language preference, choices the caller made from a menu
(Sales, Service), customer status (Platinum, Gold, Regular), and so on.
After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts.
The determination of which announcement to play is controlled in the script and is based on various inputs,
such as the dialed number, a customer ID look up in your customer database, or selections you made from a
VRU menu.
Whisper Announcement is supported for blended outbound agents when they receive inbound calls.

Whisper Announcement Functional Limitations
Whisper Announcement is subject to these limitations:
• Announcements do not play for outbound calls made by an agent. The announcement plays for inbound
calls only.
• For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU node before you
transfer the call to the agent. Transfer the call to Unified CVP before you transfer the call to another
agent. Then, Unified CVP can control the call and play the announcement, regardless of which node
transfers the call to Unified CVP.
• CVP Refer Transfers do not support Whisper Announcement.
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• Whisper Announcement supports Silent Monitoring (CTI OS and Unified CM-based) with this exception:
For Unified Communications Manager-based Silent Monitoring, supervisors cannot hear the
announcements themselves. The supervisor desktop dims the Silent Monitor button while an
announcement plays.
• Only one announcement can play for each call. While an announcement plays, you cannot put the call
on hold, transfer, or conference; release the call; or request supervisor assistance. These features become
available again after the announcement completes.
• The codec settings for Whisper Announcement recording and the agent's phone must match. For example,
if Whisper Announcement is recorded in G.711 ALAW, the phone must also be at G.711 ALAW. If
Whisper Announcement is recorded in G.729, the phone must support or connect using G.729.
• In an IPv6-enabled environment, Whisper Announcement might require extra Media Termination Points
(MTPs).

Deployment Tasks
The following list shows the high-level tasks that are required to deploy Whisper Announcement. Individual
steps are covered in more detail in later sections.
1 Unified CVP Media Server, on page 85.
2 Create Whisper Announcement Audio Files, on page 184.
3 Deploy Whisper Announcement Audio Files to Media Server, on page 185.
4 Configure Whisper Service Dialed Numbers, on page 185.
5 Add Whisper Announcement to Routing Scripts, on page 186.
6 Fail-Safe Timeout for Whisper Announcement in Unified CCE, on page 188.
Example scripts that enable Whisper Announcement are installed with your system. For information about
these scripts and how to access them, see Whisper Announcement Sample Scripts, on page 188.

Create Whisper Announcement Audio Files
You must create audio files for each different Whisper Announcement you want to use on your system; for
example, “Sales, English” or “Soporte Técnico en Español.” Create the files using the recording tool of your
choice.
When recording your files, follow these rules:
• The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and
format requirements (G729, CCITT G.711 A-Law and U-law 8 kHz, 8 bit, mono).
• To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement
play limit (15 seconds).
• Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.
• To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is
easy for you and others to remember. For example, en_sales.wav, sp_support.wav.
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Deploy Whisper Announcement Audio Files to Media Server
Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you
prefer. The most important consideration is where on the server to place the files. HTTP requests for media
server audio files are constructed as
http://<media_server>/<locale_directory>/<application_directory>/<file_name>.

The CVP defaults for the locale and application directories are en-us/app. Unified CCE automatically
adds en-us/app to the server name when making HTTP requests for media files.
For example, if:
• The script node that defines the media server has a value of http://myserver.mydomain.com
and
• The script node that defines the audio file to play has a value of en_sales.wav
Then the HTTP request for the file is automatically constructed as
http://myserver.mydomain.com/en-us/app/en_sales.wav

If you store your files in a different locale and application directory, your routing scripts must include variable
nodes that define those alternate locations. Make note of the directories in which you place your files and
communicate the locations to your script authors.
Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read
access.
CVP with the Streaming Audio (Helix) and Whisper Announcement
You must set the user.microapp.media_server variable, to point to the whisper announcement .wav file, for
the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on.
This is achieved by setting the Call.WhisperAnnouncement variable to the complete URL of the whisper
announcement wav file. The Call.WhisperAnnouncement variable should be put in using the
http://<mediaserverio>:80/en-us/app/XXX.wav URL format.

Configure Whisper Service Dialed Numbers
For Whisper Announcement, Unified CVP uses two different dialed numbers when transferring a call to an
agent:
• The first number calls the ringtone service that the caller hears while the whisper plays to the agent. The
CVP default for this number is 91919191.
• The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.

Note

Whisper Announcement dialed number is always an extension of the Ringtone dialed
number with an extra two zeros at the end.

For Whisper Announcement to work, your dial plan must include both of these numbers. The easiest way to
ensure coverage is through the use of wild cards such as 9191*.
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Configure Dialed Numbers
You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at
System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable Local
Static Route. Once Enable Local Static Route is checked, select either Route to Device or Route to SIP
Server Group for VXML gateways. Then save and deploy the dialed number.
It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts
with the overall dial number plan.

Change the Whisper Announcement Default Dialed Number
To override the DN pattern from the SIP subsystem level in CVP OAMP:

Procedure
Step 1

Select Device Management > Unified CVP Call Server.

Step 2
Step 3
Step 4

Select the Call Server on which to override the default whisper DN.
Select the SIP tab.
Override the default value of 91919191 configured under the DN on the Gateway to play the ringtone field.

Step 5

Click Save & Deploy.
For Packaged CCE, complete this override on all four CVP servers.

Configure Ringtone Dialed Number
To configure the Ringtone dialed number in the CVP Operations Console:
1 Select Device Management > Unified CVP Call Server.
2 Select the Call Server on which you want to configure the settings.
3 Select the SIP tab.
4 In the DN on the Gateway to play the ringtone field, configure the default Ringtone dialed number
Pattern.

Dialed Number in the Dial-Peer
In addition to configuring the dial plan in Unified CVP, examine your IOS dial-peer. Make sure that the dialed
number setting in your dial-peer configuration accommodates both of the whisper service dialed numbers.

Add Whisper Announcement to Routing Scripts
To enable Whisper Announcements, use the Script Editor to modify your routing scripts as follows:
• Specify the WhisperAnnouncement call variable
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• Specify the Unified CVP media server and location of whisper audio files
• Specify other required variables
For more information, see Whisper Announcement Sample Scripts, on page 188.

Specify WhisperAnnouncement Call Variable
To include Whisper Announcement in a script, insert a Set Variable node that references the
WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and
specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a
result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set
the variable at multiple places in your scripts to allow different announcements to play for different endpoints.
For example, for skills-based routing, you can specify the variable at each decision point used to select a
particular skill group or Precision Queue.

Note

Only one Whisper Announcement can play for each call. If a script references and sets the
WhisperAnnouncement variable more than once in a single path through a script, the last value to be set
is the one that plays.
Use these settings in the Set Variable node for Whisper Announcement:
• Object Type: Call.
• Variable: Must use the WhisperAnnouncement variable.
• Value: Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.
◦Specify the filename only, not its path.
◦You must enclose the filename in quotation marks.
◦The filename is not case sensitive.
◦The filename cannot include spaces or characters that require URL encoding.
◦The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP
request.

Specify Unified CVP Media Server Information
Ensure that your call routing scripts can access the Whisper Announcement audio files that you stored on a
CVP media server. If you configure a default media server, and you store the audio files on the default server,
you may not have to add any additional nodes to the scripts. For more information, see Unified CVP Media
Server, on page 85. To test the access, see Test Whisper Announcement File Path, on page 187.

Test Whisper Announcement File Path
To test the path to the whisper file that you defined in you script variables, enter the complete URL into a
browser. The .wav file should play. For example:
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• If your script includes: default media server + default locale + default application directory + whisper.wav,
then the path is “http://<default_media_server>/en-us/app/whisper.wav”
• If your script includes: http://my_server.my_domain.com + default locale + “app/wav_files” +
whisper.wav, then the path is “http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement
These additional settings are required for Whisper Announcement to work:
• Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target
an agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and
Select. If Target Requery is not enabled, the Whisper Announcement does not play.
• When you run an agent transfer or a conference script, use a SendToVRU or a Run Script Request node
before you target an agent.

Fail-Safe Timeout for Whisper Announcement in Unified CCE
Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second
message when the announcement ends. The time stamps from these messages are used to calculate Whisper
Announcement data in Unified CCE reports.
If Unified CVP fails to send a Whisper Announcement end message to Unified CCE, the following occurs:
• Unified CCE cannot accurately calculate the whisper length, thus skewing report data.
• The agent cannot control the call (for example, put it on hold or transfer it) because these controls are
disabled while a Whisper Announcement is playing.
To prevent this, Unified CCE has a Whisper Announcement timeout value. This value is 20 seconds and
represents the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.
The value was chosen based on the default Whisper Announcement play time (specified in Unified CVP) of
15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against latency. While the
value is configurable in Unified CCE, changing the value is not supported in Packaged CCE.

Whisper Announcement Sample Scripts
Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as
learning tools and as models for your own Whisper Announcement scripts. They are the following:
• WA.ICMS—This script plays a Whisper Announcement.
• WA_AG.ICMS—This script plays both a Whisper Announcement and an Agent Greeting to play on
the same call flow.
The script files are located in the c:\icm\bin directory. In Unified CCE Script Editor, they are installed
to the application root directory.
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Note

To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper
file stored in the default location on the media server. For that reason, they do not include variables that
specify the media server, locale, or application directories.

WA.ICMS Script
This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired
wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the
skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.

WA_AG.ICMS Script
This script causes both a Whisper Announcement and an Agent Greeting to play.
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Import Sample Whisper Announcement Scripts
To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE
Script Editor. Follow this procedure to import the scripts:

Procedure
Step 1
Step 2

Open Script Editor.
Select File > Import Script and select the first of the two scripts to import.
In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced
in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do
not map successfully. You must create these maps manually or change these references to point to existing
Network VRU scripts, skill groups, and Precision Queues in your system.

Step 3

Repeat steps 2 and 3 for the remaining script.

Administration and Usage
Whisper Announcement Audio File
You store and serve your Whisper Announcement audio files from the Cisco Unified Contact Center Enterprise
(Unified CCE) media server. This feature supports only the wave (.wav) file type. The maximum play time
for a Whisper Announcement is subject to a timeout. Playback terminates at the timeout regardless of the
actual length of the audio file. The timeout is 15 seconds. In practice, you may want your messages to be
much shorter than that, 5 seconds or less, to shorten your call-handling time.

While a Whisper Announcement Is Playing
Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you
cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These
features become available again after the whisper is complete.

Whisper Announcement with Transfers and Conference Calls
When an agent transfers or initiates a conference call to another agent, the second agent hears an announcement
if the second agent's number supports Whisper Announcement. In the case of consultative transfers or
conferences, while the whisper plays, the caller hears whatever normally plays during hold. The first agent
hears ringing. In the case of blind transfers, the caller hears ringing while the whisper announcement plays.
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Whisper Announcement Reporting and Serviceability
Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue
reports, the period during which the announcement plays is reported as Reserved agent state time. In the
Termination Call Detail records, it is treated as Ring Time.
Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper
Announcement failures and counters to track the number of failed whisper events.

Whisper Announcement in Agent Desktop Software
No configuration is needed to integrate Whisper Announcement with agent desktop software. While a whisper
is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the
Talking state.

Using Agent Greeting with Whisper Announcement
You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when
you use them together:
• On the call, the Whisper Announcement always plays first before the greeting.
• To shorten your call-handling time, you may want to use shorter whispers and greetings than you might
if you were using either feature by itself. A long whisper followed by a long greeting means a long wait
before an agent handles a call.
• Usually, agents that use Whisper Announcement handle different types of calls: for example, "English,
Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member,
Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of
customer calls they handle.
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Video Contact Center
Video Contact Center provides high-quality video collaboration between customers and agents. Depending
on how Video Contact Center is deployed, customers may connect with agents either from within the enterprise
network or from devices outside the enterprise.
Packaged Contact Center supports the following Video Contact Center capabilities:
• Video communication between agents and callers
• Video on Hold - Videos are played to callers when they are placed on hold by an agent.
• Video-in-Queue - Video-in-Queue can play videos before and while a caller is in queue. This feature
presents high-definition video prompts that allow callers to navigate a video menu using DTMF keys.
• Cisco MediaSense recording - Cisco MediaSense can record both the video and audio parts of a video
call, or the audio only.
Packaged CCE supports four Video Contact Center deployments:
1 Video Contact Center for enterprise callers
2 Video Contact Center with Jabber Guest
3 Remote Expert Mobile
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4 Remote Expert Branch, including Kiosk/Immersive

Important

This guide does not discuss Remote Expert Branch or Remote Expert Mobile.
For all information about the Remote Expert Mobile deployment for Packaged CCE, see the Cisco Contact
Center Solutions and Unified Communications Manager Solution Configuration Guide for Remote Expert
Mobile, available at http://www.cisco.com/c/en/us/support/customer-collaboration/remote-expert-mobile/
tsd-products-support-series-home.html.

1. Video Contact Center for Enterprise Callers
You can deploy Video Contact Center so that only callers within the enterprise network can engage in video
calls with agents. These callers use endpoints that are registered to the Cisco Unified Communications Manager.
For example, company employees can have a video call with your IT help desk.
To transition from a voice contact center to a Video Contact Center for enterprise callers, Packaged CCE
requires the following components:
• Cisco MediaSense to store, stream, and play video content. MediaSense can also record video calls.
• Telepresence MCU Video Conference Bridge to facilitate multi-party video conferences.
• Cisco Unified Border Element (Cisco UBE) that connects video calls from Unified CVP to Cisco
MediaSense to queue the calls or play video prompts.
• Video endpoints for agents and callers
For example, this is a traditional voice deployment:
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After the transition to Video Contact Center for enterprise callers, the deployment looks like this:
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See the Cisco Packaged CCE Software Compatibility Matrix DocWiki at http://docwiki.cisco.com/wiki/
Compatibility_Matrix_for_Packaged_CCE for the supported versions of these components.
2. Video Contact Center with Jabber Guest
Packaged Contact Center Enterprise supports Video Contact Center with Jabber Guest as an add-on to
Video Contact Center. In Video Contact Center with Jabber Guest, callers outside the enterprise network use
a Cisco Jabber application or browser client for video calls with agents.
In addition to the components required for enterprise callers, Video Contact Center with Jabber Guest
deployments also requires these components:
• Cisco Jabber Guest Server, to connect Jabber client video callers with agents.
• Cisco Expressway Edge and Core, to enable Jabber client traffic to reach the Jabber Guest Server through
the enterprise's firewall.
After the transition to Video Contact Center with Jabber Guest, the deployment looks like this:
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See the Cisco Packaged CCE Software Compatibility Matrix DocWiki at http://docwiki.cisco.com/wiki/
Compatibility_Matrix_for_Packaged_CCE for the supported versions of these components.
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Video Prerequisites
Licenses
Before installing Video Contact Center solutions, acquire the necessary licenses for these products:
• Cisco Telepresence MCU video conference bridge
• Cisco MediaSense
• Cisco Unified Border Element
• Cisco Jabber Guest Server - Video Contact Center with Jabber Guest deployments only
• Expressway Edge and Core - Video Contact Center with Jabber Guest deployments only
Cisco Telepresence MCU Video Conference Bridge License Requirements
For license requirements for the supported Cisco Telepresence MCU conference bridges, see the Ordering
Guide for Cisco Customer Contact Solutions at this location on cisco.com.
Cisco MediaSense License Requirements
You need the following licenses to run Cisco MediaSense with Video Contact Center:
• Media Sense Base License for the number of concurrent non-redundant sessions required.
• Video Session Licenses for the number of concurrent non-redundant video sessions required.
• MediaSense Server Software Licenses for the Primary and Secondary servers that provide database and
media operations.
• MediaSense Expansion Server Software Licences for servers that provide additional capacity for media
operations.
Additional ordering and licensing information is available to Cisco Partners in the following documents:
• Ordering Guide for Cisco Customer Contact Solutions at http://www.cisco.com/c/en/us/products/
customer-collaboration/mediasense/partner-resources-listing.html
• Cisco MediaSense Sizing Spreadsheet
Cisco Unified Border Element License Requirements
A software license is required to run Cisco Unified Border Element. If you have already deployed Cisco UBE,
you can re-use the existing ports. However, if you need additional sessions to support Video Contact Center,
you need to purchase additional Cisco UBE ports. See the Cisco Unified Border Element and Gatekeeper
Ordering Guide at http://www.cisco.com/en/US/prod/collateral/voicesw/ps6790/gatecont/ps5640/order_guide_
c07_462222.html.
Cisco Jabber Guest License Requirements - Video Contact Center with Jabber Guest Deployments Only
Cisco Jabber Guest is licensed and obtained through User Connect Licensing (UCL), Cisco Unified Workspace
Licensing (CUWL), and other ordering mechanisms. Contact a sales representative from a Cisco partner or
from Cisco for ordering details. No license keys are provided or required for the Cisco Jabber Guest software.
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Cisco Expressway License Requirements - Video Contact Center with Jabber Guest Deployments Only
The following table describes the license requirements for using Cisco Expressway with Cisco Jabber Guest.
Table 14: License Requirements for Using Cisco Expressway with Cisco Jabber Guest

License

Requirement

Rich Media Session
licenses

2 Rich Media Session licenses are
required per Cisco Jabber Guest
session:

Note

• 1 Rich Media Session license
on the Cisco Expressway-E
for each Cisco Jabber Guest
session
• 1 Rich Media Session license
on the Cisco Expressway-C
for each Cisco Jabber Guest
session
TURN relay license

TURN licensed on Cisco
Expressway

When you order Cisco Expressway, a TURN
relay license is included.

Advanced Networking If Cisco Jabber Guest is installed When you order Cisco Expressway, an AN
(AN) license
in a dual-NIC deployment, an AN license is included.
license is required on Cisco
Expressway.

Video Contact Center Restrictions
Packaged CCE supports Video Contact Center solutions with the restrictions described in this table.

Note

Packaged CCE Video Contact Center does not support any features that are not included in this document.
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Restriction Type

Restriction

Packaged CCE features

Packaged CCE Video Contact Center solutions do
not support the following features:
• Agent Greeting
• Whisper Announcement
• Mobile Agent
• Silent Monitor
• Video on Hold (caller-initiated)
• Outbound Dialer
• Courtesy Callback

Jabber endpoints

Use Jabber as a video endpoint only. As for all
endpoints, all call controls (except for answer, mute,
and hangup) must be done via the agent desktop.

Audio codec

Cisco MediaSense does not support G.711 a-law
codec for video playback.

Video resolution scaling

MediaSense does not support video resolution scaling.
For example, a 320p video plays at 320p on every
device, and a 1080p video plays at 1080p on every
device. Supported devices properly handle any
necessary up- or down-scaling themselves.

Agent and supervisor desktop features

Agent desktops support a limited set of features for
video agents, as follows:
• Standard actions — Agent log in, Agent State
(Ready, Not Ready), Dial, Answer, Release,
and CTI data.
• Additional services — Hold, Retrieve, Alternate,
Reconnect, and Blind/Consult
Transfer/Conference.
Agent desktops do not support these features for video
agents:
• Silent Monitor
• Supervisor Barge-In
• Intercept
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Supported Video Formats and Codecs
Cisco MediaSense supports the following formats and codecs for uploaded videos:
• MP4 video with up to 1080p resolution
• H.264 video codec
• AAC-LD MP4A-LATM audio codec
Videos play back using the AAC-LD MP4A-LATM, G.711 mu-law, or G.722 codec, depending on the
endpoint.

Set Up Video Contact Center Components
You must set up Cisco Packaged Contact Center Enterprise before installing and configuring additional Video
Contact Center components.
See the Cisco Packaged Contact Center Enterprise Installation and Upgrade Guide at http://www.cisco.com/
c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/products-installation-guides-list.html.
Video Contact Center
Install and configure these components for all Video Contact Center deployments. This table includes links
to installation and configuration instructions for each component, and notes specific to Video Contact Center
configuration.
Component Task

Related Document

Notes

Deploy Cisco UBE

Cisco IOS Voice Command Reference

Confirm that Cisco UBE is enabled
on the system. In the terminal
window, type:
show cube status

If Cisco UBE is disabled, type the
following text to enable it:
Voice service voip
Mode border-element
Allow-connections sip to
sip

Install and configure
Cisco MediaSense

Installation and Administration Guide for
Cisco MediaSense at http://www.cisco.com/
c/en/us/support/customer-collaboration/
mediasense/
tsd-products-support-series-home.html

The system default incoming call
configuration in MediaSense is set
to Record Audio Only. Change
this setting to Record Audio and
Video in order to record video
calls.
Follow the instructions to Edit the
System Default Incoming Call Rule
in the Administer and Configure
MediaSense chapter to change this
setting.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
201

Video Contact Center
Set Up Video Contact Center Components

Component Task

Related Document

Integrate MediaSense and Installation and Administration Guide for
Cisco UBE
Cisco MediaSense at http://www.cisco.com/
c/en/us/support/customer-collaboration/
mediasense/
tsd-products-support-series-home.html

Notes
Follow the instructions for
MediaSense Setup with Cisco
Unified Border Element in the
Administer and Configure
MediaSense chapter.
Be sure to add the username for the
AXL Administrator to the Standard
Unified Communications Manager
Administrators group and Standard
AXL API Access roles in Unified
Communications Manager, if
necessary.

Configure Unified
Communications
Manager for the Cisco
Telepresence MCU
conference bridge

Cisco TelePresence MCU 45X0, 53X0 and Follow the instructions in the
MCU MSE 8510 Deployment Guide at http:/ Deploying an MCU as a Unified
CM media resource section.
/www.cisco.com/c/en/us/support/
conferencing/telepresence-mcu-5300-series/
products-installation-guides-list.html

Video Contact Center with Jabber Guest
For Video Contact Center with Jabber Guest deployments, install and configure these additional components.
This table includes links to installation and configuration instructions for each component, and notes specific
to Video Contact Center with Jabber Guest configuration.
Component Task

Related Document

Deploy Cisco
Expressway Edge and
Expressway Core
(Expressway-C and
Expressway-E), including
firewall configuration

Cisco Expressway Basic Configuration
Deployment Guide at http://www.cisco.com/
c/en/us/support/unified-communications/
expressway-series/
products-installation-and-configuration-guides-list.html

Deploy Expressway-C and
Expressway-E before installing and
configuring Cisco Jabber Guest
Server. Once installed, confirm the
configuration details using the
appendices listed in the Cisco
Cisco Expressway on Virtual Machine
Expressway Basic Configuration
Installation Guide at http://www.cisco.com/
Deployment Guide.
c/en/us/support/unified-communications/
expressway-series/
products-installation-guides-list.html
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Component Task

Related Document

Installation and Configuration
Notes

Install and Configure
Cisco Jabber Guest
Server

Cisco Jabber Guest Installation and
Administration Guide at http://
www.cisco.com/c/en/us/support/
unified-communications/jabber-guest/
tsd-products-support-install-and-upgrade.html

Follow the instructions for the Dual
NIC Deployment.
Skip any steps that you completed
while setting up the Expressway
components earlier. Review the
instructions in the Cisco Jabber
Guest Installation and
Administration Guide to verify that
you correctly configured the
Expressway-E and Expressway-C.

Configure Video-in-Queue
Video-in-Queue (VIQ) is an optional feature in Unified CVP. Depending on configuration, the caller interacts
through high-definition video prompt or navigates a video menu using DTMF keys. The following figure
displays the topology and call flow for an enterprise deployment.
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1 New call from Unified CM to Unified CVP.
2 New call to Packaged CCE from Unified CVP.
3 Play Unified CVP Studio video application.
4 Unified CVP sends the call to the Cisco UBE/VXML Gateway.
5 Unified CVP VXML Server application instructs VXML Gateway to connect to specific dialed number
(DN).
6 Cisco UBE sends call to Video Media Server with that DN. Caller gets static video.
7 Agent is now available.
8 Unfied CVP sends call to an agent.
The Unified CVP Studio VideoConnect element plays a specific video prompt for video endpoints.
VideoConnect also collects and integrates the DTMF input during video-prompt playback with the Unified
Call Studio or Unified CCE scripting environment.

Note

Video-in-Queue does not play during a Unified Communications Manager Failover.

Note

When setting up the Video-in-Queue for Unified CVP, set the MediaSense Incoming Call Configuration
> Action to play once.

Video-in-Queue Configuration Sequence
To set up Video-in-Queue, perform the following tasks:
Sequence

Task

Configure Cisco Unified Communications Manager
1

Configure the SIP Trunk to MediaSense, on page 206

2

Configure Video on Hold, on page 215

Configure Cisco MediaSense
3

Upload Video File, on page 208 to play to callers
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Sequence

Task

Notes

4

Associate the Dialed Number with the Video File, on The Dialed Number for the video must
page 208
match the following settings on other
components:
• VXML/Cisco UBE gateway dial
peer configuration:
destination-pattern
• Unified CVP Call Studio Script:
VideoConnect element
VideoMedia Server DN setting
• Packaged CCE routing script:
"video_id" value for the Set
variable that points to the Unified
CVP Studio script for
Video-in-Queue

Configure Cisco UBE/VXML Gateway
5

Configure Cisco Unified Border Element/VXML
Gateway for Video, on page 209 to connect a dial-peer
to MediaSense and configure video capabilities on the
gateway.

The destination-pattern must match the
pattern used for the Dialed Number that
you associated with the uploaded video
in MediaSense Administration.

Write the Cisco Unified CVP Call Studio Script
6

Create Unified CVP Call Studio Script for
Video-in-Queue, on page 209

Write the Packaged CCE Routing Script
7

If necessary, create a new dialed number and call type
using Unified CCE Administration for the
Video-in-Queue routing script you will create in the
next step.

8

Create Script Editor Routing Script for
The "application" value in the Set
Video-in-Queue, on page 211 that invokes the Unified variable must be set to the name of the
CVP Call Studio script.
Unified CVP Call Studio script.
The "video_id" value for the Set
variable must the Dialed Number for
the video in MediaSense
Administration.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
205

Video Contact Center
Video-in-Queue Configuration Sequence

Configure Unified Communications Manager
After the postinstallation process for a Cisco MediaSense server, access your Unified CM server. In Unified
CM Administration, configure the SIP Trunk and video endpoints.
To configure Unified CM for video on hold, see Configure Video on Hold, on page 215.

Configure the SIP Trunk to MediaSense
Video Contact Center requires two Unified Communications Manager SIP Trunks:
• A SIP trunk to Unified CVP to handle the Contact Center routing and VXMLGW interactions. Video
Contact Center uses the SIP trunk to Unified CVP that is already configured as part of Packaged CCE.
• A SIP trunk to MediaSense for forking calls via Cisco UBE.
You must set up the SIP trunk to MediaSense.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Login to Unified CM as an Administrator user.
Click Device > Trunk.
Click Add New.
Select SIP Trunk from the Trunk Type drop-down menu.
Leave the Device Protocol set to SIP.
Select None(Default) from the Trunk Service Type drop-down menu.
Click Next.
Enter the Device Name and Description for the SIP trunk, and Destination Address for MediaSense server.
Select a Device Pool from the Device Pool drop-down menu.
In the SIP Information section, enter a destination address for the MediaSense server in the Destination
field.
Step 11 Select Non Secure SIP Trunk Profile from the SIP Trunk Security Profile drop-down menu.
Step 12 Select the appropriate SIP profile for your deployment from the SIP Profile drop-down menu.
Step 13 Click Save.

Provision Video Endpoints
Provision your video endpoints by following the documentation for your endpoints and the Cisco Unified
Communications Manager Administration Guide at http://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/products-maintenance-guides-list.html.
This section provides additional configuration necessary for video endpoints.
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Configure Multiline Settings for Video Phones
You configure multiline settings for video phones in both Unified CCE Administration and Unified
Communications Manager Administration. After changing the settings, you must restart the Peripheral Gateway
services on the Side A and Side B Unified CCE Call Servers.

Procedure
Step 1

Log in to Unified CCE Administration as an Administrator, and perform the following steps:
a) Navigate to System > Settings > Agent.
b) Select All Lines from the Agent Phone Line Control drop-down menu.
c) Click Save.

Step 2

On the Unified Communications Manager publisher, log in to Unified CM Administration as an Administrator,
and perform the following steps:
a) Navigate to Cisco Unified Communications Manager Administration > Bulk Administration.
b) Use the Unified Communications Bulk Administration Tool to modify the device profiles for all phones
as follows:
• Set Maximum Number of Calls to 2. This value indicates that the phones do not allow multiple
calls per line.
• Set Busy Trigger to 1. This value indicates that if the line is in use, other calls presented to that line
are rejected with a busy cause.
For more information about the Unified Communications Manager Bulk Administration Tool, see the
Cisco Unified Communications Manager Bulk Administration Guide at http://www.cisco.com/c/en/us/
support/unified-communications/unified-communications-manager-callmanager/
products-maintenance-guides-list.html.

Step 3

Restart the Peripheral Gateway services as follows:
a) On the Side A Unified CCE Call Server, use the Unified CCE Service Control tool to restart PG1A and
PG2A.
b) On the Side B Unified CCE Call Server, use the Unified CCE Service Control tool to restart PG1B and
PG2B.

Set the Default Maximum Session Bit Rate for Video Calls
Unified Communications Manager Region settings are set by default to a maximum session bit rate of 384
kbps for video calls. This bit rate does not support HD video. You must change the default value to a value
higher than 6000 kbps.
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Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

In Cisco Unified Communications Manager Administration, navigate to System > Region Information >
Region.
Enter Default in the text field and click Find.
Click Default in the results.
In the Modify Relationships to other Regions > Maximum Session Bit Rate for Video Calls section, select
the kpbs radio button and enter a value higher than 6000.
Click Save.

Configure Cisco MediaSense
Use a Video Media Server to upload, store, and play back video prompts. Cisco MediaSense is the Video
Media Server that provides network-based multimedia capture, streaming, and recording. Cisco MediaSense
records conversations on the network rather than on a device. This process simplifies the architecture, lowers
costs, provides optimum scalability, and facilitates use by analytics applications from Cisco technology
partners.

Upload Video File
After installing Cisco MediaSense, upload a video MP4 file.

Procedure
Step 1
Step 2
Step 3

Go to Administration > Media File Management and click Add.
Type in the Title (filename) and Description, and then browse to the location of the video MP4 file.
Click Save to upload the video file to MediaSense server.

What to Do Next
Associate the file with a new dialed number.

Associate the Dialed Number with the Video File
Once you upload a video file, associate the file with a dialed number.
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Procedure
Step 1
Step 2
Step 3
Step 4

Go to Administration > Incoming Call Configuration and click Add.
Click Address, and type the address of the appropriate dialed number.
In the Action drop-down menu, choose Play Once.
In the Media File drop-down menu, choose the appropriate video file.
The file is now associated with this dialed number.

Configure Cisco Unified Border Element/VXML Gateway for Video
This example Cisco Unified Border Element/VXML Gateway dial-peer code shows the configuration needed
to connect a dial-peer to a Video Media Server:
application
service cvp_videoconnect flash:cvp_videoconnect.tcl
voice service voip
allow-connections sip to sip
dial-peer voice 6000 voip
destination-pattern 6000T
session protocol sipv2
session target ipv4:10.78.26.142
voice-class sip midcall-signaling block
dtmf-relay rtp-nte
codec g711ulaw
video codec h264
no vad

The following code from the example connects Cisco UBE/VXML Gateway to MediaSense:
application
service cvp_videoconnect flash:cvp_videoconnect.tcl
voice service voip
allow-connections sip to sip

Important

You need to add the destination-pattern code to configure video capabilities on the gateway. The
destination-pattern must match the pattern used for the Dialed Number that you associated with the
uploaded video in MediaSense Administration.

Create Unified CVP Call Studio Script for Video-in-Queue
The CVP Studio VideoConnect element plays the specific video prompts for video endpoints. VideoConnect
also collects and integrates the DTMF input during video prompt playback within a standard scripting
environment.
When scripting in Cisco Unified Call Studio, unlike with ICM scripting, there is no reverse ability for the
media files. The script writer can point to Properties > AudioSettings > Default Audio Path URI in the
application and a single Media Server or the ACE VIP address for a farm of Media Servers.
The following graphic shows a sample CVP studio script:
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Table 15: Settings

Name (Label)

Required

Default

Notes

Video Media Server DN

Yes

None

Video Media Server Destination Number.
Example: 5000.
Must be a valid dialed number on Cisco
UBE and Video Media Server.

Digit Match Pattern

No

None

Pattern to use for matching incoming digit
collection. Leave blank for no digit
collection. Example: 600.
Must be a valid pattern for Cisco IOS
gateway. The pattern format is the same
as the destination-pattern format used in
IOS gateway dial-peers.

No Input Timeout

No

No timeout
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input. Example: 15.
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The following table describes the different ways a video call is completed/terminated:
Exit State

Notes

End_of_media

Video played to completion and the video server disconnected.

Caller_input

Caller entered a DTMF string that matched the specified digit
collection pattern.

No_input

No input received before the input timeout expired on a digit
collection pattern.

Error

An error or other unexpected termination occurred.

Caller_hangup

Caller disconnected while video in progress.

The following table describes element data that is created when one of these exit states is not completed:
Name

Type

Notes

callerdtmf

string

The digit string value captured.

result

string

Video call outcome.

Set Up Packaged CCE Routing Script for Video-in-Queue
To configure the Packaged CCE routing script for Video-in-Queue, complete these steps:
1 Create a new dialed number (if required) for the Video-in-Queue script.
Complete this step using the Dialed Number tool in Unified CCE Administration. For instructions, see
the Cisco Packaged Contact Center Enterprise Administration and Configuration Guide at
http://www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
tsd-products-support-series-home.html.
2 Associate the dialed number with either a new or existing call type.
Complete this step using the Dialed Number and Call Type tools in Unified CCE Administration. For
instructions, see the Cisco Packaged Contact Center Enterprise Administration and Configuration Guide
at http://www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
tsd-products-support-series-home.html,
3 Create a routing script in Script Editor that invokes the Unified CVP Call Studio script that you created
for Video-in-Queue.
4 Schedule the routing script for the call type in the Script Editor Call Type Manager.

Create Script Editor Routing Script for Video-in-Queue
The following illustration is a sample Script Editor script for Video-in-Queue. In this script:
• The Set variable is set to "application=VideoIVR;video_id=7000019" where application is the name
of the Unified CVP Call Studio application, and video_id indicates the video to play. The video_id is
the Dialed Number for the video in MediaSense Administration.

Cisco Packaged Contact Center Enterprise Features Guide, Release 11.0(1)
211

Video Contact Center
Video-in-Queue Configuration Sequence

• The RunExtScript node uses the standard "GS,Server,V" to invoke the Unified CVP VXML application.
• You can receive the DTMF digits back from CVP Studio application in the
"Call.user.microapp.FromExtVXML[0]".

After creating your script, schedule the routing script using Call Type Manager in Script Editor.

Schedule Routing Script
You schedule a script by associating it with a call type as follows:
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Procedure
Step 1

Choose Script > Call Type Manager. The Call Type Manager dialog box opens.
Figure 22: Call Type Manager Dialog Box—Schedules Tab
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Step 2
Step 3

Select the call type to associate with the script.
Click Add. The Add Call Type Schedule dialog box opens.

Step 4

In the Script tab, select the script to schedule:
Figure 23: Add Call Type Dialog Box - Script Tab
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Step 5

In the Period tab, choose the information to define the period for which the schedule will be effective.
Figure 24: Add Call Type Schedule Dialog Box - Period Tab

Step 6

Optionally, in the Description tab, enter a description of the schedule.

Step 7

Click OK in the Add Call Type Schedule dialog box.

Step 8

Click OK in the Call Type Manager dialog box.
Note
The schedule is not saved until you click OK in the Call Type Manager dialog
box.

Configure Video on Hold
After configuring the Cisco MediaSense server, Video on Hold (VOH) is available. Once you configure video
on hold, videos are played to callers when they are placed on hold by an agent.
To upload new video files for VOH, you must perform the steps in the following sections:
• Configure MediaSense for Video on Hold, on page 216
• Configure Unified CM for Video on Hold, on page 216
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Configure MediaSense for Video on Hold
Follow these instructions to add the new media file to the Media Resource Group List (MRGL) in Cisco
MediaSense.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5

Login to MediaSense as an Administrator user.
Click Administration > Media File Management.
Click Add.
Enter the Title, Description, and File.
Click Save.

Step 6
Step 7
Step 8
Step 9
Step 10

Click Administration > Incoming Call Configuration.
Click Add.
Enter the Address and Action, and then choose your recently added media file.
Click Save.
Login to Unified CM to apply this MRGL to the Device Pool of the client side video endpoints.

What to Do Next
Configure Unified CM for Video on Hold.

Configure Unified CM for Video on Hold
After you add your new media file to MediaSense, follow these instructions to add a SIP trunk to the
MediaSense server and add the Video on Hold server to the Media Resource Group List.

Note

In video conference use cases, the video conference bridge is a call leg on Cisco UBE. Ensure that you
select the added Media Resource Group List (MRGL) on the SIP trunk to Cisco UBE.
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Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Log in as an Administrator user.
Click Device > Trunk.
Click Add New.
Click Trunk Type > SIP Trunk.
Click Next.
Enter the Device Name, Description, Device Pool, and Destination Address for the MediaSense server.
Click Save.
Click Media Resources > Video On Hold Server.
Click Add New.
Enter the Name, Description, Default Video Content Identifier (Address from previous section) and recently
added SIP Trunk to the MediaSense server.
Alternatively, configure a call studio script to prompt the caller for a list of videos, and play the video matching
the number the user selected.

Step 11
Step 12
Step 13
Step 14
Step 15
Step 16
Step 17
Step 18
Step 19
Step 20

Click Save.
Click Device > Trunk and select the trunk.
Click Reset.
Click Media Resources > Media Resource Group (MRG).
Click Add New.
Enter the Name and Description, and then move the new Video on Hold server to Selected Media Resources.
Click Save.
Click Media Resources > Media Resource Group List (MRGL).
Click Find and then select an existing MRGL.
Add the new MRG to the MRGL above the Music on Hold entry (for priority).

Record Video Calls
Recording can be performed using the phone or through the gateway. When recording through the gateway,
an additional Cisco UBE is required, as shown in this configuration:
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For more information on video recording, refer to the Cisco MediaSense User Guide at http://www.cisco.com/
c/en/us/support/customer-collaboration/mediasense/tsd-products-support-series-home.html.
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